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TA700/800 Series Comparison

TA700 TA700C TA700PDC TA800/850 (1)

PCI-X PCI CPCI-X CPCI PCI-X PMC PCI-X PCI

Working Mode Configurations

State Analyzer maximum speed MHz 100 70 100 70 66.66 66.66 133.33 70
Exerciser maximum speed MHz 66.66 66.66 66.66 66.66 66.66 66.66 133.33 70
Timing Analyzer Y Y Y Y N N NS* NS*
Asynchronous Timing Analysis Y Y Y Y N N NS* NS*
Synchronous Timing Analysis TBI* Y TBI* Y N N NS* NS*
Easy Mode Y Y Y Y Y Y Y Y
Advanced Mode Y Y Y Y Y Y Y Y

Additional Features

Number of Sequencer States 32 32 32 32 32 32 16 16
Performance Analysis Y Y Y Y Y Y Y Y
Counters 8 8 8 8 8 8 8 8
Counter Size [Bits] 32 32 32 32 32 32 32 32
Pre-defined Projects Y Y Y Y Y Y Y Y
Simultaneous with Exerciser Y Y Y Y Y Y Y Y

Statistical Analysis

Min/Max/Avg
Latencies
Retry TBI* Y TBI* Y TBI* Y TBI* Y
Data Transfers
Command Utilization
Bus Utilization
Target Terminations [Various]
User Defined Events Y Y Y Y Y Y Y Y
Display - Graphical on Screen Y Y Y Y Y Y Y Y
Save result in File for subsequent review Y Y Y Y Y Y Y Y
Special Capabilities
Protocol Errors Y Y Y Y Y Y Y Y
Mnemonics Y Y Y Y Y Y Y Y
Compliance Testing N/A Y N/A Y N/A Y N/A Y
Interconnect to Host System
Parallel Port Y Y Y Y Y Y Y Y
USB Port Y Rev. D+ Y Rev. D+ Y Y Y Rev. C+ Y Rev. C+ Y Y
Simulation Mode - Data Analysis Without Hardware Y Y Y Y Y Y Y Y
Easy Mode
Pre-defined Capture and Trigger Projects 24 23 24 23 24 23 24 23
Voltage Check Y Y Y Y N N Y Y

TBI* To be implemented
NS* Not Supported
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TA700/800 Series Comparison Cont.

TA700 TA700C TA700PDC TA800/850 (1)
PCI-X PCI CPCI-X CPCI PCI-X PMC PCI-X PCI
Memory Size
Standard 128K 128K 128K 128K 128K 128K 128K 128k
Optional 4M 4M 4M 4M None None NS* NS*
Timing
Minimum Clock Rate [MHz] 25 25 25 25 >1KHz | >1KHz | >1KHz | >1KHz
Maximum Clock Rate [MHz] 100 70 100 70 66.66 66.66 133.33 66.66
Asynchronous Timing Clock MHz 664 664 664 664 None None NS* NS*
Advanced Mode
User Defined Projects Y Y Y Y Y Y Y Y
Definable Event Patterns 8 8 8 8 8 8 8 8
Protocol Errors 58 51 58 51 58 51 58 51
Miscellaneous
PCI Signals sampled (Not JTAG) ALL ALL ALL ALL ALL ALL ALL ALL
External Input Signals 16 16 16 16 16 16 TBI* TBI*
Status LEDs 5 5 4 4 2 2 5 5
TBI* To be Implemented
NS* Not Supported

(1) The TA850 is a functional equivalent of the TA800 built as a low profile PCI card operating on +3V only
and with the parallel port interface replaced by a 10/100 ethernet connection.
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Introduction

Catalyst Enterprises, Inc.

Introduction

What’s

In This Manual

This manual describes the installation and operation of your Catalyst PCI/PCI-X Bus
Analyzer / Exerciser. Examples of some typical applications are included.

The terms TA700 and PCI analyzer thereafter are used for referring to PCI/PCI-X,
CompactPCI and PDC analyzers(See Appendix, B, C and/or D) and in cases where
applicable TA800. The designation TA80O is a reference to TA800/TA850 unless
otherwise stated. (For the TA800 see “APPENDIX E” on page 243 and for the TA850
see “APPENDIX F” on page 247).

Timing and External Memory Availability

Product Timing Analyzer Extended Memory
TA850/TA800 No No
TA700 Yes Yes
TA700C Yes Yes
TA700PDC No No

Overview

Note 1.:

Your TA700/800 PCI Bus Analyzer is a powerful and versatile analysis tool that will
permit you to debug and characterize PCI designs operating on any PCI system
architecture. To perform analysis you simply install the analyzer card in a PCI slot in
the target machine and connect it either, to the host system Bi-directional parallel port
or to the USB port using the appropriate cable provided with your analyzer. A typical
setup may include a Host and a Target systems interconnected via the parallel/USB
port with the analyzer card installed in the Target Machine and a Windows based host
running the analysis software.

If your target machine operates under Windows it may also act as the host. In this
case, the analyzer card and the analysis software reside in the same machine and
require you to connect the analyzer card to the Host high-speed parallel port or USB
port or ethernet using the appropriate cable provided. See Figure 1 and Note 1.

Caution: Operating the analyzer in this mode, however, may impact
Performance Analysis measurement accuracy since the analyzer
software runs in the same system space as the application software.
For a precise Performance Analysis it is recommended that you use a
separate Host system.

Use only the parallel port or the USB port or ethernet to connect to the TA700/800,
do not connect more than one port at the same time.
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Figure 1 Target and Host Operating in the Same Machine

Optional Auxiliary PCI connector

Note:

The PCI Bus Analyzer Card incorporates a PCI connector on top which extends the
system PCI bus and allows other PCI cards to be plugged into the analyzer for
development or production testing. This feature allows the analyzer to monitor the
same point-to-point signals such as REQ# & GNT# on the card under test without
requiring any external connections. In this mode, both the analyzer and the card under
test require only one PCI slot. Special design methodology has been incorporated to
minimize any reflections, delay or cross-talk.

The top connector is intended for monitoring use as an analyzer only and could
interfere with the exerciser. The TA700 has an On-board arbiter that allows the TA700
to be a master regardless of the board type installed in the top connector. It is
recommended that there not be 2 masters in the same slot.

This feature only exists on the TA700 and TA700PDC PCI analyzer and not on the
TA700C, TA800 or TA850 versions.

Figure 2 illustrates such a test setup. An On-Off switch on the analyzer card enables
and disables the power and signal connections between the system and the card under
test allowing rapid cycling of the test cards without shutting off the system power.

Caution: The TA700 will not work with the top connector when operated at 100 MHz bus

speed. It is not recommended to operate the TA700 with the extender at frequencies
above 66 MHz, the extender switch must be in the Off position.

PCI CARD UNDER
TEST

POWER ON/OFF

ANY TARGET PCI SLOT

WINDOWS BASED HOST

Figure 2 Testing a PCI Bus Card




Introduction Catalyst Enterprises, Inc.

TA700 Analyzer Card

Figure 3 shows a TA700 PCI Analyzer card identifying Status LED locations, external
trigger input and output connections and the external signal input connector.

TRIG D3 it

DUT
G g928M- V35Z14W
SYS } SBURNDY CEE2X92SM gl
COMPUTERBUS SD0025
. HTH
2R e ol

1

R L Tt e T T T sadauang Ll

ON
SWITCH # <

OFF

XCVE0 0™
FGBBOAFP0033
F11387394A

Figure 3 TA700 PCI Analyzer Card

Status LED Function Description (TA700)

For the TA700C analyzer/exerciser LED status information see APPENDIX C. For the TA700PDC
LED status information see APPENDIX D, for the TA800 LED status information see Appendix E and
for the TA850 LED status information see APPENDIX F.

SYS When green the system and DUT voltages are within 5% of their value. If any of
+5V, +3.3V, +12V drop more than 5% the SYS LED turns red. SYS LED also
comes up red as a test on power on and then if the voltages are okay it turns
green once the software is executed. To enable voltages for sensing see page 15.

DUT Indicates that the voltage to the DUT is on. In this case the user may not remove
or insert any card in to the top connector of the TA700

D3, D11 When illuminated, the TA700 has been configured.

TRIG Indicates that the analyzer has met the trigger condition and is awaiting for the

defined post-trigger data to be captured.

SWITCH Function In the ON position the TA700 is transparent and connects power and PCI bus

signals to the Test Connector. In the Off position the TA700 isolates the power
and signals to the PCI bus connector and designates the TA700 to act as a PCI
Agent if jumper S2 is not installed. For jumper location see APPENDIX B.
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Receiving and Inspecting Your
Analyzer

Your analyzer includes the following components:

e Analyzer card identified in the packing list

*  Software on CD-ROM

* 10’ DB-25 to SCSI II 26 pin cable

* User’s Manual

» Cable for external signals

+ 12M USB cable

e 3M Ethernet cable (TA850 only)

* 2 brackets for low profile or regular installation (TA850 only)

Unpacking Your Analyzer

Inspect the received shipping container for any visible damage. In the event of visible
damage, retain all shipping materials until all of the contents per the packing list have
been checked for completeness and absence of damage. Unpack the shipping
container and account for each item on the packing list. Visually inspect each item for
damage. In the event of damage notify the shipper and Catalyst Enterprises.

Host System Requirements

The following are requirements for the host system for proper operation of your
TA700/800:

*  PC operating under Windows 2000 or XP

* Internet connection

*  E-mail client such as Outlook or Outlook Express

¢ Bi Directional, ECP, EPP Parallel Port, USB 1.X or 2.0 interface or
10/100 ethernet connection.

* 100 MB free hard disk space on partition with TA700/800 software
* 10 MB free hard disk space on partition with Windows

e 800 x 600 or better resolution Monitor with 16 - bit or better video
card.

¢ CDdrive
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Installing Your Analyzer

Hardware Installation

1. Make sure that the Target Machine is powered down.

2. Remove the case from your machine in accordance with the instructions
supplied for it.

3. Install the Analyzer card in any available PCI slot and secure the mounting
bracket to the chassis with the mounting screw.

Warning: Make sure to take precautions to avoid static electricity discharge

damage to the Analyzer Card by using a grounding strap or touching

& a grounded metal surface just prior to handling the analyzer card.
Avoid touching any components and handle card by the edges only.

4. Interconnect the Host system’s bi-directional parallel port, USB port or ethernet
using the cables provided.

Host and Target Same The Analyzer may be used in a configuration such that the Host and
Target are the same machine.

Bi-Directional Port The Analyzer requires that The Host parallel port support Bi-directional
data transfers. See LPT Port Setting for verifying that your parallel port
supports and/or is set to a Bi-directional mode. If the parallel port on your
Host system does not support Bi-directional data transfers you must then
install a parallel port card that supports bi-directional data transfers.

Port Configuration Make sure that the installed parallel port card address does not conflict
with an existing parallel port such as one for a printer.

Software Installation

On systems operating under Windows 2000 or XP:

1. Insert the CD-ROM.

2. The installation will automatically start the setup unless the auto Run is turned
off, in that case select the CD-ROM from “My Computer” and click on setup.

3. After the warning for closing all other programs and before starting the
installation, the Install Component selection window will open as shown in
Figure 4.
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Select Components i x|

Select which software packages you wish to install.

[V TAT00_TAB00 Software, Yersion 4.72 (78M)

[ SBAE. USE Software, Version 5.10 (105M)

[~ BTAE Bluetooth Software, Yersion Beta 1.10.0007 (3M)
[ Diiver fles for Windows NT/20004%P, Yession 4.0 [20K)
™ Hot Swap Extenders, Software and Application Notes
[~ TABS0-660, PCI/PCIX Software, Version 4.28 (46M)
I Product Catalog

InstalShield —

<Back I Next > I Cancel 1

Figure 4 Install Component Selection
4. Select the desired components for installation.
5. Click Next to complete the installation.

System Restart After installing the TA700/800 software you must restart your computer
before you can use your analyzer software.

USB Driver During installation of the TA700_TA800 software automatically installs
the USB driver, which will require the system to be rebooted. When the
TA700/TA800 is attached to the system using the USB port, the system
will search for the correct driver for the TA700/TA800. This step may
require some user interaction, the user should only need to press next, and
the system should find the correct driver. If this step does not work, please
refer to the next section for details on how to manually install the USB
Driver.

PCI Driver If at the end of installation the operating System requests a PCI driver,
then you must manually point to the PCI driver folder.

Manual USB Driver Installation
To control the TA700/800 via the USB bus perform the following:

1. Power Up the TA700/800

2. Connect the USB cable between the TA700/800 USB Port interface and the
Host Computer USB port.

3. After Windows detects the new device, select the “Search For Best Driver for
Your Device” option button.

4. Click Next.

Choose the “Specific location” option button and deselect all other option
buttons.

¢  Click Next
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*  Using Browse go to:
“c:\Program Files\Catalyst\TA700_800\Predefined\USB Driver”
(Operating under Windows 2000 or Windows XP you need to enter
the ‘Win2k’ directory.)

6. Click Next and then Finish to complete the TA700/800 USB port driver
installation.

Manually Updating the TA700/800 USB Driver

1. Install the new TA700/800 software as described in the software installation
section.

2. Click Start: Settings: Control Panel: System and click the Device Manager tab.
3. Find the Catalyst Test Tools entry.
4. Select and right click the Catalyst TA700/800 board.

Note: If the TA700/800 board is not present, please connect the TA700/800 to the host
computer using the USB cable.

5. Select Properties and click the drivers tab.
6. Click “Update Driver”

7. Choose the “Specific location” option button and deselect all other option
buttons.

» Using Browse go to:

“c:\Program Files\Catalyst\TA700 800\Predefined\USB Driver”
(Operating under Windows 2000 or Windows XP you need to enter
the “Win2k’ directory.)

* Click OK.

8. Click Next and then Finish to complete the USB driver update.




Catalyst Enterprises, Inc. Installing Your Analyzer

Connecting via Ethernet

You may use the ethernet connection using any one of the following 3 supported
configurations:

1. The TA700/800 connected to a network via a hub, switch, or similar device.

2. The TA700/800 connected to the host computer (machine running the
application software), via a hub, switch or similar device.

3. The TA700/800 connected directly to the host computer using a crossover cable.

Connecting to a Network

When connected to a network the TA700/800 must communicate with the DHCP
server to establish a connection. The DHCP server will continually send the next
available IP address to the TA700/800 until the TA700/800 software is started.

When the user starts the software, the user may be prompted if they wish the software
to automatically use the offered IP address or if they wish to assign a specific IP
address (the assigned IP address needs to be on the same network segment as the host
computer). The menu also allows the user to save the selected option (automatic or
specific address). If the assigned IP address is not available, the OS will notify the
user of an [P address conflict.

Internet Protocol (TCP/IP) Properties x|

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator for
the appropriate |P settings.

% Dbtain an IP address automatically

" Use the following IP address

I Use as default at next application run

Cancel I

After the user clicks ‘OK’ the software will search for all TA700/800 units connected
to the network, and will display a list of available TA700/800 units. After the user
selects the desired TA700/800 unit, the software will assign the IP address to the
selected unit, completing the connection and will launch the software.
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Select Device ; x|

Device List

Device ID | In Used | Connection Type | Board Type |
EIDDEESDDIJDGS No Ethernet T4 850 :

Caro

Connecting via Hub, Switch or Similar device

When connected to the host machine via a hub, switch or other similar device or
directly using a crossover cable the Catalyst board must communicate with the host
computer to establish a connection. The host computer will continually broadcast the
next available IP address to the Catalyst Board until the Catalyst software is started.

When the software starts, the user may be prompted if they wish the software to
automatically use the offered IP address or if they wish to assign a specific IP address
(the assigned IP address needs to be on the same network segment as the host
computer). The menu also allows the user to save the selected option (automatic or
specific address). If the assigned IP address is not available, the OS will notify the
user of an IP address conflict.

After the user clicks ‘OK’ the software will search for all Catalyst boards connected to
the network, and will display a list of available Catalyst boards, after the user selects
the desired Catalyst board, the software will assign the IP address to the selected
board, completing the connection and will launch the software.
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TA700/800 Overview

The TA700/800 PCI Bus Analyzer/Exerciser offers analysis/exerciser capability for
either PCI or PCI-X applications with the following capabilities:

* A convenient, easy to use Easy Mode that allows you to perform
95% of your PCI bus data capture & trigger without any
programming.

* An Advanced Mode offers you a powerful programming capability
for complex triggering.

* An Exerciser that generates bus transactions to exercise the bus as a
master or target while allowing you to monitor and capture the
resulting performance. An on board target memory allows testing
read/write operation of master agents.

* A Timing Analyzer capability is also included that allows the user to
capture bus timing violations. Not available for TA700P (PMC).
Not in current version for TA800.

Additionally, the TA700/800 includes Performance Analysis for real-time and
statistical measurement as well as comprehensive Device Compliance Test capability.

TA700/800 Working Mode Configurations

The TA700/800 may be operated in one of 6 working mode configurations, each
offering a convenient Easy Mode which requires no programming;:

The working mode configuration is selectable on the Main Menu Bar.

“P Catalyst Enterprises, Inc. TA700_TAS00 Software
File Edit Yiew Configuration Tools Macro Window Help

|J = @ H 38 ‘ % Bz B2 L% ﬁ IFCI State Analyzer
PCI State Analyzer
PCI Timing Analyzer
PCI Analyzer/Exerciser
PCl Async Timing Analyzer

@ bl

Easy Mode Switch to Advanced

PCI-X State Analyzer
PCI-X Analyzer/E xerciser

State Analyzer Only (PCI - PCI-X)

The TA700/800 Capture and Trigger mode allows hardware or software oriented PCI/
PCI-X bus debug without any programming or setup in the convenient to use Easy
Mode. A comprehensive selection of Pre-defined setups allows a variety of data
capture on several available trigger conditions for PCI and PCI-X applications.

The Advanced Mode provides for comprehensive user definition of complex data
capture and triggering projects. Users may define up to eight events covering all PCI/
PCI-X signals and employ them in a 32 level Sequencer program for a custom data
capture and triggering project. Sequencer state changes in a program may be defined
in terms of events, Boolean expressions of events and Protocol Errors.

10
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State & Timing Analyzer (PCI)
This mode of operation is not supported by the TA700PDC, TA800 or PCI-X.

To perform timing analysis for possible violation and to characterize Setup & Hold
limits on all or selected signals.

State Analyzer & Exerciser (PCI - PCI-X)

To perform Device compliance testing, characterize a PCI device by emulating
various bus cycles & terminations, injecting errors and generating traffics to measure
the PCI bus response. The exerciser may be used as a bus master to test and debug
new designs.

In Easy Mode the Capture and Trigger operates identically to that as in the State
Analyzer Only, except that the bus signals are generated by an exerciser program that
you define.

The Advanced Mode offers the same capabilities for analysis as the State Analyzer

Only except that as in the Easy Mode the bus signals are generated by a user defined
exerciser program.

Asynchronous Timing Analyzer (PCI)
This mode of operation is not supported by the TA700PDC, TA800 or PCI-X.

This option is used to perform high resolution sampling of the PCI bus signals using a
664 MHz asynchronous clock.

Additional Features

Performance Analysis

The TA700/800 provides continuous Real-Time performance analysis that operates
with Pre-defined or User-defined analysis files. On-board dual ported FIFOs interface
between the counters and the host system for transferring the measured data in real-
time without ever having to stop the counters. This feature provides a very complete
and accurate event count of up to 533 MB/Sec for TA700PCI (796 MB/Sec for TA700
PCI-X). 533 MB/Sec for TA800 PCI (1066 MB/Sec for TA800 PCI-X). An
implementation of eight counters with up to 32 bits allows a virtually unlimited count
of events.

11
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TA700/800 includes 8 counters which may be programmed to monitor the primary bus
activities and point-to-point signals or signals from the secondary bus.

Your TA700/800 includes complete setups to measure the most typical parameters as
well as giving you the ability to create your own setup. Real time Performance
Analysis allows you to count actual data transfers for any agent or agents matching
user specified address, measure and report bus utilization efficiencies, throughput,
latencies and retries, on-the-fly.

You may use real time Performance Analysis simultaneously with the exerciser to
generate traffic on the bus and measure performance of the target.

Performance Analysis results are presented in a Twelve-color display that you may
customize with your own color preferences and record in graphical format for later
review or demonstration.

Measurement intervals are selectable from 500 usec to 10 minutes.

Statistical Analysis

Statistical Analysis is implemented by capturing data in memory and then performing
software post processing.

Statistical Analysis measures and reports on Min, Max and Average occurrences for
several different parameters such as Latencies, Retry, Data Transfers, Command
Utilization, Bus Utilization and various Target Terminations.

The PCI Analyzer (Allowing the Master card to be plugged into the expansion slot on
top) can also measure latencies from request to the 1st data transfer including all of the
retries in between.

The data capture & trigger for post processing may be initiated per user defined events
on the bus, therefore yielding a very repetitive and consistent result.

The parameters measured may be selected for graphical display on the screen and may
be saved as graphical or list files for later review.

In the exerciser mode the TA700/800 can initiate data transfer to a target while the
trace statistics measures the latency response of the target.

Special Capabilities

Several other features are included in the TA700/800 such as Protocol Errors,
Mnemonics, Device Compliance Testing. Please refer to the appropriate sections for
each of these features.

12
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Launching Your TA700/800

TAZ00_TAS00
Software

Find LPT Port

Find USB Port

Double click the TA700/800 Icon in the Program Manager Window.

The TA700/800 software is pre-configured at the factory to look for LPT2 as the
selected port for the analyzer. If the software finds this port connected to the analyzer
program will launch immediately otherwise the software will ask you to specify which
LPT/USB port is connected to the hardware.

If you have connected your hardware to a different port e.g. LPT1, USB or Ethernet
(TA850 only), select the that port and click OK to launch the analyzer program.

LPT/USB Port Setting 21x]

" Search for LPT Part

" LPT1

v LPT2

{_ NP3

(" Search for USB Port

" TATO0_TASD0 Hardware Not Installed (Simulation Mode)

DK I Cancel |

If you are not sure which LPT port your hardware is connected to, check
“Search For LPT Port” then OK and let the software automatically locate
the LPT port that is connected to the hardware.

If you would like to use a USB port to connect to your hardware, check
“Search for USB Port” then OK and let the software automatically locate
the available USB ports to connect to the hardware.

USB Port Connection Dialog

l 1 USB devices found. |

Attach to device I 3:
Attach I Abort |

13
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Note: More than one TA700/800 may be connected via the USB bus at a time.
In such cases please be sure to select the correct one using the “Attach to
device” combo box.

1. Click OK to launch the software.

Performing Initialization and self Test

Analyzer state :

Analyzer (@
Abort I Trigger @

P Catalyst Enterprises, Inc. TA700_TAS800 Software

File Edit Yiew Configuration Tools Macro ‘Window Help

H B2 B & ¢ B BB PO state Anayzer =& k"HJ@ il S

Easy Mode Switch to Advanced

Figure 5 Analyzer Tool Bar

In the event that no LPT/USB port is found connected to the hardware, the software
will display the Hardware Not Detected message. To configure a LPT port see LPT
Port Setting on page 15.

TA700_TAS00 x|

' TA700_TAB00 Hardware Mot Detected.
) Software will run in Simulation Mode.

OK Cancel |
Simulation Mode Clicking OK in this dialog box will launch the analyzer software to
operate in the simulation mode.
LPT Port Problems If your analyzer hardware is connected to an LPT port and there is power

to the analyzer, but you are still getting the message Hardware Not
Detected then see the section on LPT Port setting below.

Bi-directional Port The host system LPT port must be a Bi-directional port. See LPT Port
Setting on page 15.

Launch Problems In the event that you experience difficulties in launching your software,
please see section on LPT Port Setting.

14
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Operating in Simulation Mode

Your system will operate in the Simulation Mode as default if the hardware is not
detected, however, you may operate in Simulation Mode directly without installing
the analyzer hardware. To operate without hardware, select Hardware Not Installed
(Simulation Mode) in the LPT Port Setting dialog box and click OK.

The Analyzer program will launch and display the tool bar as shown in Figure 5, but
with the limitation that the analyzer will display previously captured bus data.

Limitations The Simulation mode lets you try all of the available functions, but keep
in mind that the system is not capturing any real data and is displaying
pre-captured results.

LPT Port Setting

Your system parallel port may not necessarily be set to a Bi-directional mode even if
your system supports this mode.

Port not Configured If you continue to get a Hardware Not Detected even if you have set the
required LPT port, please check your system setting for your parallel port.

To set the parallel port:

1. Restart your computer and during boot, press F1 key to enter Setup (some
systems may use a different key than F1, please consult your system manual).

2. Once in setup select the Advanced, then Peripheral Configuration and then
Parallel Port Mode.

3. Select the Parallel Port to be configured. If your system supports Bi-directional
mode you must have choices for at least one of the following:

Bi-directional, ECP or EPP, preferably Bi-directional first then ECP
and last EPP.

Note that Standard or Compatible modes are not a Bi-directional
mode.

4. When finished with the configuration press ESC to exit setup and save the new
configuration.

15
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Configuration Menu

Configuation Teols Window Help
Working Mode v

Hnemonics...
Extemnal Signal Names ...

st TigerSetings.. Click Configuration on the main menu bar to display the various configuration

Woltage Check...

et options.
Zoom Options 3
Color Settings. .

Software Settings...

Authorization

System Feature Status
Configuration Space Information

Working Mode Allows you to select the analyzer configuration. The choices are: PCI
State Analyzer, PCI Timing Analyzer, PCI Analyzer/Exerciser, PCI
Async Timing Analyzer, PCI-X State Analyzer and PCI-X Analyzer/
Exerciser.

Protocol Errors Used to configure a Protocol Errors mask for use in triggering on protocol
errors. See Protocol Errors on page 155.

Mnemonics Used to define Mnemonics. Mnemonics may be used to display user
assigned names to specific patterns, in search a pattern in the display or
filter data patterns from a display. See Mnemonics on page 164.

External Signal Names  Allows you to assign specific names to external signals for display
purposes only. “External Signals” on page 166

External Signal/Trigger Settings Allows you to configure external input and output triggers. See
“External Signals” on page 166.

Voltage Check Used to select or deselect the voltages to be monitored for tolerance
compliance. See “Enabling Voltage Check” on page 17. Not available for
TA700P (PMC).

Host Bus Used to force the software to work with different bus characteristics than
the ones detected by the TA700/800.

Zoom Options Used to select zoom about X or Y cursor or between X and Y cursor or

Zoom Around when displaying a Wave data capture window. See Using
Zoom in the Wave Window on page 139

Color Setting Used to set custom color combinations for the Analyzer Performance
Analysis Window.

Software Settings Used to set global software user preferences. “Global Software Settings”
on page 21.

Authorization Enables purchased system configurations. See “Authorization” on
page 22

System Feature Status Displays enabled system features. See “System Feature Status” on
page 23

Configuration Space Information Displays the PCI characterization of the TA700/800 that is
presented to the System BIOS.
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Enabling Voltage Check

Working Mode

Protocol Emors...
Mnemarics...

Extemal Signal Names ...
Extemnal Trigger Settings...
Woltage Check.

Ho:

Zoom Options:

Color Settings...
Software Settings...
Authorization

System Feature Status

Configuation Space Infarmation

The TA700/800 is capable of monitoring the critical voltages on your PCI bus. TA700/
800 monitors a 5% drop in voltage for selected voltages and turns the SYS status LED
from green to red if any of the voltages drop by 5%.

Not available for TA700P (PMC).

To select voltages for monitoring:

Click Configuration on the main menu bar and then select Voltage Check. . . to
open the Voltage Check dialog box.

Note:

— Monitor Status Verifu Stat
[V Check +3.3V intemal to TA700_TAS00 @ M]
oK

[ Check Bus 5V @ |L X |
Cancel |

[V Check Bus +3.3¥ i

[V Check Bus +12 i

[V Check Bus 3.3 Vaux i

Figure 6 Voltage Check Dialog Box

Check the boxes in the Monitor column for voltages that you wish to be monitored
and click OK.

Top connector voltages not available for CPCI or TA800.

When the TA700/800 is powered from the bus, the Check +3.3V supply to TA700/800
and Check Bus +3.3V both display the Bus status, however when an external power
supply is used the Check +3.3V supply to TA700/800 will display the external power
supply status.
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After clicking Verify Status, the status column will display green LED for monitored
voltages that are within tolerance. A red LED indication signifies an out of tolerance
or missing voltage.

Verify that the SYS LED turns green signifying that the checked voltages are within
5% of their required values.

Host Bus

The TA700 hardware identifies the host bus type automatically at the
occurrence of the rising edge of the host bus RST# and displays the result on
the Status Bar at the bottom of the display.

|

Working Mode:

Protocol Emors...

Extemnal Trigger Settings...
Voltage Check ..

Zoom Options
Color Settings...

Softwars Settings
Authorization

System Feature Status
Configuration Space Information

Host Bus : PCI-X 133 MHz 3.3 Volt 64 Bit |System Frequency = 33.33MHz

In the event that the automatic selection does not match the host bus type of
your system hit reset and restart the software. If this fails you may set it
manually as follows:

Click Configuration on the main menu bar and then select Host Bus to open the
Host bus type selection dialog box.

Host Speed Change [ X|
Host Bus Width
 cmm cwm

Host Bus Type

|PCI 33.33MHz, 3.3V ]

IWI Cancel | Help |

Figure 7 Host Bus Type Selection Dialog Box
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Click the down arrow next to the Host Bus Type list box and select the bus type of
your system.

PCI 100MHz ~|

PCI 33.33MHz, 3.3V
PCl 66MHz, 3.3V
PCl 33.33MHz, 5v
PCl 6BMHz, BY
PCI-% 133MHz
‘PCI-% 100MHz

If your protocol selection does not correspond to your Host Bus selection you will get
a bus mismatch warning message.

Host Bus ¥arning ﬂ

The detected bus mode does not match the software setting. The software
has detected the system bus as PCI, while the software is set to PCI-X.

[~ Do not remind me again 0K | | Cancel I

Change the protocol to match the detected systen bus by clicking the down arrow on
the Working Mode selection list box and choose the required protocol.

Ee =} ‘ E% B [PCI-X State Analyzer j ) N2 H @& Il

PCI State Analyzer

PCI Timing Analyzer
PCI Analyzer/Exerciser
PCl Async Timing Analyzer
:PCI-X State Analyzer
PCI-X Analyzer/E xerciser

Figure 8 Protocol Selection
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Analyzer Window Colors

“Working Mode

Protocol Enors...
Mnemonics...

Extenal Signal Names ...
Extemal Trigger Settings...
Voltage Check

Host Bus...

Software Setting...
Authorization

System Feature Status
Configuration Space Information

Click Configuration on the main menu bar and then select Color Setting . . . to
open the Analyzer Window colors setting dialog box.

This color setting is used for the graph display in Performance Analysis and Trace
Statistics Analysis.

Analyzer Window Colors Setting | X] I

i~ User Defined Colors

Color 3 - Color 6 |:I Color 9 -
Colar 1 |:| Color 4 [:] Color 7 |:| Color 10 -
Coor2 [l coors | coors [l oo [

i~ Color Property
Red IU_ il | Default |
Geen [0 | 2l
Blue IE ﬂ M Cancel |
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Global Software Settings

Working Mode r
Protocol Errors...

Mnemarics...
External Signal Names
External Trigger Settinge...

Vologe Check - Click Configuration on the main menu bar and then select Software Settings to
el open the Global Settings dialog box.

Zoom Options »
Color Settings..

onzalmn
System Feature Status
Configuration Space Information

User Directory © |E:\Flogram Files\Catalyst\PCINTATO0_TAS00 4.63\UserDiry
[ TA_Release_V4. a
= 8 TA-HaIease-\M_I ¥ A3k for number of Inserts in Exeiciser Program
-] TA_Release V4. [V Close Previous Sample Window
-] TA_SRAC V483, y )
-0 TA_SRC.V4E3. ¥ Use Default Options for Utilitiss
@) TABE0_E30 [V &sk for “Save changes” on exit
{3 TA700 compliant ¥ Show Splash Scieen at Startup
#-0 ta700_capi_01
@] TA700 capi_rev ¥ View Sequencer in Text Mode
(-] TA700_TAS00 ¥ Save Software Settings on Exit
[=-{] TA700_TAB00 4 .
-3 com_api I~ Disable host bus mismatch message
{3 doc [ &sk for SBA Update
=] predefined
=ofEn .
q =r= """‘ e Scan Config compatible with PCl Spec: 21 & 22 |

Gl

Figure 9 Global Software Settings Dialog Box
Check the options that suit your needs and click OK.
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Authorization

An authorization code is required to activate additionally purchased features to
upgrade the TA700/800 as shipped.

Waorking Mode L2

Protocol Enors.
Mneman iics...

External Signal Names ..
[External Trigger Settings.

Volage Check. To enter the authorization code, click Configuration on the main menu bar and
Host Bus... . . . . .

Zoon Gl , then select Authorization to open the Authorization Code dialog box.

Caolor Settings...

Software Settings. .

System Feature Status
Configuration Space Information

TA700_TAS00 Authorization Diz 21|

@@ Enter Authorization Code

Authorization Code

T

oK Cancel |

Figure 10 Authorization Code Dialog Box

Enter the factory provided Authorization Code and click OK. You may verify that the
new configuration has been enabled as described in “System Feature Status” on
page 23.

TA700 |

._x"‘ You need to Restart the TA700 Software
{ o to Apply the changes!...

Note: The Authorization choice may be grayed out if your product includes all of the
available features.
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System Feature Status

“Working Mode 3

Pratocal Enars...
Mnemonics. ..
Extemal Signal Names ...

St Click Configuration on the main menu bar and then select System Feature

Host B Status to open the Features Status Display.

Zoom Options 3
Color Settings...
Software Settings...
Authorization

Configuration Space Information:

Features Status Dialog 21xl

Board Settings
Status : , Simulation Mode Board Type : I TA700
Factory Reference Number: | 166 Ram Size : I 128K

Feature Name

Expansion Memory Status : I Disable Expansion Memory Size : I 0
|

| Status

PLCI State Analyzer Enabled
PCI Timing Analyzer Enabled
PCl &nalyzer/E xerciser Enabled
PCl Async Timing Analyzer Enabled
PCI-¥ State Analyzer Enabled

PCI-X Timing Analyzer
PCl-X Analyzer/E xerciser

Waiting for the new release

Enabled

PCI-% Async Timing Analyzer Not Enabled
PCI Compliance Detected
PHMC-DC Not Detected
CPCI Mot Detected
C-API Not Enabled

Figure 11 System Features Status Display

The display shows all of the currently authorized system features.
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Configuration Space Information

Working Mode

Frotocol Emors...

Mnemarics...

Extemal Signal Names ...
Extemnal Trigger Settings...
Woltage Check...

Host Bus...

Zoom Options:

Color Settings...
Software Settings...
Authorization

System Feature Status

At power up the TA700/800 is automatically configured as a PCI agent and is setup to
allow the system to see the configuration. However, once the Analyzer/Exerciser is
programmed, the configuration space is hidden from the BIOS or any other agent
trying to access the TA700/800 space configuration. The initial configuration space is
stored by the software as shown below.

Click Configuration on the main menu bar and then select Configuration
.| Space Information to open the Configuration Space Information Display.

Note:

2]
| Catalyst TA700_TA800 Analyzer/E zerciser Board
Vendar ID : [0X1582 Vendor Name : [CATALYST ENTERPRISES INC.
Device ID : |0X0001 Command : IﬂNUUSD Status : lﬂNU43D
BIST : |OX00 Header Type:: IUXUU Revision 1D :  |0X01
Cache Line: |00 Class Code: |11 -80-00 Latency Timer : lDXIJD
-~ Base Address
[ Cardbus CIS Pointer: (200000000
1) |0X00000007 4] ]ENUUDUIJUUD
2) |00000000C 5) [G00000000 Subsystem ID : |0X0000
3) [1<00000000 6] [a<00000000 Subsystem Yendor ID - 0000

Hesewe:lUXUUUU Reserve : IUXUUUUUD Expansion ROM : |(X00000000
Hesewe:lﬂxﬂﬂﬂﬂ Capabilities Pointer : IMU B Max_Lat :
I\r‘lin_Gﬂst:Im‘(nn Interupt_Pin : IUXU1 Interrupt_Line : |00

|

Figure 12 Configuration Space Information Display

Configuration space information from the TA700/800 board is available only at
power on time and is not available after the board has been configured.
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Protocol Errors

To trigger on protocol errors immediately in Easy Mode, see Protocol Errors on page
32 and for Advanced Mode operation see Protocol Errors on page 155.

External Signal Names

To assign unique names to displayed external signals see “External Signals” on
page 166

Not enabled for the TAS800.

External Trigger Settings

To set external trigger parameters see External Signals/Trigger on page 166.
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Easy Mode

The Easy Mode offers you the capability to perform 95% of your bus analysis tests
without the need for any programming. When operating in the Easy Mode your
analyzer can perform the following:

*  Capture data and trigger on bus protocol immediately.

*  Perform Timing Violation detection and a search for Setup/Hold
limits.

»  Capture bus activity while exercising the bus.
e Do Performance analysis on PCI bus activity.
* Compute Statistics on selected parameters.

*  Perform Compliance Device test. (In State Analyzer & Exerciser
only)

Instant Data Capture & Trigger

Make sure that the TA700/800 is in the State Analyzer Only configuration and is
operating in the Easy Mode as shown on the Main Menu bar below.

EP Catalyst Enterprises, Inc. TA700_TAS00 Software

File Edit Wiew Configuration Tools Macra Window Help

|J =5 H é’" ¥ By E,‘Sb £ |[PCI State Analyzer =l & N‘?HJ@ el Il '-S..

Easy Made Switch to Advanced

1. Click the Green button on the Main Menu bar to open the Capture Data and
Trigger dialog box shown in Figure 13.
o3

Elcapture_pata.cdp

[ Exclude

* Evenpthing ™ Ides
(~ Specific Addressfes] = et
[ty source) -
Specilc Address(es) E

[This slot only)

Hew...

Trigger Paint Selection |

Trigger On : Address [ _I
= r i
] | Conmand: [30% | .| [y
Flemos
I™ Manusl Trigger Cleat Al |
[ Tiinger Addiess/DataSiess & 3281 C BaBil
Display: & Partial Memory [1000 | Samples " Entie bemoy
PreTigger (50%): 4| i 2| T uto Run |20 fimes
Bun || cencel | save | Losd. | iwoor. | Data Display Corfigusation | | Note.. |

Figure 13 Capture Data and Trigger Dialog Box

2. Select a Pre-Defined Trigger Point (See Table 1.) from the Trigger On
dropdown list and click Run. Wait to capture data and to view result. Figure 14
and Figure 15 show a typical Wave and List result display.
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Table 1. Pre-Defined PCI Trigger Points

1 |Address Triggers on specified address

2 |Any Interrupt Trigger when any interrupt occurs

3 |Burst Longer Triggers when the burst is longer than nnn times

4 |Burst Shorter Triggers when the burst is shorter than nnn times

5 |DMA Transfers Triggers when data burst is transferred

6 |Data at Address Triggers on specified data at address

7 |GNT# Triggers when GNT# is asserted

8 |Master Abort Triggers when a master abort occurs

9 I?]g;lg;ence of SERR# or Triggers when error SERR# or PERR# occurs

10 |Protocol Error Triggers when any PCI protocol error is detected

11 |REQ# Triggers when REQ# is asserted

12 |Reset De-asserted Triggers when reset is de-asserted, at rising edge of reset.
13 |Assert - De-assert Signal xxx asserted and then de-asserted nnn times

14 |Asserted Signal xxx asserted for more than nnn times

15 |De-assert - Assert Signal xxx de-asserted and then asserted for more than nnn times
16 |De-asserted Signal xxx de-asserted for more than nnn times.

17 |Signal Shorter Triggers when signal xxx is shorter than nnn times

18 |Target Abort Triggers when a target aborts

19 |Target Disconnect Triggers when a target disconnects

20 |Target Retry Triggers when a target Retry occurs

. Triggers when a consecutive target Retry occurs more than nnn
21 |Target Retry nnn times £g & Y

times
22 |Target Termination Triggers on target termination, combination
23 |Vendor & Device ID Triggers on Vendor & Device ID access.

27



Catalyst Enterprises, Inc. Easy Mode

Table 2. Pre-Defined PCI-X Trigger Points

1 |Address Triggers on specified address

2 | Any Interrupt Trigger when any interrupt occurs

3 | Attribute Triggers on a specific attribute phase with user defined address and
command

4 |Burst Longer Triggers when the burst is longer than nnn times

5 |Burst Shorter Triggers when the burst is shorter than nnn times

6 |DMA Transfers Triggers when data burst is transferred

7 |Data at Address Triggers on specified data at address

8 |GNTH# Triggers when GNT# is asserted

9 |Master Abort Triggers when a master abort occurs

10 ;)Eggj:nce of SERR# or Triggers when error SERR# or PERR# occurs

11 |Protocol Error Triggers when any PCI-X protocol error is detected

12 |REQ# Triggers when REQ# is asserted

13 |Reset De-asserted Triggers when reset is deasserted

14 |Asserted-Deasserted Signal xxx Asserted and then Deasserted for nnn times

15 |Asserted Signal xxx Asserted for more than nnn times

16 |Deasserted-Asserted Signal xxx Deasserted then Asserted for nnn times

17 |Deasserted Signal xxx Deasserted for more than nnn times

18 |Signal Shorter Triggers when signal xxx is shorter than nnn times

19 |Target Abort Triggers when a target aborts

20 E;g; t Disconnect at Next Triggers when a target disconnects

21 |Target Retry Triggers when a target Retry occurs

22 E?g%i;lsli;%le Data Phase Triggers on target Disconnect termination.

23 |Target Split Response Triggers on target Disconnects during burst.

24 |Vendor & Device ID Triggers on Vendor & Device ID access
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Figure 14 Wave File Output Display

To view the result as a list file output display, click the List button.
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Figure 15 List File Output Display

To return to the wave file output display, click the Wave button.

29



Catalyst Enterprises, Inc. Easy Mode

Selective Data Capture (Complete Bus)

You may refine your data capture by checking the Data Capture Selection as Specific

Address(es).
I =101 x|
Capture Data &nd Trigger |
[ Data Capture Selection
Exclude:
" Evenything ¥ Idies ADDY] [00o0m 27 .. | Command [ 20 L
! ™ wait ™| ADD ] [ | Command [ .
I~ | Retries I appp] [eeeeess Command [ 00e%
r— Trigger Point Selection
- Mew...
Trigger On : —
lS\'gnaI wa shorter than ninn times E‘ bodiy
wex: [ackesn = Remove
nnn: |1 ™ Manual Trigger T I
Trigger Address/Data Size: (+ 32Bit " B4 Bit |
Display: = Partial Memory [1000 | Samples € Entie Memary
Pre-Trigger [50% ) : ,ll _[ LI [~ Auto Run |20 times
Bun | Cancel I Save | Load.. I Impot: | Data Display Configuration | Note... [

Figure 16 Capture Data At Specific Addresses Dialog Box

Selecting this option allows you to specify data capture at up to 3 address ranges with
a specific associated command that is selected from the CBE# dialog box. To open the
CBE Type dialog box click the ellipses button next to the Command edit box.

CBE x|
- CBE# Type

(O el 101X Config (This Slot Only)
0000 Interupt ACK " 101 Config Entire Bus)
0001 Special Cycle " 1010 Configuration Read
001X 140 " 1011 Configuration \Write
0010 1/0 Read 1100 Memory Read Multiple
0011 140 rite 1101 Dual Address Cycle
011 Memory " 1110 Memory Read Line
0110 Memory Read 1111 Memory Wiite & Invalidate
0111 Memory Wite ' Any Memory

ok | Cancel | Hep |

Figure 17 CBE Select Dialog Box
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Selective Data Capture (Current Slot Only)

Choosing this option allows you to further refine your capture by limiting it to the bus

traffic originated at this slot only.

apture_Data.cdp = sl |
Capture Data And Trigger |
i~ Data Capture Selection
Exclude:
 Eveything I Idles aDD[) peaceeess .| Command [ 03¢ L
- [S’Azeycr.:ﬁlgress(eﬂ I Wait ™| ADD[ ] [redotd Command| [~ 5642
I” Reties I~ 4DD[] [e000aad Command| [ 5068¢
r~ Trigger Point Selection
= 5 New...
rigger On Address [000e00e | .
Address =l Modfy.
Command: [}¢00¢
Manual Tri
[~ Manual Trigger Cleat & |
| TiggerAddessiDatasie: & azei Coat |
Display: (" Partial Memory [1000 b|Samples C Entie Memary
Pre-Trigger (50%]: 4| il 2| T AutoRun)? times
Run Cancel Save | Load. | Jmoui | Dala Display Configuiation | Note...

Figure 18 Capture

Data for Current Slot Only.

Setup for this option is identical to the Selective Data Capture for the complete bus.
You may specify data capture at up to 3 address ranges with a specific associated
command that is selected from the CBE# dialog box. To open the CBE Type dialog
box click the ellipses button next to the Command edit box.

x|

; 7 € 101 Config (This Slot Only]
0000 Interupt ACK. " 101X Config Entite Bus)
0001 Special Cycle " 1010 Configuration Read
001X 140 € 1011 Configuration ‘Write
0010 1/0 Read " 1100 Memory Read Multiple
0011 140 Write " 1101 Dual Address Cycle
011X Memory 1110 Memory Read Line
0110 Memory Read 1111 Memory Wiite & Invalidate
0111 Memory 'Wite " Any Memory

oK | Cancel | Hep |
Figure 19 CBE Select Dialog Box
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Easy Mode

Data Capture & Trigger Exa

mples

The capture data and trigger dialog box changes depending on the type of Trigger On
chosen. The following are some examples.

Signal on shorter than nnn times. With this Trigger selection you must choose a signal from the xxx
dropdown list and specify the number of times in the nnn edit

box.
1 =131
Capture Data &nd Trigger |
[ Data Capture Selection
Exclude:
| Idles ADD[] (00000127 ... | Command peeed I
™ wait ™ ADDI ] [io0daui .| Command: [ )
I~ | Betiies | ADD[ ] [R5 Command | 55
[Tikirs slat onty] '
r— Trigger Point Selection
Mew...
Trigger On : _[
|S§gnal wx shorter than nnn times j Wodiy:
ks [ACKEMN = Heuma
nnn: |1 ™ Manual Trigger T I
Trigger Address/Data Size: (+ 32Bit " B4 Bit |
Display: = Partial Memory [1000 | Samples € Entie Memary
Pre-Trigger [50% ) : ,l‘ j _>| [~ Auto Run |20 times
Bun I Cancel | Save I Load.. | Impot: I Data Display Configwaliml Note... I

Protocol Errors

Figure 20 Specify Signal And Number of Times

When this Trigger On selection is chosen, note the PE button next to the

Trigger On list box. Clicking this button opens the Protocol Error mask.

@ Capture_Data.cdp i =10 -_)gl
Capture Data And Trigger |
i Data Capture Selection
Exclude:
@ Everything [V Idles
- E;'ner.wfi: Addiessles) I~ Wait
Ay source
< I~ Retries
Speciic Addiess(es]
(This slot orly]
1~ Trigger Point Selection
MNew..
Trigger On :
Protocol Error L’EI ety
20
(VIERROU - FRAME B must be de-asserted as soon as IRD'YH can be asserted from the lime STOPH was asserted, PCI Retva |
ck timing was transaction in Cee wirk the
(WIERRDZ - FRAMEH is not asserted within 16 clocks from the time GNT# was asserted. PCI Rev 2.2-3.4.1,
[WIERRD3 - FRAMER was asserted before the bus was granted(before GNTH was asserted) PCI Rev 2.2 -3.4.1
[WIERRD4 - IRDYH was not asserted a cycle immediately after FRAME# was deasserted. PCl Rev 22- 331 S
V|ERRODS - Improper termination _Either IRDYH, TRDYH. or STOP# were not deasserted after FRAME # was deasserted P
Display: & Pat |WIERROE - IRDY# was asserted on the same clock edge that FR&ME# was asserted .PCl Rev 2.2 - 3.3.1.
. | WIERRO7 - IRDY# was asserted when FRAME# was high.PCl Rev 2.2 - Appnedix CRule 7.
Fre-Trigger (50° | ERROS - After IRD'YH was asserted, IRDYH of FRAMEH were changed before the current data phase was completed or
[ JERRODY - IRDY# was asserted during the second addiess phase of a Dual Addiess Cycle. PCI Rev 2.2- 3.9
V|ERR10 - PERRH was asserted during special cycle. PCI Rev 2.2, - 3.7.4.1
VIERR11 - PERRH was asserted during addriess cycle. PCl Rev 2.2, - 3.7.4.2
[(JERR12 - PAR does not match parity across 0] and C 0). PCI Rev
[CJERR13 - PARB4 doss not match parity 38 -
4| »

Mote : Eror is masked as a trigger when unchecked.

Mask ALL Unmask ALL | Mask 64 BitSio. |

Pint | oK |

Cancel I

Figure 21 Trigger on Protocol Error

32



Easy Mode Catalyst Enterprises, Inc.

Data Capture Options

Memory Display You may limit the captured data display to a specific number of samples
by checking Partial Memory and entering the number of Samples to be
captured or, you may check entire memory to allow the capture for the
entire memory.

Extended Memory If your TA700/800 or TA700C has the optional extended memory, you
may limit the capture to 1MS, 2MS, 3MS or 4MS. The memory limit
flyout becomes active whenever the extended memory card is detected as

present.
Display: ' Partial Memory |1IJIJIJ . 1MS Entire |
. 2Ms |
Pre-Trigger (50%): 4| I IMS Aute
Bun | Cancel | Sav 4 MS !
Address/Data Size Choose 32 bit or 64 bit addressing and data size.
Pre-Trigger Pre-Trigger is set by default at 50% which defines the percentage of data

to be captured before and after the triggering event. You may change this
percentage by dragging the slider to the desired value.

Pre-Trigger Data The capture of the specified percentage of the data prior to the triggering
event cannot be guaranteed and may in some cases be 0. This can occur in
cases where the triggering event occurs before the required number
pre-trigger event data can be stored. In these cases the data display will
show fewer than the specified data points prior to the triggering event. For
more detail see Set Trigger on page 81.

Manual Trigger Select this option when you wish to manually interrupt the data capture
based on some external event. With this option selected, data will be
continually captured to memory and overwritten as required until you
stop the data capture.

Auto Run Continually captures data for the number of times specified. A separate
data file is generated each time that a capture is performed.

Exclude Cycles To simplify the captured data display you may check the options to
exclude: Idles, Wait States and Retries.
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Performance Analysis

ll:l Click the Performance Analysis Icon on the menu bar to open the Performance
Analysis dialog box
[Eocrommeenss T

Performance Analysis |

Performance Analysis Group: General Performance

Ayailable Items : Selected Items

Data Rate
Bus Utilization
Idle time:

Transfer Efficiencies

Master Efficiency A -
Target Efficiency =

Counters Mode:

* Reset " Accumulative ‘

Address/Data Size:

‘ Cycle Address: I){)QW _I Cycle Command: [Don't Care - ‘ & 280

lEnmpulas the bus p on the selected 648
[~ Savedatatofie: | _] Mo of Samples: {1000
Update Interval (10msec) ¢ ] | Mo of Windaws(15]: [~ =
NOTE: Use slower than 30ms intervals only for events

with low occurtences.
Bun Cancel | Save | Load. | G | Hote...

Figure 22 Easy Mode Performance Analysis Dialog Box

To perform an immediate Performance Analysis:

1. Click the down arrow next to the Performance Analysis Group list box and
select one of the four available analysis groups.

General Performance

Performance for Specific Agent
Transaction Termination
Command Utilization

2. Select the parameters for analysis from the Available Items list.
3. Select the counters mode, Reset or Accumulate and click Run.

Reset/Accumulate With Reset selected, the measurement counters are reset at the beginning

of each interval. With Accumulative selected, the measurement counters
will continue to add up.

Save Settings To save the measurement setup, first select Save to open the Save As
Dialog Box, enter a new file name to save as a *.pep file and click Save.

34



Easy Mode

Catalyst Enterprises, Inc.

Save Results

Review Results

= Peformance Analysis Review <5

wlwf offw = fr:

erfAnal pafy — Last Sample = 19 (=] 3

- Peiormance Analyzer Equations Chart Review <SimPerfAnal.pal> -- Last ... =] E3

wlwf olf® -

i B Vtzaton ©1)
e time )
u

| Tuaner Efciencies,

o e A ERE QI Iste/3 00,

vg Burst dala/addiess = 1.0 Data Per frdhess

Bus Utlization  © [CLOCKidle] 1 00/CLOCK = 50.0%  (Entie Bus on)
e bme: 1007ide/CLOCK =500 % [Entire Bus ony)

w/ak bme  [devaehdatal'100/devrel = 75,0 %

Translen Efficiencies : 100*data/devsel = 250 %
Masten Edficiency - ([100masterlidevsel] = 100.0 %
Taiget Elfciency  © [1100"arget)/{devsel) = 25,0 %

ide idy Clack.
13068 13068 55554 13888 833 55554

£4442 13888 168666

Figure 23 Performance Analysis Result

If you would like to save the analysis results, click Save to File enter the
number of samples you wish to save and the name of the output file.

For instructions on reviewing a saved performance analysis file, see
Saved Performance Analysis Review on page 81.
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Trace Statistics

PCI-X not supported in current version.

Trace Statistics analysis is implemented by capturing data in memory and then post
processing it with software. The analysis software is capable of measuring important
parameters such as Minimum and Maximum latency occurrences for any target or user
defined specific target, command utilization such as how many times an /O write
versus I/0 read occurs or, how many times memory commands occur. Available Trace
Analysis parameters that may be selected for a report are listed on page 39.

Obtaining Trace Statistics

ll.l.l Click the Trace Statistics Icon on the menu bar to open the Trace Statistics

dialog box

!]statisti cs_easy.tep

Trigger Point | Tmceﬁlaﬂsﬂm]

=101 x|

Update Interval (1 Sec) 4 | |
Pre-Trigger (50%): 4| Il i

~ Data Capture Selection
~ Exclude
I Idles
= w/ait
I | Retries
Trigger Point Selection
Trigger On : Address 0000000 | .
Addr o
g il Command: 232
Remove
I Manual Trigger Fa
| Tiigger Addiess/Data Size: C et |
[~ Savedatatofie: [ Mo of Samples: {1000

Bun | Cancel | Save | Load. | g

Figure 24 Trigger Point Selection

1. Select a Trigger Point from the Trigger On dropdown list and then select the
Trace Statistics tab to set the trace statistics options. For a list of available

choices see Trace Analysis Options on page 39.
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Selecting Parameters

Choose for Processing

Number of Samples

Update Interval

Address/Data Size
Graph, Report

Pre-Trigger

REET
Trigger Point  Trace Statistics I
- Calculat i~ Tiaee List
€ Percen ) Count (Select any parameter(s) you want to
 Ayerage  © Magimum Q r;j
0f [DEVSEL Speed | =>
™ Accumulative Tatal <=
At (00000000 Change
CMD: 000t Changal 1701 AL Address KAPUAIULINN
Display
Address/Data Size: = 32Bit B4 Bit ‘ ¥ Giaph  No. of periods [20 ¥ Report
I~ Savedatatofie: | [ Mo of Samples: [1000
Update Interval [1 Sec) 4 ﬂ
Pre-Trigger (50 % ): LI I |
Bun Cancel Save | Load. | i i | Note.

Figure 25 Easy Mode Trace Statistics Dialog Box

Select the parameters to be measured from the Analyze List Of shown in
Figure 25. Move the selected parameter to Trace List window for
software to perform interrogation on that parameter during post
processing by clicking the =>> button next to the Of edit box. Parameters
may be defined as minimum, average, maximum or count and or
percent depending on which unit applies. Parameters may also be
defined, if applicable, by address type.

Highlight the parameters in the Trace List that you wish to have
processed.

Set the amount of data to be captured in the memory for post processing
for each interval. The larger the number of samples the more time is
required for downloading and processing, Therefore you should select an
optimum number of samples to be captured to memory such as 1000. This
takes about one second to process. If your application requires more data
then a larger number should be entered.

If a small number of data samples is expected to be captured, say 1000,
and the application does not require repeated measurement, you may want
to sample data once every 5 or 10 seconds by changing the Update
Interval to 5 or 10 seconds as required. The larger of the two number of
data samples or faster update rate will be the dominating setup for data
capture time.

Choose 32 bit or 64 bit addressing and data size.

Checking either or both the Graph or Report check boxes will produce a
corresponding graphical and or statistical report.

Pre-Trigger is set by default at 50% which defines the percentage of data
to be captured before and after the triggering event. You may change this
percentage by dragging the slider to the desired value.
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Pre-Trigger Data

The capture of the specified percentage of the data prior to the triggering
event cannot be guaranteed and may in some cases be 0. This can occur in
cases where the triggering event occurs before the required number
pre-trigger event data can be stored. In these cases the data display will
show fewer than the specified data points prior to the triggering event. For
more detail see Set Trigger on page 81.

2. When all the parameters have been specified, click Run to capture the specified
data and perform the trace statistics determination.

Save Measurements

» Trace Statistics Review <SimTS.tsf> -- Last Sample = 19

[ EEED]
[ A=)
. %BusUt (33)

W Ewaiten

0.0ms
20s
40s
805
80s
10.0s
1205
14.0s
16.0s
18.0s
2005
2205
2405
26,05
28.0s
30,05
3205
3405
38.05
38.05

Figure 26 Trace Statistics Graphical Display

Row i Walue | Sample ltem

270 ns  Minimum of Latency T arget.
1.02us  Mawimum of Latency T arge s :
90 ns  Maximum of Latency Master AlAddress  HOOBROIEEEEE, - CMD: S0EE0H
30 n:  Minimum of Latency Master At Address: X0008000000KN - TMD: KodddxK

Count of Throughput [MB/Sec)

Maximumn of No of Data Transfer / Address

Minimum of Mo of Data Transfer / Address

Average of No of Data Transfer / Address

Count of 1/0 At Address: o000

10 0 Count of Memory At Addr{ss: KSR

n 0 Count of RETRY At Addrebs: )00

Medium : Maximum of DEVSEL Speed At Address: 2000000000000 - CMD: 20000000
Medium : Minimum of DEVSEL Speed At Address: X00000000000000 - TMD: MO00040KK
SampleNo: 1 -

14 270 ns M\nlrnum of Latency Target At Address: KEERKREXPRRA - TMD: X0KAX
158 270ns  Maximum of Latency Target At Address: MR - TMD: KX

000~ 00 O 4= 0 R

[RpErpr—y_}

16 90ns  Maximum of Latency Master At Address: 200000000000O0O0 - CMD: 2000000
17 30ns  Minimum of Latency Master At Address: }00000000000000MK - TMD: 20000004
18 0 Count of Throughput [MB/Sec) ;I

Figure 27 Trace Statistics Report

All measurements may also be saved and reviewed later, select SAVE and
specify the output file name. The results may be selected and reviewed
from the View option on the Main Menu bar.
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Trace Analysis Options

Latency Target
Latency Master
Latency Arbiter

Efficiency

Target Efficiency
Master Efficiency
Throughput Mb/Sec
Bus Utilization
IDLE

No. of Data Transfer/Addr
Wait

Int Ack

1/0

I/O RD

/0 WR

Memory

Mem RD

Mem WR
Configuration
CFGRD

CFG WR

MEM RM

DU ADD

MEM RL

MEM W&l

Total No of Data
RETRY

TABORT
DIS+DATA
DIS-DATA
MABORT

Latency, REQ# to Data

DEVSEL Speed

*Number of waits due to TRDY before first data phase
*Number of waits due to IRDY not asserted

Number of clocks from REQ to GNT (master board must
be plugged on top of the TA700)

Efficiency in percent for the duration of the captured data
*Number of TRDY# asserted over DEVSEL# asserted
*Number of IRDY# asserted over DEVSEL# asserted
Number of data transferred over time

Number of cycles DEVSEL# asserted over time
Number of IDLE cycles

*Size of data burst

Number waits or wait time in percent

Number of INT ACK

*Total number of I/O Commands

*Number of I/O Read Commands

*Number of I/O Write Commands

*Number of Memory Commands

*Number of Memory Read

*Number of Memory Writes

*Number of Configuration Cycles

*Number of Configuration Read

*Number of Configuration Write

*Number of Memory Read Multiple

*Number of Dual Address Commands

*Number of Memory Read Line Commands
*Number of Memory Write and Invalidate

*Number of Data Transferred during capture
*Number of Target Retry

*Number of Target Aborts

*Number of Target Disconnect + data

*Number of Target Disconnect - data

*Number of Master aborts

Latency time from REQ# asserted until data transferred,
including retries

Reports Target Decode speed

* Indicates a total or number at specified address or an address range
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Exercise and Capture

Make sure that the TA700/800 is in the State Analyzer & Exerciser configuration
and is operating in the Easy Mode as shown on the Main Menu bar below.

“[* Catalyst Enterprises, Inc. TA700_TA800 Software - performance.pep

File Edt View Configuration Exerciser Compliance Tools Macro Window Help

EEEIEE Y - IR

Easy Made Switch to Advanced

@ Click the Green button on the Main Menu bar to open the Capture Data and
Trigger dialog box shown in Figure 28.

Ejdata_capture_:uer.cdp ;lgl x|
Exerciser Program  Capture Data And Trigger I
i~ Data Capture Selection
o Exclude
 Evething  Idies
(~ Specific Address(es) I~ Wait
[Any source) s
~ Specific Address(es) s
(This slot only)

r— Trigger Point Selection
i = New...

oger’n Address [)00000K
|Addless j _I lulgel )

Command: [»0004 .
FRemove
I™ Manual Tri
== Clear &l |
| TiggerAddess/DaaSize: = 328t C B4BR |

Display: = PertilMemory 1000 b|Samples  Enliie Memory
Pre-Trigger [50%): 4| 1 2 T AutoRun|20 times

A | Cancel | Save | Load. | i | Data Display Configuration | Note.

Figure 28 Capture Data and Trigger Dialog Box

The data capture and trigger operation behaves identically to that as in the State
Analyzer Only configuration, with the exception, that the bus signals are generated by
an exerciser program that you define.

For details of setting up a capture see “Instant Data Capture & Trigger” on page 26.
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Defining an Exerciser Program

1. Click on the Exerciser Program tab to open the Exerciser Program definition
dialog box as shown in “Exerciser Program Definition Dialog Box” on page 41.

[{jdata_:apture_ener.cdp =0 El
Exerciser Progiam ] Capture Data And Trigger |
I Ict\pruglam fileshcatalystyta700_ta800\UserDitdnalyzerE serciserw1_20.dat Impait... Edit... |
| COMMAND | Taiget Addiess | Number | Target

LI Target Termination s i | Base Target Address C/BE of Data | Address

M1 MEM Wiite =l > ||ooooono Joo [ 1 .
M [M2 170 wiite =l ~]|oooo0aoo [ e[ .
M M3 [1/0 Read = J3 | [N E [ 1 .
Ma [intenupt ACK = 3 | R o | .
I_lMS Interrupt ACK = LI][EI[II]EIIZ\EI [T1] |
F[ME [intenupt ACK =l ~]00000000 | oo |
M7 [intenupt aCK [ Jid | [T J oo |
e [intenuptACK = 2 | | oo | .
M3 [intenupt ack = Ji | [T J oo |

™ Enable Local Memary

Display: " Partial Memory [1000 | samples £ Entie Memory
Pre-Trigger (50%]: 4| il 2| T AutoRun|? times

Bun Cancel Save | Load... I Import... | Data Display Ennl'gurdinnl Note... I

Figure 29 Exerciser Program Definition Dialog Box

2. Define up to 9 exerciser program lines by selecting a command type, data to be
written or a previously defined data block if applicable, target address, and data

size.

Set the exerciser options as described on page 42.

4. Click Run to perform data capture and trigger with exerciser generated signals.

[E_Spechdi. 1mp]

P Catalyst Enterpiises, Inc. TATOD Soltware

2 B Edi Yew Confprobon Egmcier Complonce Tgos Moo indon e

EEEEY Y | -m]@n-uua| ES

JAETES)

Easy Mode Swmich o Advanced

ample Tyoe : PCLS!

Exercizes.  Zoom
[Somsoon | _sctmsits | 4] X [»] + [ion]m8|m] ] |

Signaltlome  Value () | 7 & 5 4 2

Clock.
Time Gop Tane Gop
Ada2)
Detaf2]
CYCLE

ETle@ciTngl  TIVRefTog) eY10Hel Rell

Joalm WA WAT WAT WAT  WAT DATA  IDLE

Time_Rel
LAT_TGTY
LAT Mstr
LAT_ARB

o

INUM

Host Bus - PO Unkrowr B4 0 [System Frecqaency = 33 33HHz Simulabon Mods: |

Figure 30 Wave File Output
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Setting Exerciser Options

| DataBlocks...

| Options...
Set Intemupts...

Durnp Memary..
Read/Modify Wiite...
Write/Read Verify...

Address Test

Scan Configuration Registers...

Bus Exerciser's Options

—TAT00_TAS00D as Master
— Master Abort on No DEVSELH

" \Wait extra cycles
" Per PCl Specification

To set the exerciser options, click Exerciser on the menu bar and select Options
from the drop down list to open the exerciser dialog box as shown in Figure 31.

20 x|

On Target Disconnect/Retry

i+ Use same transaction

" Use next transaction

— Master Assert FRAME #

-
g

Regardless of GNT#
After GNT# asserted

— Master Completes Transaction at Time Out

% Disabled " Enabled

Default

o]

Cancel

On Target Disconnect Retry

Use Same Transaction

Use Next Transaction

Master Abort on No DEVSEL#

Wait Extra Cycles

Per PCI Specification

Master Assert FRAME#
Regardless of GNT#

Figure 31 Exerciser Options Dialog Box

Completes from the disconnect point on,
regardless of the number of times the target
issues a disconnect. The TA700/800 will take it
from where the target disconnect was issued and
try to complete the transaction from that point
on.

The TA700/800 will bypass all of the
transactions in the current command and will
jump to the transaction for the next command.

FRAME# says asserted 10 additional clock
before issuing a Master Abort.

A Master About will be issued on the 5th click if
no DEVSEL# is asserted.

Once the TA700/800 is set to become a master, it
asserts the frame and starts the transaction
regardless of the status of the GNT#.
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After GNT# Asserted

Master Completes Transaction at Time Out
Disabled

Enabled

The TA700/800 will request the bus and start the
transaction only after the GNT# is asserted.

The TA700/800 continues to complete the
transaction for however many clocks it takes
regardless of GNT# being deasserted.

The TA700/800 completes the current
transaction as soon as possible after GNT# is
deasserted.
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Creating a Data Block File

f To create an exerciser data file click the Data Block Icon on the Main Menu bar
I to open the Data File dialog box shown in Figure 32.
£ Data Filel HiE B3
Data Blocks Block Pattens w
Delete Block
Close
Help

Fill with W alking Bits

Binary Format

Figure 32 Data File Definition Dialog Box

Click New Data Block in the Data File Definition dialog box to enter a data block
(“Data Block 0”) in the Data Blocks area. With the new data block highlighted you
may define a specific block pattern or create a walking bit type pattern.

Fixed Data Pattern Click the Define Pattern button to open the Define Data Pattern dialog
box.

Data Size & Posiion
oK

Hex G | [

List Siee: [abi ¥ Cancel

Posiion: [0(31.0] b |
Repeat |4 times

Binary [00000000000000000001111111111111

Figure 33 Define Data Pattern Dialog Box

Enter a pattern and select the number of times that pattern is to be repeated and click
OK.

Multiple Line Pattern You may define a block of multiple lines that can be automatically
repeated. Figure 34 shows the definition of a two line pattern to be
repeated 3 times. To add a new line, enter the data in the edit box and then
click on the down arrow to include it in the list.
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Data———— Size&Postion

N ] |

List [FFFFFFFF See: [azbi ¥ Cancel
00000000

Positon:  [p[31.0] Help
Repeat |3 times

Binary 00000000000000000000000000000000

Figure 34 Define Multiple Line Pattern

Figure 35 shows the resulting block pattern where the defined pattern is replicated 3
times.

% Data Filel |_ [T ]
New Data Block
| Data Blocks | Block Patteins Joisaleslubas |
0000000000000000 Delete Block
00000000FFFFFFFF Close
0000000000000000 —
00000000FFFFFFFF Help

0000000000000000
00000000FFFFFFFF

Fill With ¥ alking Bits

Binary Format
|DDDDDI]I]I]DDDDDDUEBBBBDDDDDDODBDBm 1111111111111 1111111111111

Figure 35 Resulting Multiple Line Pattern

Walking Data Pattern Click the Fill With Walking Bits button to open the Fill With Walking
Bits dialog box as shown in Figure 36.

i~ Data Size & Position

Size : - Posilion 0[31 0]

Direction

ing Bil » o«
S 0 i " Right to Left

Repeat l*l—' times

Start Position : |31

0K I Cancel | Help

' Left to Right

Figure 36 Fill With Walking Bits Dialog Box

Enter the walking bit options desired and the number of times the data pattern is to be
written and click OK.

Figure 37 is an example of a walking bit “1” set in a direction of left to right to be
written 4 times.
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€ Data Filel S B3

- New Data Block
Data Blocks | Block Pattems eI 8 Dol
0000000080000000 Delete Block

0000000040000000 Close

0000000020000000

Help

Define Pattemn I

Binary Format
|DDIJDI]I]I]EIEIDDDI]I]I]I]I]EIDDDIJDDDDEIDDDDI]BBM 0000000000000000000000000000

Figure 37 Walking Bit Data File Example

To save the newly created Data file click Close click Yes In the Save Changes to the
Data File Dialog box.

Enter a file name name.dat in the Save As dialog box and click Save.

The newly created data file is now available for use with the current exerciser
program.
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Archiving a Project

Once you have completed a project and saved it under a unique project name you may
easily archive all of the project files in one operation.

New >
Open... Ctd+0
Close

Save as...

Printer Setup...

Brint... Ctrl+P
Print Preview

To archive an open, but saved project, click File and choose Archive

Archive Project... Crl+4

Restore Project... Ctil+E
E-mailto ... Ctr+Z

Exit

The Archive Project Dialog opens displaying all of the applicable project files. As a
convenience, you may also add other relevant files to the archive by clicking Add file
and then choosing the file from the Add File to Archive dialog.

Note: Make sure that your sample file is included in the Archive Contents list.

Archive Project Dialog [ ¥]

Archive Name : [J:\Catalyst\UserDirt\&dvancedPCl ExerciserlJserDefl.zip

Archive Contents:

JACatalyst\UserDir\ddvancedPCl ExerciserllseiDefudp.evn :_] Add File
J:\Catalyst\UserDiidvancedPCl ExerciserUseiDefludp.seq
J:\CatalystiUserDirvddvancedPCl Exerciserl)serDefludp.prg Delete File
J:\Catalyst\UserDitAdvancedPCl ExerciserUseiDefludp.exp
J:ACatalystiUserDirvddvancedPCl Exerciser)serDefl.udp

Send

_satri |
oot |
s |

K|

To complete the archive click Save.

E-mail archive To e-mail the archived project click Send and complete the e-mail address
in the e-mail dialog. This feature is useful for obtaining product support
from the factory.
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Restoring a Project

New »
Open... Ctrl+0
Close

Savece..
S ~ | To restore an archived project, click File and choose Restore Project to open the
Erint Gl Open Archived Project dialog

Print Preview

Brchive Project...  Cti+A

g Ctil+Z

Open Archived Project [ 7] x|
Lookin: | 4 Usei =] =
AnalyzelExerciser
Compliance
Ltility

@Advaﬂ:EdF’El ExerciseilserDef1.zip
‘,fEas!.lF'I:I ExerciserCaptureD atal. zip

File nhame: |EasyPCI ExerciserCaptureD atal.zip Open |
Files of type:  [ZIP File (~.2ip) = Cancel

Choose an archived project and click Open.

E-mail Archived Project

New 3
Open... Ctl+0
Close

e
Prirter Selup.. | To e-mail an archived or currently open project, click File and choose E-mail to

ok IR open the e-mail dialog.
Frint Preview

Archive Project... Clil+&
Restore Project... Ctl+E

E-mailto ... Ctl+Z

Exit
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b Customer Support Services [_ (O] x]
J File Edit View Inset Format Tools Message Help ﬁ

=
=

¥ @ ® o e S0 o |3 B B

Send [ Eopy s Pagte s nds Check Speling @ Attach  Priority Sign  Encrypt  Offine

To:  |support@catalyst-ent.com
e

Subject: lEuslumer Suppoit Services
Attach: }@AdvancedPCl Exerciser)seDefl zip 28.2KB]

[—L”_El E|B ZUuA |[EEEEsz==— Q&
=
Customer Support Services Note
|
%

Figure 38 E-mail Dialog box

Default E-mail Client The E-mail dialog box reflects the default E-mail client installed on your
system.

Default Recipient The default recipient of your E-mail is Catalyst Enterprises customer
support, but you may change that to any valid E-mail address.
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Exerciser Utilities

Dump Memory

Data Blocks. .

Dptions...
Set Interupts.

Dump Memory

Read/Modify Wiite. .
‘Wwhite/Read Verify

Address Test

Scan Configuration Registers...

To perform a memory dump select Dump Memory from the Exerciser dropdown
list on the menu bar. This will open the Dump Memory dialog box.

Enter a Start address and an End address or Count and click OK to perform a memory

dump as selected.

Dump Memory x|
Address Len
Start Address [00000100 o T
End Address IDDUDUZUU  64Bit
Count I
| 0K I Cancel | Help |

The resulting memory dump will be displayed as shown in Figure 40.

Figure 39 Dump Memory Dialog Box

Dump Memory Rezult !EB
Address Data =

R ™™ 0D0000000F D00 CB3

0x000000000000071 04 0x00000000FO00EFDS

0x00000000000001 08 0x00000000F000FO8S

0x00000000000001 0C 0x00000000C0006C0 3

0x00000000000007110 0x00000000F000EFEF

0x0000000000000114 0x00000000F000E FEF

0x0000000000000118 0x00000000F000E FEF

0x000000000000011C 0x00000000F000E FEF

0x00000000000001 20 0x00000000F000E FEF

0x00000000000001 24 0x00000000F000E FEF

0x00000000000001 23 0x00000000F000E FEF

0x00000000000001 2C 0x00000000FC 4E2637

0x00000000000001:30 0x00000000F000EFEF

0x00000000000001 34 0x00000000F000E FEF

0x00000000000001 38 0x00000000F 000E FEF ;I

Figure 40 Dump Memory Result
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Read/Modify Write

Data Blocks...

P To perform read/modify write select Read/Modify Write . . . from the Exerciser
ey, dropdown list on the menu bar. This will open the Read/Modify Write dialog

box.

Address Test
Scan Configuration Registers...

PCl Read/Modify Write Dialog [ %]
— Memory Content
Cur. Address[007FE0T0 MEMO07FEDT0] = 0000000000003 0D
Address Size:

" B4Bit Data Size: |8 bit 'I
= 32 Bit Data Position: [p(7.) vl

Cur. Add Content |0000000000003F0D
Mew Value |0000000000FA450C]
Modify Read

i~ Read/wite Command
& Memory € I/0 O Configuration

Read Next I Close I Help |

Figure 41 Read/Modify Write Dialog Box

1. Enter an address the contents of which you wish to modify in the Current
Address edit box.

2. Enter the value to be written to that address in the New Value edit box.
NOTE: This feature assigns the TA700/800 to be a bus master and may be used to read or

write to any register or memory address of a target device without having to use a
programming menu.
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Write/Read Verify

Data Blocks. .
. S | To perform Write Read Verify select Write/Read Verify from the Exerciser
Beothodits dropdown list on the menu bar. This will open the Write/Read verify dialog box.

ciess Test
Scan Configuration Registers...

B+ Write/Read Verify Programl = [T ]

Data File Mame : |ct\catalysl\useidir’\w1_32.dat Browse...
’ COMMAND ‘ TARGET ADDRESS E[ DATA/Data Block Name ggg
[Memoy  =][0007FEOD [00 ['DATABLOCKD" 2 |
Binary Format : {00000000

Compile... |

Figure 42 Write/Read Verify Dialog Box

1. Select the command type from the Command dropdown list, enter the Target
address, BE and either the data to be written or a previously defined data block
and a DMA size.

2. Click Compile & Run to perform the Read/Write verification.

3. To view the executable code as shown in Figure 43 click Compile and then to
perform the Read/Write verification click Run.

E+Verify Compiled Program1 [_[O]x]
Line | Loop | Clock Cycle Type R[F[1 AD[] C.[PIP[R[A[L] & [S[P] Loop | .=
E|R|R BE|A|AlE|CJO E[E| Count
Q|AID # |RIR|Q|K|C R[R
o0 HIMY 6|6|B[K R(R
E|# 414|4(# #|#
| e
M1 i1 MEM Wiite 0jof1 000000000007FEQD |07 f1j0f1f1[1[1111{1]1 2
M2 2 Last Data Phase 1[1]0] 0000000000000001 [ 0O|1{Of1]1]1][1111[1]1 0
M3 3 Idle 1]1[1 0000000000000001 aojtpiftjrngi 0
4 4 Idle 1[1]1] 0000000000000001 [ 0O|1{1[1]1]1[1111[1]1 0
M5 5 Idle 1(1]1] 0000000000000001 {00 1{T[1]1]1{1111[1]1 0
ME E MEM Wiite 0joj1 000000000007FEQS |07 fOjO[T[1[1]1111fT1]1 2
M7 7 Last Data Phase 1[1]0] 0000000000000002 | OO|T{Of1|1]1]{1111[1]1 0
M8 8 Idie 1111 0000000000000002_ (0O T{1[1)1]1{1111)1]1 0
M3 3 Idle 1[1]1] 0000000000000002 0O |1{1[1]1]1[1111[1]1 0
M10 10 Idle 1111 0000000000000002 (00| 1[1[1)1]1{1111)1]1 0 ﬂ
Emennkarmet: I
Loop Counter
Ir & rfirite ) Defimite | Insert | Delete Check Loops |
BUN Help

Figure 43 Write/Read Verify Compiled Program
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[ ‘whitten Data | Read Data [ Verify [
0x00000000 0x00000000 Pass
[00000004] 0:11111111 011111111 Pass
[D0000008] 0522222222 0422222222 Pass
[0000000C) 0433333333 0433333333 Pass
[00000010] 0x44444444 Oxd4444444 Pass
[DO000014] 055555555 0x55555655 Pass
[00000018] 0xBEEEEEEE 0+E6666666 Pass
[0000001C] 077777777 77777777 Pass
[00000020) 0+38038808 0x86888088 Pass
[D0000024] 0x33333999 0+99999993 Pass ﬂ
‘Wiite/Read Commands on Memory space. Close

Figure 44 Write/Read Verification Result

Address Test

Data Blocks.

Dptions...
Set Intemupts...

To perform an Address Test select Address Test from the Exerciser dropdown

Dump Memoy...

i list on the menu bar to open the Address Test Program dialog box.

‘Wiite/Read Werify...

iguration Registers. .

1. Enter the starting address to be tested and the number of addresses (Length) to
be tested.

B+«Address test Programl 0] x|

I COMMAND ‘ TARGET ADDRESS ’EI Length

| Memoy [00FA3000 [oo[re H

Help |

Compile... |

Figure 45 Address Test Program Dialog Box

2. Click the ellipses button next to the Length edit box to set the Read/Write
properties, click OK and then Compile & Run. The test results are displayed as
in Figure 47.
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Easy Mode

Proaram Line Properties | x|

Lddessing Size: @ e

DataSize: |32big vI DataPosition:lD[g]_ﬂ] vI

" Burst

— Readwrite Compile Mode

' Single

Address Increment :|4 bytes

Cancel |

Help |

Figure 46 Set Read Write Compile Mode Dialog Box

Address Test Result

X
3
Address | ‘whitten Data | Read Data | Veiify =
00FA3000] 0x00FA3000 0x00FA3000 Pass
[00FA3004] 0x00FA3004 0x00F43004 Pass
[00FA3008) 0x00FA3008 0x00FA3008 Pass
[00FA300C] 0x00FA300C 0x00FA300C Pass
[00FA3010] 0x00FA3010 0x00F43010 Pass
[00FA3014] 0x00FA3014 0x00FA3014 Pass
[DOFA3018] 0x00FA3018 0x00FA3018 Pass
[00FA301C] 0x00FA301C 0x00FA301C Pass
[00FA3020] 0x00FA3020 0x00F43020 Pass
[DOFA3024] 0x00FA3024 0x00FA3024 Pass
Wite/Read Commands on Memory space. Close |

=

Figure 47 Address Test Result
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Scan Configuration Registers

Data Blocks...

Dptions...

Eellunen To perform a configuration scan select Scan Configuration Registers from the
Dump M . .

BestModiyvite. Exerciser dropdown list on the menu bar.

‘Write/Read Verify...

Address Test

Scan Configuration Registers...

The system will search for PCI devices on the bus and display the configuration as
shown in Figure 48. All devices on the bus are reported. To see information on
additional devices click Next>.

Configuration Space
|? of 7) PCI Device - Simple communication controller BusMNo: |0
Vendor D: [06131F Vendar Nare: [Undsfined vendor name
Device ID: (<1021 Command: [(:<0003 Status: (<0280
BIST: |0e<00 Header Type: |00 Revision ID: |02
Cache Line: |0:08 Class Code: |07 - 01 - 02 Latency Timer: |00
Base Addiess
1) [1<0D 000000 4)[(<00000679 Cardbus CIS Pointer: [(00000000
2)[<00000401 5000000285 Subspstem 1D: [T<000D
3)[o<00000279 61{C<00000623 Subsystem Yendor ID: [(x0000
Reserve: |(0000 Reserve: (00000 Expansion ROM: (C:<00000000
Reserve: (00 -00-00 Capabilties Pointer: (<00 Max_Lat: |00
Min_Gnt: {0600 Interrupt_Pin: [Cbe01 Interrupt_Line: (<08
Configuration Address: (;X00800000
Wie PCI Corfiguation 1o this Device: | Rizad PCI Configuiation from this Device |
Load Save it | Readal | gack [ nen | Hep | Close

Figure 48 Configuration Header Display Dialog Box

You may edit all of the parameters displayed in white, if your hardware allows it. Edit
the field and then click on the “Write PCI Configuration to this Device” button.

To save configuration read all devices, find your device and save it to a file.

PCI 2.1 or PCI 2.2 Specification

Scan check may be performed to either the PCI 2.1 or PCI 2.2
specification. The selection of which specification is made on the
Software Global Settings dialog box. To set these options click
Configuration on the main menu bar and then choose Software Settings.
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User Directory: [D:\CatalystiUserDirh
52 0) =]
500 “MSSETUPT [ sk for number of Inserts in Exerciser Program
& eMp ¥ Close Previous Sample Window
=0 Catalyst
{1 Examples IV Use Default Options for Litiities

(# (1 PreDefined

8 ; SystemData ™ Ask for “"Save changes" on exit

3 User ¥ Show Splash Screen at Startup
SRS e
- corel® IV View Sequencer in Text Mode
3 DBF v ) :
6 0 exras ¥ Save Software Setlings on Exit
@] Live3D
1 Mail Sean Config compatible with PCl Spee: 21 % 22 ‘

(- 0 Microsoft Difice

3 madownid tmp = ok | Cancel Heo |

Scan Direction Limitation The TA700/800 may be used in any bus location including downstream

Device Compliance

from a bridge. Since the TA700/800 can only scan subsequent buses
through a bridge in a forward direction devices above the bridge will not
be found.

To perform an immediate device compliance on a device, see
Compliance Device Test on page 116.
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Generate Traffic and Measure Performance

Make sure that the TA700/800 is in the State Analyzer & Exerciser configuration and
is operating in the Easy Mode as shown on the Main Menu bar below.

“[* Catalyst Enterprises, Inc. TA700_TA800 Software - performance.pep

File Edt View Configuration Exerciser Compliance Tools Macro Window Help

IEEEIRE N e RN IR ) b

Easy Made Switch to Advanced

Performance Analysis with exerciser requires you to define an exerciser program as
described in Defining an Exerciser Program on page 41.

M Click the Performance Analysis Icon on the menu bar to open the Performance
Analysis dialog box as shown in Figure 49.

_ioix]

Exerciser Program I Performance Analysw&'
l Iroport... | Edit... I |

[ COMMAND | Target Address Number | Target

I — Taiget Temination ARl Base Taiget Address — of Data | Address

M1 [Intempt ACK > Ji3 | E 1
¥ [M2 " [MEM Fead - | [00000000 o[ 1
2 CER - =|[ooooo0oo o [ 1
M4 Jintemupt ALK E Jia | [ o[ 1 !
M5 [internupt ACK =l Ji2 | FET] [[oo [
TM8 Jinternupt ACK = Ji | ] on i
7 [intemupt ack = J | ] 00 1 2
M8 Jintenupt ACK = ||00000000 oo 1
M3 internupt ACK =l i | T o [ 1

™ Enable Local Memary
I~ Savedatalofie: [ =] No of Samples: [1000
Update Interval (10msec) 4| | 2+ o of Windows(1-5]: [17=]
NOTE: Use slower than 30ms intervals only for events
with lows occurences.
Run Cancel Save | Load... | Impoit... | Note.

Figure 49 Performance Analysis with Exerciser
To perform Performance Analysis with the exerciser:
1. Define the exerciser program, such as reading or writing to a known memory
location.

2. Click the Performance Analysis Tab and set up the Performance Analysis as
described in Performance Analysis on page 34.

3. Click Run.
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Easy Mode

Generate Traffic and Measure Statistics

Make sure that the TA700/800 is in the State Analyzer & Exerciser configuration and
is operating in the Easy Mode as shown on the Main Menu bar below.

“[* Catalyst Enterprises, Inc. TA700_TA800 Software - performance.pep

File Edt View Configuration Exerciser Compliance Tools Macro Window Help

IEEEEEE Y - BRI ]

Easy Made Switch to Advanced

M Click the Trace Statistics Icon on the menu bar to open the Trace Statistics dialog

box as shown in Figure 50.

'_Estatisti(siqenerateieasy.tep

Exerciser Ploglaml Trigger Point  Trace Statistics I
Calculate
 Percent. = ) Total
C fvprsge O Magmum € Minimum
of [RETRY =l
I™ Accurulative Totsl

TR ecerid Change
CHD |20 Change

Trace List

[Select any parametei(s) you want to see] Clear List

Address/Data Size: ' 32 Bit " B4 Bit ‘

Display

¥ Graph  No. of periods |20 ¥ Report

[~ Savedatatofie: |

Update Interval [1 Sec) 11

Pre-Trigger (50 % ) : _:j J _!J

B

=

Mo of Samples: [1000

Bun | Cancel ] Save | Load... | Impart.

Figure 50 Trace Statistics With Exerciser

To obtain Trace Statistics with the exerciser:

1. Set the trace statistics options and the Trigger Point as described in Obtaining

Trace Statistics on page 36.

2. Click the Exerciser Tab and define the Exerciser Program as described in

Defining an Exerciser Program on page 41.

3. When all the parameters have been specified, click Run to capture the specified

data and perform the statistics reporting.
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Timing Analysis - Synchronous

Make sure that the TA700/800 is in the State & Timing Analyzer configuration and is
operating in the Easy Mode as shown on the Main Menu bar below.

This mode of operation is not supported by the TA700PDC, TA800 or PCI-X

“F Catalyst Enterprises, Inc. TA700_TAB00 Software
File Edit VYiew Configuration Timing-Analyzer Tools Macro ‘Window Help

£

Easy Mode Switch to Advanced

(8@ o]0 ne s o ||

In this mode you may immediately detect and capture timing violations on all bus
signals. Any bus “glitch” of 1.5 ns or greater is captured as a timing violation.

You may also perform a Setup/Hold Limits search on any or all PCI bus signals by
using a convenient signal mask.

Caution: When performing measurements at 66.6MHz, make sure extender switch
if OFF.
_ To perform an immediate timing analysis, click the Timing Violation
!v! Icon to open the Timing Violation Analysis dialog box.

® TimingViolation1

Tiring Vielation Ansysis |

This project looks for Setup and Hold time violations.
The measurement is made for minimum specified Setup & Hold requirement
per the PCI bus specifications:
Frequency Setup Time Hold Time Glitch
15-33.33 MHz Tns 2Ins 15ns
33.33-66.66 MHz 3ns 2ns L5ns
File Name: [J:\Catalyst\Predsfined\Simulation\ Timing.Stp J W (e o e

Display: & Patial Memory [1000 Ji|samples © Entre Memary
Pre-Triger (0%): 4| 1 #| I AutoRun|™ times

Bun | Cancd | Save || Load. | it | DataDisplay Canfiguration | Note..

Figure 51 Timing Violation Analysis Dialog Box
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Easy Mode

Timing Violation Capture

1. Set the desired data capture options such as Pre-Trigger percent, Display
Memory etc. and click Run.

The occurrence of the first timing violation will cause a trigger and open the Timing
Violation Results display as shown in Figure 52. The red signals represent a timing
violation. Bus signals are shown in a code. As an example 00000080 indicates that the
timing problem is for AD7, and 1000000C indicates the problem is for AD28, AD3 &

AD?2 signals.

SeopSevon | Bookmads | 4|

* |ioso]mm w5 |

[Signel Name |vaue 09 | 2

Clock,

Time Gap Time Gap
lad[32) 50000000
Data[32]
CveLE INTACK
FRAMEZ? 0
IRDive 1
DEVSEL# 1

1

STOP# 1
TE_AD[E3-0]  0050000->
[TE_G/BE[?-0]

TE_AD[]

TE_DEVSEL#
[TE_FRAME#

[TE_PERR#

[TE_AD[0}

x|
1

qunm
2 4

0 1 2
L il I

Figure 52 Timing Violation Results Display
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Search for Setup & Hold Limits

To search for setup and hold limits click the Setup/Hold Limits search Icon to
open the Setup and Hold Limits Mask definition dialog box.

® Search for setup & hold values -] x]
Setup/Hold Limits |

Mask the signals you want to ignore in search,

[ea]e2]61[60]59]58]57 5655 [ 54] 53] 52]51]50] 49 48[ 47 [46 4544 [43] 42[ 41 [40]39]:
MDDRESS | % % X % X X X X % % % X X X X X X K X X X KR X % X

(T 0|

P T
SO PO
Tmon
En=o
Tmon
Tmon
o

o

o

o
LG
#MZ XM
<O D
H <0 D~
#OVO—W
HANOr
#OmMmD
®AZ 0
#rnOmMmD
LD
PR HAZ
W=~
- -
O Z =
#HODMun
HODOMD
H-ALD
#MI D

| #wrmu=mo

OO0 XXX XXX X X X

~Address/Data Size
& 328it C B4Bit ‘

This program performs a reaktime search to find the Setup and Hold values for the selected [Unmasked) signals on the bus.

Seaich Cancel Help

Figure 53 Setup and Hold Limits Mask Definition Dialog Box

Select the signals that you wish to ignore in the search and then click Search. At the
completion of the search the result is displayed as shown in Figure 54.

Timing Violations B3

Setup Time : 7.50 [Nanosecends]
‘Hold Time: 4.00 [Nanoseconds)

Figure 54 Setup and Hold Limits Search Result
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Timing Analysis - Asynchronous

Not available for TA700PDC
PCI-X and TA800 asynchronous timing not supported.

Asynchronous timing analysis uses a 664 MHz independent clock to sample PCI bus
signals. This clock is asynchronous to the PCI bus clock and allows a very high
resolution sampling of the bus signals.

Caution: The TA700/800 may draw as much as 4.0 A during an asynchronous timing test, the
TA700/800 board must be configured to operate from the + 3.3V bus power. JP2
shunted between pins 2 - 3.

To perform an asynchronous timing analysis, make sure that the TA700/800 is in the PCI Async
Timing Analyzer working mode as shown on the Main Menu bar below.

“F Catalyst Enterprises, Inc. TAT00_TA800 Software
File Edit View Configuration Tools Macro Window Help

H = 5 H S ‘ 5 (2] | 55 4 |PCI Async Timing Analyzer | () RQH@ ';S\
Easy Made Switch to Advanced

@ Click the Green Icon on the Main Menu bar to open the Capture Data and
Trigger dialog box shown in Figure 55.

(& EasyPCl AsyncCaptureD atad

:auuenu.s.www]

Data Ce

& Eveytting ’

AMW__I Hew..
Command: [000 Ll ey
I Manual Trigge: =
Clear A1
Display: & ParidlMemery [1000 b Samples ¢ Ervre Memay Asyncionous Option - & Option & € (1771010
Pre-Tigger [S0%): 4 I'| 2| T aoRun|? tme:  Addess/DataSize @ 3281 O B4Bi
Bn | Cocal | sove | Load. | oo | Dita Disslay Contigration | Hote.. Help.

Figure 55 Asynchronous Timing Capture Data And Trigger Dialog

1. Select a Pre-Defined Trigger Point (See Table 1. on page 27) from the Trigger
On dropdown list, select the Asynchronous Option A or B and set the desired
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data capture options as outlined on page 33 and click Run. Wait to capture data
and to view the result as shown in Figure 56.

Asynchronous Option A Samples PCI control signals and addresses AD[31 . . 0]
Asynchronous Option B Samples PCI control signals and addresses AD[63 . . 32]

P Catalyzt Enterprises. Inc. TA70 Softwase - [Atync_E_Spechdd.imp]

2} Fie Edt View Conigeaton Tgck Window Hep =18 %]
E A E S a R E | 00 A T Ao 7] W] @] &
_ _ Eaay Mode Swich 1o Advanced
Sarnoke Type - PLI Atymchicrous Timng Anskzer Opton Zoom KTIerTigl  [¥-TIIMRekTrig) Y] pRevRel]
[immsenn | esurwe | o X o] = [molm|m]s | o0
Signal Name .lelBN .I\II Js Ia I—? L3 ‘{ ‘4 lﬂ IZ J| In ll IZ J3 I. L5 IE
s [y ) i
Too 530 | 25502405 256020027108 028614 012 ) D6 30020 45180 6024 530w S0%0 105420 120481385 s 15 060 1656
sk [
FRAME# L)
IRDY# 1
DEWSEL# 1
TROVE il
STOP# 1
CYOLE WAIT I0LE VDWR WAIT CWAT AT WAIT WAIT  WAT WAIT WAIT WAl
. ,
Host Bus - POIBE 68 MHz Vol 3281 [System Fiequency » 33 33MHz |Smulalion Mode INUM

Figure 56 Asynchronous Timing Data Capture Wave Display
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Advanced Mode

The Advanced Mode expands the analyzer capability by allowing you to program
special custom debugging projects and define complex triggering levels. Such projects
are programmed by defining event patterns for triggering and triggering sequences om
convenient Event Pattern definition and Sequencer programming menus.

The State & Timing analyzer configuration, in addition to the special programming
with event and sequencer files, also expands the Timing Violation Analysis by
allowing you to chose leading and trailing edge timing values.

With this expanded capability you may perform all of the same analysis functions as
in the Easy Mode but with much customizing.

Setup complex triggering level to Capture data and trigger using
custom projects.

Perform timing characterization timing violation detection.

Capture bus activity and the device under test response under
different conditions using the exerciser.

Do Performance Analysis on PCI bus activities.

Measure and report Statistics on selected parameters.

Easy Mode Access As a convenience to allow you to get a quick snapshot of bus activity, the
Advanced Mode menu bar includes a Yellow button that gives you access
to an Enhanced Easy mode.

Enhanced Easy Mode Accessing the Easy mode from the Advanced mode expands the exerciser
programming capability to include program loops
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Custom Capture Data Project

With the TA700/800 operating in the Advanced Mode as shown on the Main Menu
bar below, make sure that the Working Mode is PCI State Analyzer or PCI-X
Analyzer.

=P Catalyst Enterprises, Inc. TA700_TAS800 Software

File Edit View Configuration Tools Macro ‘Window Help

|@ @ B 4% @ @28 #&[Posate Anayzer EERIICEC-TM

Advanced Mode Switch to Easy

For a custom project you must define/program:

e A set of Events
* A sequencer Program

Example Files Your analyzer includes a set of pre-defined Project, Event and sequencer
files. You may load a complete Project or import Events and Sequencer
programs to perform pre-determined tasks. For more detail see Example
Files on page 113.

1. Click the Black button on the Main Menu bar to open the Custom Project dialog
box shown in Figure 57.

€3 AdvancedPCl AnalyzerUseiDef2 _ [ =]
Event Patteins Sewmnml
3| o stated ( | +
While Capturing All PCI Signals At "Every_Clock" { Add State
If"PCI_Clock(s)" Oceurs .. " Then GOTO "Statel”
Otherwise Contnue With This State } Add Else If
Q Statel { Défm
Set_Tngger =
While Capturing All PCI Signals 4t "Every_Clock" { ke
If"1" "PCI_Clock(s)" Occurs "..." Then GOTO "Statel" Font
Otherwise Continue With This State } 7
) Full Screen
S o
o | <
L} ¥ Form
File Mame: | _I ™ Increment filename automatically
Display: (' Patial Memory |1000 »|Samples ¢ Entire Memory
Pre-Trigger [50% ) : l, J _>| [~ Auto Run |20 times
Bun | Cancel | Save | Load... | Import.. | Data Display Configuration Note... Help ]

Figure 57 Custom Project Dialog Box
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Defining Event Patterns

An Event pattern defines the PCI/PCI-X bus signals, including address, data and control signals to:

e Define the data capture manipulation.

* Define events that are used for Performance Analysis and Bus
Utilization measurement.

You may define up to 8 events identified as follows:

EV1-EVS 8 Events with identical capability.

DEFAULT NAMES EV1 - EV8 are default event names that may be changed to a user defined
descriptive name for reference in the Sequencer and Performance analysis
displays.

PCI SIGNALS All PCI bus signals are included except JTAG which is used for boundary
scan testing.

EXTERNAL The TA700 & TA850 supports 16 external signals that are all sampled and
captured in memory in synch with the PCI bus signals. Not available on
the TA800.
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Creating an Event Pattern

Click the Event Patterns tab to open the Event Pattern Definition dialog box.

€ AdvancedPCl AnalyzerUseiDefl [_ [T x]
Event Patteins |Sgwmgu]
Name XFER AD[ ] cee[1 | P [1[e[x]p[r[s[L] r/G [inTx [ E [R]3.[P| EXT
A [D|r|R|E[R|T|O R (5|3 |v| ERN
S|AID¥|D(O|C R [T(V|E
E|v[¥|s|¥|r|k #|a|#| s16
L|(E|#|E|#|&# u NAL
# (L *®
#
Ev1 XXXXXXXKXXXXHXKK ~ XXNXXXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
Ev2 XXXXXXXKXXKXXXKX  XXXXXKXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
EV3 ARRRAKLKKRRRAR KKK ARKKKKRY XX X X X X X X X XXX XKXX XX X X X X¥¥X
EV4 AXARXKXXARK AN ALK AXKKKEXY XX X X X X X X X XXX XXXX XX X X X XXX
EVS EXARKKXXARAKARREX ARXEEXAE XX X X X X X X X XXXX XKXX XX X X X XXX
EV6 XXHXXXXKXXXXHKKX | XXNMEXXX XX X X X X X ¥ X XXXX XXX XX X X X X¥XX
EV7 XXXXXXXKXXXKXXXKX  XXXXXXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
fewg XXRRKKKKRRKKHRKE | RNKHEKEK XK X K X ¥ X X X KKK KEKK XX X X X XEXX
Clear All Events
File Name: [ _I ™ Increment filename automatically
Display: & Partial Memory [1000 »|Samples ¢ Entire Memory
Pre-Trigger [50% ) : l, J _>| [~ Auto Run |20 times
Bun | Cancel | Save | Load... | Import... | Data Display Configuration Note... Help ]

Figure 58 PCI Event Pattern Definition Dialog Box

To enter a parameter or edit a previously entered parameter, double-click in the
appropriate data field to open a corresponding dialog box, enter the required data, and
click OK. The changes entered will be reflected in the edited data field.

Keyboard Edit You may also edit all of the data fields by using the keyboard by moving
through the available data fields using the arrow keys and pressing Enter
on the desired field to either open the associated dialog box or to change
the contents from X to 0 to 1.

Name an Event For example, to define EV1 as mem_addr, double click in the EV1 field
to open the New Event Setting dialog, enter the new event name and
click Rename.

) AdvancedPCl AnalyzerlseiDefl (O] x]
Event Patteins |Sgwmgu]

Name XFER AD[ ] cee[1 | P [1[e[x]p[r][s[L] r/G [nTx [ E [R]3.[P| EXT
p|r|R|E[R|T|O R [5|3[v| ERN
s(alp|v|p(o|c R [T|v|E
E[M|¥|5|¥(P|K #|a#| s16
L[E|[#|E |#/|#|# u| | NaL

#| L X
#
mem_addr XXXXXXXKXXXXHXKX  XXKMEXXX XX X X X X X ¥ X XXXX XXXX XX X X X XXXX
Ev2 XXXXKXXKXXKXXXKK | XXKXXXXX X X X X X XXXX | XXXX XX X X X XXXX
EV3 XXRKKKKKARRARRRY el
Ev4 oooooaseoones | xeoon
EVS5 XXRKKXXKARKARKKL | RAKKHR e
EV6 XAAXAAXKARKKRKKL | KXXHXH New Name : Bename
EV7 XXXXKXXKXXKXXXKX | XXKKXX
L e XXRKKXKKARKXRKKK | XREXXX|  Select Mnemonio
Close.
Impoit
Export =k =
File Name: | | ——
Import All
Display: ' Partial Memory |1000 P |Samples ¢ Entire M Export Al
Pre-Trigger [S0%): 4] 1 | T AucF
Fun | Cencel | save | Lead. | | I

Figure 59 Naming an Event
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Mnemonics as Events

External Signals

Set Default

Set Transfer Type

To use a pre-defined Mnemonic as an Event, double click in an Event
field, then select a Mnemonic from the Select Mnemonic window in the
New Event Setting dialog an click Import. For a detailed description of
Mnemonics see “Mnemonics” on page 164.

External input signals are an extension of event definition. You may
include an external signal with an event definition by double clicking the
in the External Signal data field and entering an external signal number
between 0 and OxFFFF.

) AdvancedPCl AnalyzerUserDefl =10l x]

Event Pattemns | Sequencer ]

Name XFER AD[] CBE[ ] P R/G | INTX | E EXT
A

ERN

SIG
NAL

-
mmng -
#mMLT

% X x x| BEMIBPDT
#RNO"

=
==

XEQcww

eHt 01 e XXXXXXXXNXXKMNNN  HXNNXXXK XX
Ev2 XRXXXXXXXXKXXXKK  XXXXXXXKX XX
EY3 ARXXXLXARAKKLAXR XXXAXKEX XX
Ev4 AXXXXKXXAXRXXXKAXK XXXXXXXX XX
EV¥S5 XRXXXKXXXRXXKLXXK XXXXXXXX XX
Ve
EV7 -
e

X X XX X XX KEXX XX X X X XXXX
XX XX X XRXX XEKXX XX X X X XXXX
X XX X XXX XKXX XX X X X X¥EXX
X XXX
X XXX

XXXX XXXX XX X X X XXXX
XXXX XKXX XX X X X XXXX

HEIEIEIE I

Exte 5.0
Input Data Format
& Hex O Binay [T SetFenae

— oo
File Name:

Display: % Patial Memmory [100

Pre-Trigger [50 %) : ll 16 Bits maximum.

= Cancel oK I Cancel | Clear | Help |

Figure 60 Invoking an External Signal

To set all of the PCI signals to the default value of don’t care, X, for any
given event EVx, position the highlighted cursor anywhere in that row
and hit the “del” key.

The transfer type selection dialog box shown in Figure 61 controls the
pre-determined signal settings and address limits based upon the XFER
type selected. For example, with A32 selected as shown, the address field
is automatically limited to 32 bits, a limited CBE dialog as shown in
Figure 62 is enabled, 64 bit settings in the PAR dialog and the R/G dialog
are grayed out. Additionally the IDSEL, FRAME#, IRDY#, DEVSEL#,
TRDY# and STOP# are pre-defined and unchangeable.
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Limit to Current Slot You may qualify an event to be applicable to the transaction started at the
current slot only by setting the “Latched” option in the R/G dialog.

R/e 2|

REQ GNT RENES AEKES

1 N §5 I 0l

0 o1 oy o

% C X = %
* Latched

0K I Cancel I

Alternate qualification A different way to qualify an event to the current slot is to double click
the XFER field and then select the desired latched transfer type LA32,
LMX32, LA64 or LMX64. These options are the same as A32, MX32
etc. except that they apply only to the slot that the TA700/800 is installed
in.

- XFER Type

2/ x|
.
_ Comcel |

" D32 (DataXFERS only IRDY=0, TRDY=0, DEVSEL=0)
(" D32 (Data XFERS Inchuding Wait Cycle, DEVSEL=0)
" MX32 (DE_Multiplex)

" AB4

" D64 (Data XFERS only IRDY=0, TRDY=0, DEVSEL=0)
(" D64 (Data XFERS Inchuding Wait Cycle, DEVSEL=0)
" MX64 (DE_Multiplex)

" IDLE

" Pet User Defined

 Attribute

~ LA32

 LMX32

" LaB4

" LMXB4

Figure 61 PCI Transfer Type Selection Dialog Box

PCI-X Attributes When operating as a PCI-X analyzer an additional transfer type choice,
Attributes, is enabled. See “PCI-X Attributes” on page 73 for
description.
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> AdvancedPCl AnalyzerUseiDef2

I:Bs Type.

o € 101X Config (This Slat Only)
€ 0000 Interrupt ACK € 101X Config (Entire Bus)
€ 0001 Special Cycle € 1010 Configuration Read
001X 1/0 € 1011 Configuration White
€ 00101/0 Read € 1100 Memory Read Multiple
0011 140 Wiite € 1101 Dual Address Cycle
011X Memory 1110 Memory Read Line
€ 0110 Memory Read 1111 Memory Write & Invalidate
0111 Memory Wiite € Any Memory

[T ] Cancel Help

Figure 62 Limited CBE Dialog Box

Event Patterns |Semmpe{]
Name XFER AD[] CBE[ ] P|IF|I|D|T|S|L| R/G |INTX | E |R|3.|P| EXT
A DR|IRE(R(T|O R |5|3 || ERN
S|A|D ¥(D|O|C R |T(¥|E
EM|Y|S|Y|P|K #|a|#| SIG
L |E|#E|& & # u NAL
#| L X
#
E¥1 XAXAXAXX XXXX X X F X ¥ XXX XX XXXX XX X X X XXXX
EV2 XXXXXKXXXXXXKXXK XXXXXXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
E¥3 XAXKRAKKARRRLKEE XUXUREKE XX X X X X X X X XMEX XMXX XX X X X XMEX
EV4 XAXXXAXXARXXAKAL XXXAXXKX XX X X X X X X X XXEX XXXX XX X X X XXXX
E¥S RRXKXXKRRXKKLKRXR KXXXXREX KX X X X X X X X XXKX XXXX XX X X X XXXX
EY6 AXXXXKXARLXKLAXR XXXAXXXX XX X X X X X X X XXX XXXX XX X X X XXXX
EV7 XXXXXKXXXRXXXKAXK XXXXXXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
E¥8 XRXXXKXXXRRXKKLXXR XXXXXXXX XX X X X X X X X XEXX XXXX XX X X X XXXX
Clear All Events
File Name: [ _I ™ Increment filename automatically
Display: & Partial Memory [1000 b |Samples C Entire Memory
Pre-Trigger [50% ) : l, J _>| [~ Auto Run |20 times
Bun | Cancel | Save | Load... | Import... | Data Display Configuirati Note... Help ]

Figure 63 PCI Event File Setup for XFER Type A32
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Set Address Range

To set an address range for an event, select an address XFER type and
double click in the AD[] field to open the data entry dialog. Check the Set

Range box, enter the address range values and click OK.

3 AdvancedPCl AnalyzerlUserDef2 (O] x]
Event Patteins | mgu]
Name XFER ap[] ee[1 | p [1[F[1]p|T[s|L] rR/G [InNTx [ E [R]3.[P[ EXT
D[R[R[E(R[T|O R |S|3|v| ERN
S|AID|¥|D(O|C R |T(V|E
E|M|Y|5|Y(P|K #| a|#| SIG
L(E|#|E|#&# u NAL
# L *
#
EV1 A32 XXXXANXX XXXX X X F X X X XX XX XXXX XX X X X XXXX
|37 S XXXXXKXXKXXXXXXXX ~ XXXKXXXX XX XX X X X X X XXXX XXXX XX X X X XXXX
E¥3 = XAXKKAKRARKRARLK RAXKKXKN XM X X X X X X X XMEX XMXX XX X X X XMEX
EV4 XAXXXAXAAAXXAALK XAXKXXXX XX X X X X X X X XXEX XXXX XX X X X XXXX
E¥S ARXKXXKRRAKARRKK AXXKEXXE XX X X X X X X X XXKX XXKXX XX X X X XXXX
EVE o viv v v uv v vver vuve vv v v v vuuw
EV7 -
E¥8 00 Input Data Farmat
& Hex ' Binary ¥ SetRange
————————————| Low [00000000
File: Name:
High [0000C012
Display: (" Partial Memory |1001
Pre-Trigaer [50 % ] : l, 32 Bits mawimum.
ok | Cancel | Cea | Hep |
Run Cancel

Figure 64 Setting an Address Range

¢ AdvancedPCl AnalyzerUserDef2
Event Patterns |Sewmpe{]
Name XFER AD[] CBE[ ] P |I|F|I|D|T|S|L| R/G |INTX | E |R|3.|P| EXT
p|r|R|E[R|T|O R (5|3 (4| ERN
S|A(D|¥|D(O|C R |T(¥|E
EM|Y|S|Y(P|K #|a|# SIG
L|E|# E|&#(# & u NAL
# |L x
#
EV1 A32 | 00000000-00000012 XXXX X X F X ¥ XXX XX XXXX XX X X X XXXX
Ev2 - ERXXXKKRRAKXRALK ZXXKEXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
EV3 ARAXXLXERAXARKLK AXXEKXNK XX X X X X X X X XXX XKMX XX X X X X¥EXX
Evd AXAXXAXXXKXX AR AKX XXXXXXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
E¥5 KRXXXKXKRXKRXRRKX XXXXKXRX XX X X X X X X X XXXX XKXX XX X X X XXxX
E¥6 XAXXKAKRAARRAALK NAXKKUMN XM X X X X X X X XMEX XMXX XX X X X XMEX
E¥7 AAXXXAXAAAXXAALK XXXKEXXX XX X X X X X X X XXXX XXXX XX X X X XXXX
[3.0:] KARXXXAXAXKKAAKE  AXKKKKEE XX X X X X X X X XXKK KKXX XX X X X X2RX
Clear All Events
File Mame: | _I ™ Increment filename automatically
Display: & Partial Memory [1000 »|Samples ¢ Entire Memory
Pre-Trigger [50% ) : l, J _>| [~ Auto Run |20 times
Bun | Cancel | Save | Load... | Import... | Data Display Configuratior | Note... | Help ]

Figure 65 Address Range Set
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PCI-X Attributes

To define an Event with Attributes double click the XFR field in the event pattern
definition dialog and choose Attributes in the PCI-X transfer type dialog box.

—XFER Type

C 4%

D32 (Data XFERS only IRDY=0, TRDY=0, DEVSEL=0) T
D32 (Data XFERS Including W ait Cycle, DEVSEL=0]

MX32 (DE_Multiplex)

Ab4

DE4 (Data XFERS only IRDY=0, TRD'Y=0, DEVSEL=0)
DE4 (Data XFERS Including W ait Cycle, DEVSEL=0]
1X64 [DE_Multiplex)

IDLE

Per User Defined

Attribute:

L&32

LMX32

L&64

LM>E4

C @ e e e e e e e e

® W0 e @

Figure 66 PCI-X Transfer Type Selection Dialog Box

Note that for the event chosen with Attributes as XFER, the AD[] and CBE][] fields are
merged.

©) eve_seq_x.udp [_ [T x]
Event Patteins |Sgwmgu]
Hame XFER AD[ ] CBE[ ] P|I|F|I|D|T|S|L| RIG | INTX | E |R|3.|P| EX]=
a [o|r|R|E|R|T|0 R|5|3|m| ERS
R |s|a|p|v[ofo[c R |T|v|E
EM|Y|S|Y|P|K ¥ la|#| SIC
L|E|#|E|#|#|# ul | nai
# L H
I
Ev1 A32 AXXXXXXX XXXX X X F X X XXX XX XXXX XX X X X XXX
Ev2 Attr RRAXKKRER X X 0111 % X XXKX XXXX XX X X X XXX
EV3 wmeeees KXXXXKXXXXXXKXXX XXXXXXXX XX X X X X X X X XXX XXXX XX X X X XXX
EV4 ARXXXLXARLXKLAXR XXXAXKEX XX X X X X X X X XXX XXXX XX X X X XXX
EV5 XXXXXXXXXXXXNXXX ~ XXXKXXXX XX X X X X X X X XXKX XXXX XX X X X XXX
EV6 mmeeeee KXXXXXXXXXXXKXXX XXXXXXXX XX X X X X X X X XXXX XXXX XX X X X XXX
= wvvv“vvmvwwwvvvv:.lﬂ
4 »
Clear All Events
File Name: | | T Increment flename automatically
Display: & Partial Memory [1000 »|Samples Entire Memory
Pre-Trigger (50 % ): 4 1 2| T Ao Run |0 times
fun | Cencel | Save | Load. | import. | DetaDisplayConfiguation | Mete. | Hep |

Figure 67 PCI-X Event Pattern Definition Dialog Box

To Set Attributes Double click the merged AD[] and CBE][] fields to open the Set
Attributes dialog as shown in Figure 68.
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Attribute Setting
R N R Tag Requester Requester Requester Lower Upper
S |0 Bus Device Function Bute Bute

Number Number Number Counter Counter
BN S S pesey Pl e KX PRRRRRR KRR
Attibute Type—————————— |

o Burst ¢ DWORD € Configuration " Spiit Completion
0K I Cancel LClear All Help

Figure 68 Attribute Setting Dialog
Check the desired Attribute Type and enter the required parameters.

Abbreviations The following is a definition of the abbreviation designated fields:

With Burst or DWORD attribute type is selected:
R Reserved

NS No Snoop

RO Relaxed Ordering

When Configuration attribute type is selected:

R Reserved

When Split Completion attribute type is selected:
BCM  Byte Count Modified

SCE Split Completion Error

SCM Split Completion Message
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Programming the Sequencer

The sequencer is used for data capture manipulation, generating complex triggering
on bus events and starting the exerciser (if required).

The TA700/800 Sequencer includes 32 states, SO to S31 (Limited to 16 states in
TA800). The Sequencer always starts at SO. Each state can be programmed to go to
any other state depending on the occurrences of specified patterns in that state. Jump
to any state is conditional. At any of the states S1-S30, the Sequencer may jump to
several other possible states depending on which of the specified conditions have been
met first.

A Trigger may be set in the Sequencer to occur:

1.

2
3.
4

Unconditionally at any state
On protocol error (PE).
On occurrences of Events or on Boolean expressions of Events.

On occurrence of a timing error. Not supported on TA700PDC (PMC) and
TAS800.

On occurrence of an external signal input. TA800 does not support external
signals.

Unconditional trigger is mostly useful when data sampling requires more than one
Sequencer state. So the trigger may be set to occur at S1 and then continue to sample
data based on several sequences of events.
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The data capture choices for every state are:

All

None
EV1-EVS
'EV1-!EVS

Expression

Captures all data on every cycle
Captures no data
Captures data as specified for each events

Captures all data outside the specified address or
data range

Captures data as defined by a Boolean
expression

The state transition events for every state are:

Any
Protocol Error

Timing Error

EV1-EVS8
'EV1-'EV8
Expression

External

Unconditional
A Protocol Error

Only in PCI Timing Analyzer. Not supported
on TA700PDC (PMC) and TA800.

Predefined events
If not pre-defined
A Boolean equation of events. e.g. EVI+!EV2

External signals
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Programming the Sequencer as Text

€3 data_exer_ady.udp ==
Event Pattems Sequencer ]Exemisel Plnglanl
5| © State0 { =
While Capturing All PCI Signals At "Every_Clock" { Rl
If"1" "PCI_Clock(s)" Occurs "..." Then GOTO "Statel" ']
Otherwise Continue With This State } Add Else If
)
© Statel { ... ge{be
Start_Exerciser -
While Capturing All PCI Signals At "Every_Clock" { &
If"1" "EVZ+EV3" Occurs " " Then GOTO "State2" Font
Otherwise Continue With This State } i
} Full Screen
© State2 { ... o
Set_Trigger
While Capturing All PCI Signals At “Every_Clock" { 54
TF'" PO Clacki@ Neenre " Then GOTO "State 2" _,;I ~
1 E L fom
File ame: [0ut Srop _J I™  Inciement filename automatically
Display: " Entire Memory = Partial Memory IW » | Samples I [ Auto Run l]\]—lim
Pre-Trigger (50 % ) - il J LI
Bun | Cancel | Save | Load... I Impart... | Data Display Configuration | Mote... | Help I

Figure 69 Prototype Text Programming Window

The text programming window opens with three default prototype states with all
programmable parameters displayed in blue.

Additional States

Maximize Display

To Change Parameters

You may add up to 30 additional states by clicking the Add State button.
Programmable parameters are displayed as blue.

You may maximize the programming window by clicking the Full Screen
button.

1. Position the display cursor over the parameter and double click the left mouse
button to open a list box with available choices for that parameter. See Figure

70.

2. Choose the desired parameter with the display cursor and double click the left
mouse button.

To Delete a Parameter
Add Else If

Tag and Discard

Double click the parameter to be deleted and select delete.

You may include Else If statements in your program by clicking the Add
Else If button. To remove the added Else If, double click on it and choose
<Delete> from the open list box.

Tag and Discard allows the user to delete a portion of the capture memory.
Setting Tag places a marker in capture memory and setting Discard causes
the deletion of all captured data between Tag and Discard.

Click the ellipses after If [Event A occurs] ”...” and choose Tag_Event at
the point after which you expect a result. Then click the ellipses after
Elself [Event B occurs] ”...” in the state where you expect the result and
choose Discard. Data will be discarded between the last Tag Event set
and the Discard set.
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Optimum Workspace

Deleting a State

Pre-Trigger

) data_exer_adv.udp I 3
Event Paltemns ~ Sequencer ] Exerciser Flnglan]
© State0 { = o
) %% While Capturing All PCI Signals At "Every_Clock" { State
If"1" "PCI_Clock(s)" Occurs "..." Then GOTO "State " ']
Otherwise Continue With This State ) Every_Clock #dd Ekee I
© Statel { ... Delete
Start_Exerciser
“While Capturing All PCI Signals At "Every Clock" &
If"1" "EVZ+EV3" Occurs ", " Then GOTO "Stat Font
Otherwise Continue With This State } i
} Full Screen
© State2 { ... e
Set_Trigger
While Capturing All PCI Signals At "Every_Clock" { L
TF'1" "POT Clack() Nrenrs " " Then COTN "State 2" = ~
_4| » Form
File Name: [Out Smp L] T lincrement flename sutomaicaly
Display: € Entire Memory & Partial Memory [1000 b Samples I™ AutoRun [20 times
Pre-Trigger (50 % ) : ij J _ﬂ
Bun | Cancel | Save | Load... I Import... | Data Display Configuration | Mote... | Help |

Figure 70 Changing the Programmable Parameters

To avoid scrolling the display in long sequencer programs you may
minimize completed states by double clicking the symbol next to the state
to be minimized. To expand the minimized state, double click the state

name.
) data_exer_adv.udp =[5] ]
Event Paltemns ~ Sequencer ] Exerciser Flnglan]
© State0 { = . d*
While Capturing All PCI Signals Matching "EV2" { State
If"1" "PCI_Clock(s)" Occurs "..." Then GOTO "Statel" ']
Otherwise Continue With This State } Add Else If
) Sl
© Statel { ... bee
Start_Exerciser
While Capturing All PCI Signals At "Every Clock" { &
h If"1" "EVZ+EV3" Occurs . " Then GOTO "State2" Font
Otherwise Continue With This State } i
} Full Screen
® State2 {}
@ State3 {} |
@ Stated {} &
& _l—I
File Name: [Out Smp L] T lincrement flename sutomaicaly
Display: € Entire Memory & Partial Memory [1000 b Samples I™ AutoRun [20 times
Pre-Trigger (50 % ) : ij J _ﬂ
BRun | Cancel | Save | Load... I Import... | Data Display Configuration | Note.. | Help |

Figure 71 Minimized State Display

To delete a state, place the cursor in the text for that state and click the
Delete button.

The Sequencer menu includes a Pre-trigger xx% function which lets you
set the percent of data to be captured before and after the triggering event.
This percentage is set by default to 50%. For more details see “Set
Trigger” on page 81

78



Custom Capture Data Project Catalyst Enterprises, Inc.

Programming the Sequencer With Menu Form

To program the sequencer with a menu form click the Form button in the

N ’/ . . . . .
D7 Sequencer programming window to open the form window as shown in Flgure
Form 72
€3 data_exer_ady.udp 5] x|
Event Patterns ~ Sequencer ]Exemisel Ploglanl
S0: Store [N ~ IF | ANy - I TagEvent ThenGoto [s1 =
ELSEIF [NONE =] I~ [Dioad ThenBota [50 =]
ELSE IF |MONE d I™ Discard Then Gioto (30 ¥
51: I™ Set Trigger [V Start E zerciser Continue Stare m ﬂ
IF( ™ Time) [1 EXPRESSION ¥ J [~ TagEvent ThenGoto [52
ELSE IF NONE i ™ Discard ThenGoto |51
ELSE IF NOME ¥ I” Discard ThenGoto |51 =
52: ¥ Set Trigger [ Start Exerciser Continue Store |ALL -
IF( I~ Time) |1 ANY > [" TagEvent ThenGoto |S2 =
ELSE IF NONE d ™ Discard ThenGoto |52 ¥ E.L
ELSE IF NONE s I~ Discard Then Goto |52 ¥ s T'e'x-l:
File Name: [0t Srop _J I™ | Increment fileniame automatically
Display: ™ Entire Memary & Partial Memory [1000 » | Samples I™ Auto Run [20 tirnes
Pre-Trigger (50 % ) : ll J LI
Bun | Cancel | Save | Load... I Import... | Data Display Configuration | Mote.. | Help l
Figure 72 Sequencer Menu Form Style Programming Dialog Box
Unlimited Else If The menu form allows only 2 Else If statements but in the Text Form the

user may add as many FElse If statements as desired.
To View and Program As Text Click the Text button on the Sequencer Form menu.

Pre-Trigger The Sequencer menu includes a Pre-trigger xx% function which lets you
set the percent of data to be captured before and after the triggering event.
This percentage is set by default to 50%. For more details see “Set
Trigger” on page 81

The Sequencer definition dialog box shown Figure 72 displays the programmable
states as follows:

SO The starting state, displayed always.

S1-S31 These states can be viewed and programmed two
at a time by using the scroll bar on the right side
of the screen.

Tag and Discard Tag and Discard allows the user to delete a portion of the capture memory.
Setting Tag places a marker in capture memory and setting Discard causes
the deletion of all captured data between Tag and Discard.

Click the ellipses after If [Event A occurs] ”...” and choose Tag_Event at the point
after which you expect a result. Then click the ellipses after Elself [Event B occurs]
”...” in the state where you expect the result and choose Discard. Data will be
discarded between the last Tag Event set and the Discard set.
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Defining a Boolean Expression

To define an expression, scroll down the list of options in the dropdown list where you
wish to use an expression and click on Expression to open the Expression Editor
window as shown in Figure 73.

Expression Editor

—— Event Names ——
EY1

EV3
EV4
EV5
EVE Operators -

EV7

EVE ilx”]ﬂ)l‘l?(l

Expression

EV1 +EV2

0K I Cancel | Help |

Figure 73 Expression Editor Window
Double click the Event Names and Operators as required to define the desired

Boolean expression and click OK.

The available Boolean operators available from left to right are: Logical Or, Logical
And, Negation, Parentheses, Backspace and Clear.
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Set Trigger

Set trigger is available to be set by the user for states S1 - S31. When set trigger is
selected, a trigger is enabled, when the Sequencer enters that state for the first time.
The amount of data to be captured before and after the trigger may be set as a
percentage of pre-trigger, between 0% and 100%. This may be done by positioning the
pre-trigger slider to the desired percentage. This feature allows the evaluation of bus
activity leading up to and after the triggering event. The operation of the pre trigger in
the data memory is conceptually illustrated in Figure 74

Pre-Trigger Data: The capture of the specified percentage of the data prior to the triggering
event cannot be guaranteed and may in some cases be 0. This can occur in
cases where the triggering event occurs before the required number pre-
trigger event data can be stored. In these cases the data display will show
fewer than the specified data points prior to the triggering event.

DATA MEMORY

PRE TRIGGER —
ALL
% PRE TRIGGER PARTIAL
DATA % PRE TRIGGER
DATA
TRIGGERING EVENT —
ALL SPECIFIED ALL SPECIFIED
POST TRIGGER DATA| POST TRIGGER DATA|

Figure 74 Pre-Trigger Example, 20% Pre-Trigger
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Exercise and Capture Data Project

With the TA700/800 operating in the Advanced Mode as shown on the Main Menu
bar below, make sure that the Working Mode is PCI Analyzer/Exerciser or PCI-X

Analyzer/Exerciser.

EP Catalyst Enterprises, Inc. TA700_TAB00 Software
File Edit View Configuration Exerciser Compliance Tools Macro ‘Window Help

ICEEE IR Y oo BRI R

Advanced Mode Switch to Easy

Click the Black button on the Main Menu bar to open the Exercise and Capture
dialog box shown in Figure 75.

C_“ AdvancedPCl ExerciserlUserDef2 !m
Event Pattemns  Sequencer | Exerciser Program I
3| o Stated { = #*
While Capturing All PCI Signals At "Every_Clock" { AddJtate
If "PCI_Clock(s)" Occurs "..." Then GOTO "Statel" D
Otherwise Continue With This State } Add Else If
)
Q Statel { 4 Q£E
Set_Trgger
While Capturing A1l PCI Signals at "Every_Clock" { &
If"1" "PCI_Clock(s)" Occurs "..." Then GOTO "Statel” Eont
Otherwise Continue With This State } 7
| Full Screen
2/
= e
] _>|—I Foim
File Name: [ _' I Increment filename automatically
Display: & Partial Memory |1000 »|Samples ¢ Entire Memory
Fre-Trigger [50%): 4 Tl & T AutoAun | limes
A | concel | Save | Load. | mpot. | DateDisplay Configuaion |  Mote.. Help

Figure 75 Exercise and Capture Data Project Dialog Box

For an exercise and capture data project you must program/define:

*  An exerciser program
* A set of Events (See “Defining Event Patterns” on page 67)
* A sequencer program (See ‘“Programming the Sequencer” on
page 75)
The exerciser will run whenever a the sequencer enters a state for which it is set to
start the exerciser.
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Programming the Exerciser

Make sure that the Exerciser Program Tab is selected on the Custom Project Dialog
box as shown in Figure 76.

O AdvancedPCl ExerciserUserDef2 Hlﬂ m
Ewvent Pa\temil Sequencer  Exerciser Program I
Data Block Seftings
[ Impot .. Edit ..
LOOF | I COMMAND [Number | TargetAddiess |
Counter | LINE Target Termination DATA/Data Block Name of Data | Bage Target Address C/eE
2 Interupt ACK =l =l 17 Jooodoooo 00 J
| d | :1
[ I 2| |
= IZ I || [
[ [ I || [
Binary Format : |
Padding LoopCounter ———————
( " No Padding & Insert Idle |3 | & [ firte ) Defrite ™ Enable Local Memory
#dd | Insest | Delete| 11771 Fio 5147 | Check Loops || Compie.. | Evercises Oplions
File Mame: [ _I ™ Increment filename automatically
Display: &' Partial Memary |1000 ﬂSarmles € Entirs Memory
Pre-Trigger (80 %): 4| | 2| T AuoRun|™ e
Bun | Cancel l Save | Load... I Import... | Data Display Configuration l Note... | Help |

Figure 76 PCI Exerciser Program Dialog Box

To program the Exerciser:

1. The Exerciser Program dialog box opens as default with one active program
line. You may add additional active program lines by clicking Add.

PCI-X Exerciser The PCI-X Exerciser operates similarly to that for PCI, but with some
notable differences.

- = |
¢3 AdvancedPCI-X ExerciserUserDef3 S B

Event Pdlslm] Sequencer Exerciser Program ]

| Impot... Ed..

| LINE T COMMEND DATA/DalaBlock Name | NiTESr Tarcel Siiess | cope
Interupt Ack Jia | R S0 Joooecoon [0 |
| IE] I | [
[ = = [ [
| = I | [ |
I = I | [ ]
Binary Format : |

Add | Insert | Delete| 101

st Loops || Compie.. |

File Name: | _I ™ Increment filsname sutomatically
Display: & Partial Memory |1000 ﬂSampbes " Entire Memory

Pre-Tringer (50%): 4| i} | [ AuoRun] times

Bun | Cancel | Save | Load... | Import... | DauDispiayEmﬁwratbnl Note... | Help |

Figure 77 PCI-X Exerciser Program Dialog Box
See page 85 for PCI-X differences.
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2.

Insert Program Line

3.

Choose the number of lines to be added and the Line Type, Master or Target, in
the number of lines dialog.

Number of Lines X |

Number of lines :I _%I

Line Type
( * Master o Target ‘
oK Cancel |

Figure 78 Number of Lines Dialog Box

To insert a new program line between previously added active program
lines, position the cursor below the line where you want to insert the new
line and click the Insert button.

Select a command such as MEM Write from the command dropdown list for
each active program line. Commands differ PCI vs. PCI-X.

Available PCI Exerciser Commands:

Interrupt ACK
Special Cycle
I/0 Read

I/0 Write

MEM Read
MEM Write
CONFIG Read
CONFIG Write
MEM Read Multiple
MEM Read Line
MW & Invalidate
Data Transfer

DAC:
DAC:
DAC:
DAC:
DAC:
DAC:
DAC:

1/0 Read

1/0O Write

MEM Read
MEM Write
MEM Read Multi
MEM Read Line
MW & Invalidate

Data Transfer TA700/800 to Transfer data as Target without termination

and complete as expected.
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Disconnect with data TA700/800 to Generate Disconnect as Target at the last
data phase.
Retry Generates Retry as Target.

Disconnect without data ~ Generate disconnect after the last data phase.

Target Abort with data Generate Target Abort at the last data phase.

Target Abort without data  Generate Target Abort after the last data phase.
Available PCI-X Exerciser Commands:

Interrupt ACK

Special Cycle

I/O Read

I/0O Write

MEM Read DWORD

MEM Write

Memory Read Block (Alias)
Memory Write Block (Alias)
Configuration Read

Configuration Write

Split Completion

Memory Read Block

Memory Write Block

Dual Address I/O Read

Dual address I/O Write

Dual Address Mem Read DWORD
Dual Address Mem Write

Dual Address Mem Read Block (Alias)
Dual Address Mem Write Block (Alias)
Dual Address Mem Read Block
Dual Address Mem Write Block
Target

Target Single Data Phase

Target Disconnect at Next ADB
Target Retry

Target Abort

Target Split Response

NOP

4. Enter a TARGET ADDRESS that you would like to write to and enter the
DATA or select a Data Block to be written to that address.

32/64 bit Addressing To set 32 or 64 bit addressing mode click the enabled ellipses button at the
end of the active program line Base Address Setting dialog box shown in
Figure 80. Addressing selection applies on a line to line basis.
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DEVSEL# Speed Assertion
Fast (Not supported at this time) target responds within 1 clock period.

() AdvancedPCl ExerciseiUserDefl

Event Patteins Exerciser Program | Sequencer |

=lalx|

Data File Name : | Browse... Data Black...
LODP COMMAND Number | Tarqet Address
Counter U= Target Teimination e of Data | Base Taiget Addiess el
| 2 M [0 wite =l =][ 1 [oooooooo I
[Tz = | 5]
[T B [ | L]
[Tz Iz ][ L]
= E 2 (| i | ]
= Program Line Properties
Binary Format : |
Padding Lo Addressing Size : " B4 bit
" NoPadding & Insert Idie |3 | [
] Data Size igm - DdaPuellm:iD[7__g] 'I
4dd | st | Delte|  impt From 47| Check Loops | Com
Read/wiite Compile Mode
File Name: [ C Burst & Single
Address | k|4 by
Display: (" Partial Memory |1000 »|Samples  { Entire Meman S e
Pre-Tri 50%): I~ Auto Run |
il (0 T s —
Fun | Cancel I Save | Load... | Imnpor

Figure 79 Setting 32/64 bit Addressing Mode
TA700/800 Address as Target When a Target command is chosen from the available COMMAND

list, clicking the ellipses button opens the Base Address Setting Dialog

(3 AdvancedPCl ExerciseiUserDef2

Event Pattems | Sequencer  Everciser Progiam |

=lo)x|

File Name: [ ’

Data File Name : | Browse.. | DataBlock... ‘
LOOP COMMAND [ Number | Tamet Address
Counter itz Target Temination IR £ BRI of Data | Base Target Addiess —

‘ 2 T1 Target &bort with Data 'I FFFFFFFF - 1 po0040257 00000 E
[ = | [
= = I | |
[ = E T [
== IZ [ (| ]

Binary Format : ]11111111111111111111111111111111 a
Padding DEVSELH speed assertion
C NoPaddng Insetlde [3 CBelowSubliactive O Subtiactive hiedum
Add | Insett | Detete|  Trpeion 97| | Chesk Losps || || Slow C Fast
- Addiess Size

—— [y DataSize
+ 32Bit " B4 Bit ‘ [ + 32 Bit " B4 Bit

Display: = Partial Memorp |1000 »|Samples " Entire | I—IDSEL

Pre-Trigger [50%): 4| 1 2T A I T=
A || Cencel | Save | Load. | [ | Cancel | tep |
Figure 80 Target Base Address Setting

Specifies DEVSEL# response speed when operating as a target.

Medium target responds within 2 clock periods. (Supported @ 33MHz

Slow target responds within 3 clock periods.

86



Custom Capture Data Project Catalyst Enterprises, Inc.

Subtractive target responds between the Sth and 6th clock period.
Below subtractive target responds between the 6th and 7th clock period.

In cases where a target response to a specific command is required the C/BE entry
must be set to that command. C/BE commands are chosen from the C/BE dialog.

CBE B
CBE# Type
™ %44 Don't Care ™ 101% Config [This Slot Only)
0000 Intermupt ACK ™ 101% Config [Entire Bus)
0001 Special Cycle ¢ 1010 Configuration Read
001X 1/0 1011 Configuration Write
€ 0010140 Read 1100 Memory Read Multiple
0011 1/0 ‘Write 1101 Dual Address Cycle
011 Memory 1110 Memory Read Line
" 0110 Memory Read 1111 Memony Wiite & Invalidate
0111 Memory Wiite Ol o

oK I Cancel | Help |

Figure 81 C/BE Set to Respond to Any Memory Command

Burst Data Writes For burst data write operations requiring multiple data you may select a
previously created data file from a list of Data Files by clicking Browse
and selecting a pre-defined data file, or create a new data file by clicking
Data Block. See Creating a Data Block File on page 44.

Padding/Bus Utilization = Checking Insert Idle and entering the number of idles desired will insert
Idle states at the end of each compiled command. See Figure 82. Adding
idles at the end of commands allows the TA700/800 to be precisely
controlled on how long it will utilize the bus.

5. Set Exerciser options as described in Setting Exerciser Options on page 90.

6. When done, click Compile . . . to generate and view the executable exercise
code as displayed in Figure 82.
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() AdvancedPCl ExerciserlserDef4 !Iﬂﬁ
Event Pattems | Sequencer Exeiciser Program I
Line | Loop [ Clock CYELE R[F[1[D[T[5 AD[) CAPTPIRTAIL] e [STF] Loop
E[R|RIE|R|T BE|A&(&|E[C|O E(E| Count
a|4/0|v|pjo #|R|R|a|K|c|  |A|R
00 #|M|v|s| Y|P 6| 6|B|K| R(R
E| #E| #| # 4|4]4|# 4
# L #) 4
#
b1 1 MEM Read 0]0]1]0|0]0] 0000000000000000 |OG|0[0]T)1]1[1111]1)1 2
M 2 Last Data Phase_|1]1]|0]0[0]0] _0000000000000000__|FO[0[ 0| 1[1]1[1111[1]1] 0
M1 3 Ide 1[1[7]o[o]o]oosooooooooocan [Foli 1111 [T [1] @
M1 4 Idle 1[1[1[0]o[0[ _oooooooooooooong[Fo[ [ A [1[1[tmi[1 1] 0o
M1 5 Idle 7[7[7[0[0[0[ oooooooocooooond[Fo[1 (11111111110
BirieiyFormet: |
Loap Counter |
nset | [etets gt From 5147 | Check Loops | Bregram.. || & e € Dt | Global Everciser Gotions
File Name: | _I ™ Increment filename automatically
Display: & Pattial Memry [1000 ﬂSamp‘as " Entite Memory
Pre-Trigger (50 % ) : ;l _| ﬂ I~ Auto Run |20 times
A | Concel | Save || Load.. | Impot.. | DataDispleyConfigwation |  Nete. | Hep |

Figure 82 Compiled Output File With Padding

Forcing Errors All signals displayed in blue may be changed to force errors and
anomalies.
Parity Error Parity error is checked by the recipient of data. If PAR is not in

compliance with data, PERR is asserted two clocks later. The TA700
behaves the same way, meaning that it can only assert PERR when it is
the intended recipient of data. Although it seems as if PERR is
programmable during all transactions it is only altered per the users
program during the data phase of Read transactions generated by the
TA700.

Wait States Wait states may be inserted by pointing the cursor on the line where a
Wait State is desired and then clicking Insert.

Looping You may define a loop by clicking in the Loop Start column next to the
program line where you wish for the loop to start and in the Loop End
column next to the program line where you wish for the loop to end. Loop
end may be placed in Idle lines.

Enable Loop For the loop to execute, check the Autorun check box and enter a value
of up to 65535 in the Number of times edit box.
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Forcing an Interrupt You may force interrupts for a specific number of clocks during the

program execution by double clicking in the INT# field for that line and
then setting the interrupts in the INT# dialog box. See Figure 83.

INTH ]
INTA INTE INTC INTD
Lo Ll Ll Lo
Lol =i (O] Lol
£ £ £ L

o]

Cancel |

Help |

Figure 83 Setting Interrupts
Set Interrupts
Setting interrupts may be done in two ways:

1. From a compiled program for a specified number of clocks.

2. Outside of a compiled program, indefinitely until reset by the user again.

DataBlocks..

Dptions...

S To set one or more interrupts indefinitely, click Exerciser on the menu bar and

then select Set Interrupts from the dropdown list to open the Set Interrupt dialog
box

Dump Memory...
Read/Modify Write...
\whrite/Read Verify
Address Test

Scan Canfiguration Reagisters...

Set Interrupt | x|
— Interrupts

oK |
I INTCH
™ INTB# I~ INTD# &l
[~ SERR# $I

Interrupt(s) will be set at all times when checked. When
unchecked, interrupt(s) will reflect the contents of the compiled
program.

Figure 84 Set Interrupts Dialog Box
Select the interrupts that you wish to set and click OK.

Continuous Setting, Outside Program Setting the interrupts in this manner sets them continuously
until you uncheck them.

Limited Duration, Inside Program You may set one or more interrupts for one or

more program steps when running compiled Program files. See Forcing an Interrupt
on page 89.
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Setting Exerciser Options

You may set the exerciser options globally for all input program types or locally on the
Exerciser Programming window.

. DataBlocks...

Options... . . . . . 3
Setenupts.. To set the exerciser options, click Exerciser on the menu bar and select Options
Beaihiodie. from the dropdown list to open the exerciser dialog box as shown in Figure 85.
Wiite/Read Verify...

Addiess Test ’

Scan Configuration Registers...

Bus Exerciser's Options 21l

— TA70D_TABDD as Master
— Master Abort on No DEVSELHE — — On T arget Disconnect/Retry

" Wait extra cycles {* |Jse same transaction
" Per PCl Specification " lse next transaction

— Master Assert FRAMEH#
" Regardless of GNTH#

(* After GNTH asserted

— Master Completes Transaction at Time Out
¢ Disabled " Enabled

| oK I Cancel Default

Figure 85 Exerciser Options Dialog Box

On Target Disconnect/Retry

Use Same Transaction Completes from the disconnect point on,
regardless of the number of times the target
issues a disconnect. The TA700/800 will take it
from where the target disconnect was issued and
try to complete the transaction from that point

on.

Use Next Transaction The TA700/800 will bypass all of the
transactions in the current command and will
jump to the transaction for the next command.

Master Abort on No DEVSEL#
Wait Extra Cycles TA700/800 waits for 10 extra cycles.

Per PCI Specification
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Master Assert FRAME#
Regardless of GNT#

After GNT# Asserted

Master Completes Transaction at Time Out
Disabled

Enabled

Once the TA700/800 is set to become a master, it
asserts the frame and starts the transaction
regardless of the status of the GNT#.

The TA700/800 will request the bus and start the
transaction only after the GNT# is asserted.

The TA700/800 continues to complete the
transaction for however many clocks it takes
regardless of GNT# being deasserted.

The TA700/800 completes the current
transaction as soon as possible after GNT# is
deasserted.
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Easy Mode Trigger and Capture

The Advanced Mode menu bar allows you to open an enhanced Easy Mode dialog
that permits you to trigger and capture data using predefined PCI and PCI-X trigger
points and data capture settings while allowing you to create a custom exerciser

program.

To perform a quick data capture with a minimum of programming;:

1. Click the Yellow button on the Advanced Mode menu bar to open the enhanced

Easy mode dialog.

is]]data_exer_adv.cdp (o]
Exerciser Program  Capture Data And Trigger |
r— Data Capture Selection
Exclude
I~ Idles
~ Specific Address{es) I~ it
[Any sowrce) [ Retre
(~ Specific Addressfes) =
[This slot only)
i~ Trigger Paint Selection
New...
Trigger On : Addiess [}R0004H
[ddess =] ] | oty |
Command : [#o000 _I
Hemoe
M .
[~ Manual Trigger Clear Al |
Trigger Address/Data Size: = 2Bt B4R ‘
Display: + Partial Memory [1000 | sarples © Entire Memory
Pre-Trigger (50%]: ¢ 1 2| T AutoRun]®0 times
Bun | Cancel | Save | Load... | [mport | Data Display Configuration | Mote.. |

Figure 86 Capture and Trigger Dialog

2. Set the trigger and capture options as described in “Instant Data Capture &

Trigger” on page 26

3. Click the Exerciser Program tab to open exerciser program dialog.
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) AdvancedPCl ExerciserCaptureData3

Exerciser Program ] Capture Data And Trigger |

101X

Data Block Settings
I Import ... Edit...
[ LOOP \ COMMAND Mumber | Tarqet Address
L Counhe \ Taiget Termination PRl «:fugatal Base Taiget Address
Ei Intemupt ACK =] =] 00000000 _|
= IE A | L
2| = = =]
| : T —l
T - T —
Binary Format : |
Padding Loop Counter
€ No Padding & Insert Idie |3 (% Ffirite 1 Defirie T™ Enable Local Memory
Add ] Insert | er‘al [rport From %N‘*l Check !.Dopsl Compile... | Exerciser Options
Display: & Pattial Memary [1000 1] samples € Entte Memary
Pre-Trigger (S0%): 4| 1 ] T AutaFun“ times
Bun | Cancel | Save | Load... | Impait... | D ata Display Configuration Note.. Help ]

Figure 87 Exerciser Program Dialog

4. Program the exerciser as described in “Programming the Exerciser” on page 83

5. Click Run and wait to capture data and display the result.
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Timing Analysis - Synchronous

This mode of operation is not supported by the TA700PDC, TA800 or PCI-X.

Make sure that the TA700/800 is in the Timing Analyzer working mode and is
operating in the Advanced Mode as shown on the Main Menu bar below.

“F Catalyst Enterprises, Inc. TA700_TAB800 Software

File Edit Yiew Configuration Timing-Analyzer Tools Macro Window Help

Jb”' I = r;’1| & By R | Eh %IPCI Timing Analyzer j ) R“?H 2o

Advanced Mode Switch to Easy

Click the Black button on the main menu bar to open the Timing Measurement setup

dialog box below.

3 AdvancedPCI-X TimingUserDefl

Event Paiterms  Timing Violation Analysis | Sequencer |

CLK

paTA X X

L T

<< < | Tl Bage=2000s > | 33|
<] < | LieadingBlge=T000s > [33]

- Mask:

63|62|61|60)|59|58|57 |56 55|54 |53|52|5

ADDRESS
Kl

IrT
&P
o

Pl

Ly}

-~

Ly

-

Ly}

Pl

Ly

-

Ly

-

Ly

= -
Em=2
rmno—
<00 -
#<OT—
HTVO—w

sXOOr |;

Maskal | Mask32Bits | | Mask64bis |

Unmask Al | Unmask 32 Bits|  Unmask 54 bit's |

File Name: ]

_I ™ Increment flename automatically

Display: & Partial Memary [1000 | Samples " Entie bemary

Pre-Trigaer [80%]): 4] I L' I~ Auto Run |20 times

Run | Concel | Save || Losd. | Uipoi. | | DataDispley Configuiation | | Note..

Figure 88 Timing Measurement Setup Dialog Box

1. Choose the signals intended for timing violation analysis in the Mask area of
the dialog box and mask each signal that is to be excluded from the analysis.
Alternately you may click the 32 bit or 64 bit button and then uncheck or check
the signals that you want included in the analysis.

2. Set the desired Leading and Trailing edge values in the Parameters arca of the
dialog box by either dragging the vertical L and T bars to the desired position
or by using the > >> or < << buttons to position the timing definition bars
incrementally. The >> and << buttons move the bars in 2 ns increments and the

> and < buttons in 0.10 ns increments.
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3. Click the Event Patterns and Sequencer Tabs and create Event Patterns and a
Sequencer Program as described in Defining Event Patterns on page 62 and
Programming the Sequencer on page 64 and click Run.

After the occurrence of a timing violation the timing violation display will open as
shown in Figure 89. The red signals represent timing violation. Bus signals are shown
as a code. As an example 00000080 indicates that the timing problem is for AD7, and
1000000C indicates the problem is for AD28, AD3 & AD?2 signals.

SehpScen || Booknaks | 4] X [»] [+ |iow|mm|e] | | (=2 [
SignelNome  Velue (9 |2 A » i 2 2 p s £ fi ! 2 h il
1 L1

R I Y Y O |

|Clock [
Tite Gap
fdd3z)

Data(32] ]
FRAME#

Time Gep | Tove 5

50000000

IRDY#
DEVSEL#

STOR#
TE_AD[E30]
[TE_G/BE[7-0]
TE_AD[)
ITE_DEVSEL#
[TE_FRAMES
[TE_PERR#
[TE_AD[0)

Figure 89 Timing Violation Results Display

To view the result as a list file output display, click the List button.

o0}

Display Setup Use the setup screen to configure your display.

1. Click the Setup Screen button in the results display window to open the Timing
Error Signal selection dialog box as shown in Figure 68.

| Remaining Signals Active Signals C Show Diﬁerences !" Time

& Show Diff in Clock

AD[31-0]

TE_REQH id Li

Group |PCI - TETRECEAH l ™ Show Grid Lines ‘
g_:mrftm ‘ © List Show Mode ‘
A g

TETINTBH * Wave Show Mode

TE_INTC# ,

TECINTD# Column Width |60

TE_RST# Row Height 0

TEGNTH i
Color Property
Red |[o < _,I
Green [o < ﬂ

Add > <~ Remove l
Add All Groups ==>> Bloe 255 | 4] 1
Add Al ->> <<-- Remove All '
|
0K I Cancel | Set Color | Default Color I Help |

Figure 90 Timing Error Signal Selection
2. Select the signals for display from the Remaining Signals list and click Add.

3. Select other display options such as display of time in units of time or clocks,
show gridlines etc. and click OK.
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For a detailed description of display manipulation, see “Display Manipulation” on
page 129

Search for Setup & Hold Limits

To search for setup and hold limits click the Setup/Hold Limits
search Icon to open the Setup and Hold Limits Mask definition

dialog box.
© Search for setup & hold values == x|
Setup/Hold Limits |
Mask the signals you want to ignore in search.
| 63| 62] 61] 60 59] 58] 57| 56| 55/ 54] 53] 52] 51 50] 4a] 48] 47] 46] 45] 44] 43] 42] 41] a0] 33]
BDDRESS [X:X X X X X X X X X %[ X[ X[R[X[R][X[R[X]X]|X]X
K| |
PPy e[y e es[es[es i [eTiToltTs[cTR]a[RTAT T I TITs[P[R]P
alale(e|e|e|B|B|B|B|D|R[RIE[R|T|O[E|N|E|C[N|N|N|N[E[E|S|HM
R(R|E[E|E|E|E|E|E|E|S|a[lD|v|D|O|C|la|T|alk|[T|T|T|T|R[R|T|E
6| (7] [61] (5] (41) (3)) [21) (O] (0)) E (M| Y| S || P[K|#|#[6 ] 6[A|B[C[O|R|R|#|#
4 LIE|#|E| #|#|# PN R A
#) |L #|#
#
XX XX KKK KK X
X Masked signal
Mask Al Mask AD[ ] Mask 64 bit Signals
Unmask All Unmask AD[ ] Unmask 64 bit Signals

‘ This program performs a realtime search to find the Setup and Hold values for the selected (Unmasked) signals on the bus.

Search | Cancel | Help |

Figure 91 Setup and Hold Limits Mask Definition Dialog Box

Select the signals that you wish to ignore in the search and then click Search. At the
completion of the search the result is displayed as shown “Setup and Hold Limits
Search Result” on page 97

Timing Yiolations X

Setup Time : 7.50 [Nanosecends]
‘Hold Time: 4.00 [Nanoseconds)

Figure 92 Setup and Hold Limits Search Result
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Timing Analysis - Asynchronous

This mode of operation is not supported by the TA700PDC, TA800 or PCI-X

Caution: The TA700/800 may draw as much as 4.0 A during an asynchronous timing test, the
TA700/800 board must be configured to operate from the + 3.3V bus power. JP2
shunted between pins 2 - 3.

Make sure that the TA700/800 is in the Async Timing Analyzer working mode and is operating in the
Advanced Mode as shown on the Main Menu bar below.

“F Catalyst Enterprises, Inc. TAT00_TAS00 Software

File Edit WYiew Configuration Tools Macro ‘Window Help

H = = é—}il PANEETN ¢ ‘ 55 £ |PCI Async Timing Analyzer x| () k"HJ@

Advanced Mode Switch to Easy

Note: The Async Timing Analyzer in the Advanced Mode operates identically to that in
the Easy Mode. See “Timing Analysis - Asynchronous” on page 62
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TA700/TA800 as Target

TA700/TA800 Enumeration

Once the TA700 is used in the System, it is enumerated. During the Enumeration the
Operating System assigns a memory and I/O address to your TA700 which is used as
TA700 Target Address. This will only happen if the S2 jumper is not installed and the
S1 switch is down. If the TA700 is used in a passive environment you may assign any
target address. To view the TA700 Configuration Space “Scan Configuration
Registers” on page 55.

Once you start the software, the TA700 will not respond to any transactions, including
configuration unless programmed on the Exerciser or Local Memory page.

Setting Target Operation

There are two ways to operate the TA700/TA800 as a Target.

1. By defining specific Target responses in the exerciser program.

2. By enabling Local Memory.

Defining Target Responses in Exerciser Program

On an exerciser program page, click the down arrow in the T1 LINE COMMAND to
choose a Target Termination.

COMMAND
Target Temmination
IData Transfer j

|
|

LINE |
T1

| Disconnect with Data
Retry

I_
= Di ct without Dat
m isconnect wi

|_| Target Abor wih Dato

Target Abort without Data ™

99



Catalyst Enterprises, Inc. TA700/TA800 as Target

Enter a Base Target Address and set up target data with Data or a pre-defined Data
Block. Note, however, that this data will not be stored.

:E‘] EasyPCI ExerciserCaptureDatal ;lﬂl 5‘
Exerciser Program ICapIuvB Data And Tnggerl
lc:\pmglam files\catalyst\ta700_ta800"userdir\analyzerexerciser'w1_20.dat Import... Edi... ‘
COMMAND Target Address ‘ |Nu'nher Target
UNE | et Temination DATA/Dala Bock Nae | page Target Address | /0 | of Data | Address
Target Abot with Data | |"DATABLOCKD" Flpnoon B 5
[T ntemupt ACK _~||'DATABLOCKD” =] ooocooco [oo [ 1 =
[~ |m2 = hd ||t 00 1
[1jM3 El I | 00 1
I [ I =0 I .
I~ [Ws =J|"'DATA o [foo | s
I~ [m8 ][ DATABL J | [T 00 1 |
I~ [m7 ~||'DATA =] [ooooooco 00 1 ]
| (113 ~|['DATABLO ] [0o0o0oc 00 1
™ Enable Local Memory
Display: & Partial Memary [1000 b Samples € Entire Memory
Pre-Trigger (50%): 4| il | T AuoRun|0 times
Bun | Cancel | Save | Load... | Impait... | Data Display Configuration MNote...

Figure 93 Setting Exerciser as Target

Note:  When set up this way the TA700/TA800 will only respond with specifically
programmed responses and not as a random target.

Enable Local Memory

Check the Enable Local Memory check box on the Exerciser Program tab. Note,
however that this enables the TA700/800 to behave as a real target, but does not offer
the flexibility to modify target response behaviour for specialized testing.

The PCI exerciser allows the TA700/800 to be programmed to act as a 1 MB random
access memory behaving like a real target while still operating as an Analyzer. The
local memory becomes active when the Enable Local Memory box is checked on the
Exerciser program page and the Run button is pushed. The local memory will stop
responding after the exerciser is manually stopped.

Setting the Base Address The TA700/800 base address is assigned by the system BIOS at boot up
time. The first 20 bits (5 bytes) are assigned to the local memory and
initially set to don’t care. The user may change these bits to use the local
memory for some specific memory access. You may assign any target
address if the TA700/TA800 is being used in a passive environment.

Note: If you wish for local memory to correspond to a range of addresses you need to
specify that range with X’s. e.g. 0xA0000XXX which corresponds to 4K address
range starting from 0xA0000000.
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(3 AdvancedPCl ExerciserUserDefl [_ O] %]

Event Paiterns | Sequencer | 11 P | Local Memory |

Bin Format : (I

Hex Format : |000000000000000C

I” Define Local Memory Contents

ietale B | _I

Pre-write Memany Contents Settings

Start Address; | 00000 Ce bt e DEte Elool: -
ot ]—
Dump Memary Settings
Dump File Name: |
I” Disable Local
Start Address: [00000 Count: [ End Address: [FFFFF B Dump M:mory oc:
File Name: [ | T Inciement flensme automaticaly

Disglay: & PatialMemory [1000  §|Samples  Entiie Memary
Pre-Trigger (S0%): 4 1 2 T Auto Run |2 fimess

Bun |

Cancel | Save [ Load... | |y eieigt | DataDisg\ayCoNigulalionl Note... | Help |

Figure 94 PCI Local Memory Programming Dialog

Memory Organization The 1 MB local memory is organized in 8 byte by 128KB locations as
illustrated in Figure 95.

Address

00007:00000

00007:00000

Byte 7 | Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 | Byte 0
+7 +6 +5 +4 +3 +2 +1 +0
+15 +14 +13 +12 +11 +10 +9 +8

Figure 95 PCI Local Memory Organization
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Predefining Data

Memory Contents check box and then the Data Block button.

To load the memory with user predefined data, check the Define Local

Define the desired data blocks as described in “Creating a Data Block

File” on page 44. When defining data please note that data is to be entered
such that the MSD is in the highest address byte complying with the local
memory organization format shown in Figure 95.

Dump Memory

You may view the local memory contents after a local memory operation. To view the
local memory content, specify the start address and the end address that you wish to
view and click the Dump button.

i Local Memory Dump Result Dialog

[_[Ofx]

Address Dffset (Hex) | Contents Hex) | Contents (ascil)

00007-00000 07 06 05 04 03 02 01l 00 0O 0o0oooao
0000F-00008 OF OE 0D OC OB OA 03 08 o o 0ooao
00017-00010 17 16 15 14 13 12 11 10 0000 D0DOoOoao
0001F-00018 1F 1E 1D 1C 1B la 19 18 (== = - =
00027-00020 27 26 25 24 23 22 21 20 ‘s % ¢ F "
000ZF-000Z8 ZF ZE ZD ZC ZB ZA 22 Z8 L B | {
00037-00030 37 36 35 34 33 32 31 30 7 6 5 4 3 2z 1 0
D003F-00038 3F 3E 3D 3C 3B 3A 39 38 T o= <% ; 9 8
00047-00040 47 46 45 44 43 42 41 40 G F ED C B A @
0004F-00048 4F 4E 4D 4C 4B 44 49 48 0N M L K J I H
00057-00050 £7 56 55 54 53 52 51 S0 w Vv o T $ R QP
0005F-00058 SF SE 5D SC 5B SA 59 &8 _ 1 % 1 z ¥ X
00067-00060 67 66 65 64 €3 6Z 6l &0 g £ e d ¢ b a °
0006F-00068 EF 6E 6D 6C 6B 64 69 68 onm 1 k 3 i h
00077-00070 77 76 75 74 73 72 71 70 w v u t s r g p
0007F-00078 7F 7E 7D 7C 7B 7A 7% 78 g ~ 3} I { =z v x
00087-00080 87 96 85 84 83 82 81 80 + t . , f§ , 0 €
0008F-00088 8F SE 8D 8C £B B84 83 38 0oz o0& < § w °
00097-00030 97 26 95 34 93 9z 91 90 A - |
0009F-00038 9F 9E 9D 3C SE 94 99 98 ¥ 2 0 &« > & = -
000A47-00040 A7 A6 AS A4 A3 AZ AL A0 § 1 ¥ ® &£ ¢

=l

Figure 96 Local Memory Content
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Performance Analysis

Your TA700/800 offers you two ways to do Performance Analysis, Real-time and
statistical. Performance Analysis that may be performed in any of the TA700/800
working modes except the Timing and Timing Asynchronous.

Exerciser Program When operating in the State Analyzer & Exerciser working mode, an
exerciser program is required to generate bus traffic.

Real-time analysis uses hardware counters and dual ported FIFOs. The counters count
the events at all times and interface with CPU via the FIFO to pass the results. This
method results in the most accurate performance measurement since the counters are
never stopped to be read.

ADVANTAGE: Continuous Real-time measurement.

DISADVANTAGE: Measurement results are based on an average.
Minimum and maximum can not be measured
and reported in this mode.

Statistical analysis is done by capturing the data into memory and post processing it
by software. In this mode TA700/800 allows the capture to occur after an
occurrence(s) of events so the captured data would include mostly the desired
transactions and not unrelated bus activities.

ADVANTAGE: Many more measurements are possible than in
the Real-time method. It is possible to measure
Min, Max and Average counts.

DISADVANTAGE: Non Real-time, Software post processing the
data.

Real-time Analysis

Continuous, Real-Time Analysis measures bus performance of up to 796MB/Sec,
64-bit 100 MHz. The analysis measurements are taken in accordance with predefined
analysis projects (*.pap). Some predefined analysis projects are included with your
software for immediate use or, you may create your own custom analysis projects by
setting analysis options, creating analysis equations, event patterns and exerciser
programs.
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Performing a Pre-defined Analysis

M Click the Performance Analysis Icon on the menu bar to open the Performance
Analysis dialog box and select the Performance Analysis Tab.

'a| PCI_AdvancedExerciserPerformance2 [_ (=] x]
Event Pnnunsl Exerciser nglaml Equation Performance Analysis |

1~ Show Events/Signals: i~ Graphic Settings: F i
— Percent Rati i~ Chart Mode:
o e e ¥ Repoit Mode
% Based On The Greatest ' Only Update Period =
F|Eventl 7 Even2 € Based On Clock B By d e
¥ Event3 7 Eventd Scale: Mo of Visible Periods {10 Advanced Options...
e 4| (W rmel] L
W Evens "o i) Counters Made:
o o & Reset
" Event3 =150
Yol ' Accumulative
™ Savedatatofile: [ | o of Samples: [T000
Update Interval (500 us) 1 | No of indows(1-5) - |1_:|

MOTE: Use slower than 30ms intervals only for events with low occurences.

A | cancel | Save | Load. | ot | Hote... Help

Figure 97 Performance Analysis Dialog Box
1. Click Load to open the Load dialog box.

- e .
Look jn: I’ﬂUsevDir _vJ @l gl

1 AnalyzerE verciser
] Compliance
] Uity

] performance.pep

File name: [pedd Open I
Files of type: IPelformance Analysis Project Files (*.pep) j Cancel
Z

2. Select a pre-defined analysis file and click Open to load the file.

3. Click Run to perform an analysis.
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Creating a New Analysis Project

To create a new analysis program you must define/program:

*  Performance Analysis Options
* Event Patterns
* Analysis Equations

*  An Exerciser Program

Setting Analysis Options:

To set analysis options make sure that the Performance Analysis Tab has been selected
and click on the Advanced Options button in the Performance Analysis Dialog Box to
open the Analysis Type Setting dialog box shown below.

Analysis Type Setting | X|

Analysis T
rrlaysls‘ iy This is the normal mode and
Entire Bus events of the event file are
" Specific Address counted in the update interval.

" Events at a Specific Address
o

le

pddiess [EHEngEs
oK I Cancel
ANALYSIS TYPE
Entire Bus To count the events defined in the event file at all
addresses.
Address Override Specific Address and Events at a Specific Address selections override
the addresses set in the event file.
Specific Address To count only all of the address events defined in
the event tab.
Events at a Specific Address To count all of the events defined in the event
tab after the occurrence of the specific address
selected. This mode may be used to measure a
data burst rate of a specific transfer.
SPECIFIED
ADDRESS RANGE A1 \ ALL SUBSEQUENT SPECIFIED EVENTS COUNTED UNTIL IDLE
DATA FOR A2 NOT COUNTED
IDLE | IDLE [ A1 | D1,,| D2, | IDLE|IDLE | A2 | D1, | D2, \
TIME
|—0 NOT INCLUDED IN
THE SPECIFIED ADDRESS RANGE
Specific Address Selecting the Specific Address or the Events at a Specific Address enables

address entry on the Performance Analysis dialog box.
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Per Event Tab To count bus cycles such as memory and I/O
operations at two or more addresses that are
specified in the event tab, e.g. I/O operation of
two different agents.

UPDATE INTERVAL

Set the update rate between 500 us and 10 minutes by positioning the Update Interval
slider with the mouse cursor.

ANALYSIS WINDOW SETTINGS

Percent Ratio Select Based on The Greatest to display results
relative to the largest value or Based on Clock,
to display an absolute measurement of all values.
Select *1, *10, *20, *50 or *100 to zoom the
display scale from 100% full scale to 1% full
scale.

Reset/Accumulate With Reset selected, the measurement counters
are reset at the beginning of each interval. With
Accumulative selected, the measurement
counters will continue to add up.

Chart Mode Choose Only Update Period to display the
default number of period only and choose
Periods and specify number updated periods
desired to see on the display.

Show Expression Chose Report Mode and or Chart Mode to see
the result of the equation in both report format as
well as graphical.

Defining Event Patterns
1. Click the Event Patterns Tab.

2. Define the Event Patterns as described in Creating an Event Pattern on page 68.

Writing And Editing Analysis Equations

Analysis equations are needed for generating the results of the measurement on the
Reports window. They are entered in simple algebraic format observing standard
algebraic conventions for operations using EV1 to EV8 (or their corresponding name)
as the variables, Clock is the number of system clock cycles specified in the update
interval of the project, e.g. in a 66MHz system and an update interval of 10ms clock
would equal to 660000. Freq is the system frequency expressed in millions, e.g in a
66MHz system Freq would be 66. The “Description” line is used to enter the report
title.

1. Click the Equation Tab to open the Equation Editor dialog box as shown in
Figure 98
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Add a New Line

Insert a Line

New Equation

Edit Equation

T1Generate_measure_adv.pap JE i e
Event Pattems | Exerciser Progiam ~ Equation ]PerfnrmanueAnalysisl
— Available Items:
Gades || Descritior: [[64 bR, 66 MHz) PCI Performance, Effciencies, Thiughput and Bus Utiization
data
master Show.~|
target Name Expression Unit In
idle Grap
::J;SEI Bus (Clock-idle)*100/Clock % (Entire X _'
EVS Idle time 100%idle/Clock % (Entire x
Freq Wait time (devsel-data)*100/devsel % X
Clock Transfer 100*data/devsel % X
Master ((100*master)/{devsel)) 4 X
Target ((100"target)/(devsel)) % X
Ll | LI'J
x|=x|2] || «] add | et | Delete |
| Erraaaas——
[~ Save data to file : Name Expression Unit
Update Interval (10 msec) 4] [Master Efici [0 masten)/(devsel) B
NOTE: Use slower than 30ms intervals
e || |
Bun | Cancel | Save

Figure 98 Equation Editor Dialog Box
To add a new equation line at the bottom of the list, click the Add button.

To insert a new equation above an existing equation line click the cursor
in the line above which you wish to insert the new line and then click the
Insert button.

Double click in a blank Expression line to open the Expression Dialog.
Type an equation name in the Name edit box.

Enter the equation in the Expression edit box using the Available Items and
operators from the Equation tab.

Enter the units to be displayed in the Unit edit box.

Double click in the line of the equation that you wish to edit to open the
Expression Dialog and perform the necessary editing.

Programming the Exerciser

1.

Click the Exerciser Program tab.

2. Program the Exerciser as described in “Programming the Exerciser” on page 83

Save Results

Save Settings

If you would like to save the analysis results, click Save data into the
File enter the number of samples you wish to save and the name of the
output file.

To save the measurement setup, first select Save to open the Save As
Dialog Box, enter a new file name to save as a *.pep file and click Save.

3. To perform the analysis Click OK.

107



Catalyst Enterprises, Inc. Performance Analysis

- Analyzer Windowl

I |
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ez

Figure 99 Analysis Real Time Display

In the Display area, select any combination from the available display options,
2D, 3D, Stacked, etc... . From the “Graphic Settings” in the Performance
analysis menu you may select scale for vertical and horizontal display.

4.
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Saved Performance Analysis
Review

Your TA700/800 offers you the ability to review the results of previously performed
and saved performance analyses.

Wisw Dt Fils

Pert

e Click Yiew on the menu bar and then select Performance Analysis Review to
w i Toolbw open the Open dialog box.
v Project Taolbar
v Ussr Mode Toolbar
v Status Bar
Open H

Lookin: |4 TaB6O

pritestfiles

File name: Ipa_test_review.paf Open I
Filez of type: IPetformance Analysis File (% paf) j Cancel |

Select a previously generated performance analysis file *.paf and click OK to open
the performance analysis windows and a Statistics Review Window for that analysis
file as shown in Figure 100.

I | ot

Flay Intenval ) [100 =]

LRI

Figure 100 Review of Saved Performance Analysis
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To review the previously saved performance analysis you may drag the scroll bar on
the Play Control Panel to the desired location or command it to step through
automatically.

Trace Statistics

PCI-X Trace Statistics not supported in current version.

Trace Statistics analysis is implemented by capturing data in memory and then post
processing it with software. The analysis software is capable of measuring important
parameters such as Minimum and Maximum latency occurrences for any target or user
defined specific target, command utilization such as how many times an /O write
versus I/O read occurs or, how many times memory commands occur. “Trace Analysis
Options” on page 39 lists the parameters that you may select for a report.

Click the Trace Statistics Icon on the menu bar to open the Trace Statistics
dialog box.
mfﬂali cs_adv.tap =]
Event Patlemsl Sequencerl Equation Trace Statistics I
Calculate View List
o ce € ot (Select any parameter(s) you want to see) Clear List
ol E € L i vLatency Target At Address )OOOBEEEEEEEEK
= “Latency Target At Address )OOOEEOOEEEEK
0f [RETRY 2 [N ) AP TSSO AAS
5 _ vLatency Master At Address )oOOOEROERELAN
I Accumulative Total & vNo of Data Transfer / Address
HRETRY At Addres:
A [Ro00000ae0aadin Ehange y =
CMD ﬁ [Ehange
Display
’7 IV Graph  No. of periods [20 IV | Report
I Savedatatofile: [ _‘ No of Samples: |1000
Update Interval (1 Sec) 4 Ll
Pre-Trigger (50%): 4| 1 |
Bun | Cancel | Save | Load... | [rport | Note... Help

Figure 101 Trace Statistics Dialog Box
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Creating a New Trace Project

To create a new trace project you must define/program:

* Trace Statistics Options.
* Event Patterns

* A sequencer program

* Analysis Equations

* An Exerciser Program

Setting Trace Options

Selecting Parameters

Select the parameters to be measured from the Analyze List Of shown in
“Trace Statistics Dialog Box™ on page 110 Move the selected parameter
to the right window for software to perform interrogation on that
parameter during post processing by clicking the =>> button next to the
Of edit box. Parameters may be defined as minimum, average, maximum
or count and or percent depending on which unit applies. Parameters may
also be defined, if applicable, by address type.

Optimum Number of Samples Set the amount of data to be captured in the memory for post

Update Interval

View List

Display as Text

Save Measurements

processing for each interval. The larger the number of samples the more
time is required for downloading and processing, Therefore you should
select an optimum number of samples to be captured to memory such as
1000. This takes about one second to process. If your application requires
more data then a larger number should be entered.

If a small number of data samples is expected to be captured, say 1000,
and the application does not require repeated measurement, you may want
to sample data once every 5 or 10 seconds by changing the Update
Interval to 5 or 10 seconds as required. The larger of the two number of
data samples or faster update rate will be the dominating setup for data
capture time.

Select the items you want to view on the display by highlighting and
clicking the items in the View List.

The report in text as well as graphics may be displayed on the screen
during run time by checking the Report box.

All measurements may also be saved and reviewed later, select SAVE and
specify the output file name. The results may be viewed under view.
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Defining Event Patterns
1. Click the Event Patterns Tab

2. Define the Event Patterns as described in “Timing Analysis - Synchronous” on
page 95.

Programming the Exerciser
1. Click the Exerciser Program tab.

2. Program the Exerciser as described in “Programming the Exerciser” on page 83

Defining Equations
1. Click the Equations Tab

2. Define Equations as described in “Writing And Editing Analysis Equations” on
page 106

Running the Trace Project

After all of the configuration and programming steps have been completed, click the
Trace Statistics Tab and verify that the items that you wish to collect statistics on are
highlighted.

1. Click Run to collect trace statistics.
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Example Files

A number of pre-defined projects with defined event patterns and sequencer programs
are include with your analyzer. You may Load a complete project to perform an
immediate data capture and trigger, or you may Import event patterns and sequencer
programs to assemble a project without much programming.

Create a Project Click the Black button on the menu bar to open a Project Definition

dialog box.

€3 eve_seq.udp

Load a Project

ol x]
Event Pattems Sequencer |
s0: Store [N ~ IF | address - I” TagEvent ThenGoto [51 =
ELSE IF [NONE ud ™ Discard Then Goto |S0 ¥
ELSE IF [NONE &2 I" Discard Then Goto |SO ¥
§1: [ Set Trigger I | Stat Ereriser Continue Store [ALL - l
IF( I~ Time) |1 ANY = [T TagEvent ThenGato |51 ¥
ELSE IF NONE = " Discard ThenGoto |51 ¥
ELSE IF NONE ¥ I™ Discard ThenGoto [S1 ¥
595 ™ Set Trigger I= | Stat Evercicer Continue Store |ALL =
IF( I~ Time) [1 ANY = [~ TagEvent ThenGoto [52 =]
ELSEIF NONE =l I~ Discad  ThenGoto |52 =] .
ELSE IF NOME = ™ Discard ThenGoto |52 =] 5 r'"x:
- Tex
Fi\eName:lUul‘Smp __I ™ Incriement filename automatically
Display: € Entire Memory  * Partial Memory |1000 » | Samples ™ AutoRun (20 times:
Pre-Trigger (50 % ) - il J LI
Bun | Cancel | Save | Load... I Impart... | Data Display Configuration | Mote... | Help I

Figure 102 Project Definition Dialog Box

To load a pre-defined project click the Looad button on the bottom of the

Project Definition Dialog Box.

Load

Look jn: I _ 4 AnalyzeiE xerciser

= 8l [EE

I_evenls.udpg E] eve_seq_x.udp
= ata_exer_adh @Mux.udp

= data_exer_adv_x.udp E]t\m\ng_adv.udp
] delay_crtr udp

2] eve_seq.udp

=) eve_seq_asych.udp

a‘ta_exer_ad\;'.udp

File name: | udp

Open I

Files of type: |Usa| Defined Project Files [*.udp)

B el

Select a pre-defined project from the examples folder and click OK.
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Import a Sequencer Program To import a pre-defined sequencer program, open a new project, select
the sequencer tab and click the Import button on the bottom of the
Project Definition Dialog Box.

Import Sequencer From EHE
Look in: I _ 4 AnalyzerE xerciser Ll EF
3] AdvancedPCl-X_evnsegqudp seq E‘ eve_seq_asychudp.seq El
ﬂ all_eventsudp.seq lﬂ eve_seq_xudp.seq @
g data_exer_adv_xudp.seq lﬂ eve_sequdp seq @
ﬂ data_exer_advudp seq E generate_measure_adv_xpap.seq @
2‘] datacapture_exercudp.seq E generate_measure_advpap seq @
2‘] delay_crtrucdp.seq ‘ﬂ mux_mocdeudp.seq @
dl | I
File name: | Open I
Files of type: |Sequence File [*.seq) j Cancel

Select a pre-defined sequencer from the examples folder and click OK.

Import an Event Pattern To import a pre-defined event pattern, select the event tab and click the
Import button on the bottom of the Project Definition Dialog Box.

Look in: I _ 4 AnalyzeiE xerciser L‘ gl

E AdvancedPCl-X_evnsequdp.evn E, eve_seq_asychudp.evn

E all_eventsudp.evn E, eve_seq_xudp.evn

5] data_exer_adv_xudp.evn ] eve_sequdp.evn

2] data_exer_advudp.evn 5] generste_meas_advpep.evn

2] detacapture_exercudp.evn 5] generste_measure_ady_xpap.evn
|Ei| delay_cntrudp.evn £] Generste_measure_advpap.evn

4 |

File name: | Open

i,

Files of type:  [Event Pattemn [*.&vn) =l Cancel

Select a pre-defined event from the examples folder and click OK.
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Program Device

The Program Device function initializes the configuration registers for use in a
passive motherboard.

Start Test...
Test Options To program a device, click “Program Device” from the Compliance dropdown
View check list :

list.

A reminder message appears requiring a passive backplane.

e The devices that you want to program should be on the passive back plane.

Cancel I

Click OK. After a brief period a list of programmable devices appears as shown in
Figure 103.

Program Device Dialog x| I

Found Devices :

(] Bus No= 0Vendor ID = 8086 Device ID = 7110 Bridge device

(] Bus No= 0Vendor ID = 8086 Device ID = 7111 [Func 1] Mass storage controller
14 Bus No= 0 Vendor ID vice ID = 7112 [Func 2]  Serial bus controllers
(] Bus No= 0Vendor ID = 8086 Device ID = 7113 [Func 3]  Bridge device

(] Bus No= 0Vendor ID = 5333 Device ID = 8301 Display controller

] Bus No= 0Vendor ID = 11F6 Device ID = 1401 Network controller

Program Checked Devices | Close Help

Figure 103 Select Device for Programming Dialog

Check the box next to the device you wish to program and then click the Program

Checked Devices button.
TA700_TAS00 | x|
! E Program Device is completed.

oK

Figure 104 Programming Device Complete Message
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Compliance Device Test

The TA700/800 incorporates a built in “Compliance Device Test” that performs the
PCI compliance checklist. The Compliance Device Test is available only while
operating in the Analyzer & Exerciser configuration.

“F Catalyst Enterprises, Inc. TA700_TAS00 Software
File Edit view Configuration Exerciser [cgmpliance Tools Macro Window Help

2@ ES L me(8 = b Co R (@0 ®- -0 W

Test Options F Advanced Mode Switch ko Easy

Wiew check list

Program Device

E-mail results to ...
To view a comprehensive description of the PCI Compliance Checklist, click
Compliance on the menu bar and then select View check list which opens the
checklist as a Microsoft Word for 2.1 spec and Acrobat format for 2.2 spec that you
may review on line or print.

<!

PCIl Compliance Checklist

NOTE 1: To view the Compliance checklist version 2.1 specifications requires Microsoft
Word 97 or higher to be installed on your system.

NOTE 2: To view the Compliance checklist version 2.2 requires Acrobat 4.0 or higher reader
to be installed on your system.

NOTE 3: You can run the tests at an offset that is specified in the compliance.inf file. For
more information refer to Manual\Compliance-Readme.txt.

Disable Device Drivers =~ When performing a device compliance test on your device that has
resident device drivers, you must disable them for the duration of the test
to avoid hanging the system. This is due to the compliance test rewriting
of the DUT registers for the purposes of the test.
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Executing a Compliance Device Test

Compliance RS

Mz

Start Test...

Test Options
View check list

Program Device

E-mail results to ...

Note:

Click “Start Test” from the Compliance drop down list on the menu bar to open
the Compliance Tests Configuration dialog box.

Be sure that your board is not involved in running any application program during
the Compliance Test.

Compliance Tests Configuration ' X|

i~ Device Selection
endor ID : |11F6 Device D : |14U1 Function NO : |FO i

Vendor Name :  Undefined vendor name

Found Devices : |Vendor ID = 11F6 Device ID = 1401 Network controller j_l

Vendor ID = 8086 Device ID =7110 Bridge device
Vendor ID = 8086 Device ID = 7111 [Func 1]  Mass storage controller
Vendor ID = 8086 Device ID = 7112 [Func 2]  Serial bus controllers
Vendor ID = 8086 Device ID = 7113 [Func 3]  Bridge device
Vendor ID = 5333 Device ID = 8301 Display controller
s

r— Tests List

[=- Component (]
co
o]

Add > |
DS

BA,
VG <--- Remove

YG_01
VGE_02 <--- Remove &ll
VG_03
VGE_04

VG 05 b
«| | »

Output File Name : ITEST.HTF

B

-3
K&
= -
]
Q

L

Start | Close | Load | Save | Help | thionsl

G_03. Does the device come up disabled? [Bottom three bits of Command register must be
initialized to zero on power-up and PCI RSTH).

Figure 105 Compliance Tests Configuration Dialog Box

Click the browse button to the right of the “Found Devices” field to have the TA700/
800 search for all PCI devices on the bus. The software will then display a list of
found devices with the ID code and the vendor code for each of the devices found on
the bus.

1. Select the device you like to perform the test on.

2. Choose the desired tests from the “Tests List” and click Add ->.

Test Description For a description of each test, click on a test and view the test description

on the bottom of the Compliance Tests Configuration dialog box.
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Compliance Device Test

Setting the Compliance Test Options

Select the desired device for compliance test and open the Compliance Tests Options
by clicking the Qptions button.

Compliance Tests Options [ %}

Configuration Space Tests Master Protocol Tests
Device Type Transaction Type
£ Taiget ' 32Bit v ALl [V Special
" Master " B4 Bit
v M
' Master and Target IV Memory v Memory AiM
M 1/0 [V Memory Wi
[V Configuration v
— Target Protocol Tests " Int 2 . v Memory FL
—SpecialCycle——————————————— nterup [V Dual Address
Encoded Message IFFFF
VeernlBen — DEVSELH Speed
seeae T IFFFF v Medium [V | Subtractive
IV Slow [V Below Subtractive
Report Mode
V¥ Overview
[~ Detal  Checklist compatible with
& Spec21  Spec 22
- Find Free Address
& Automatically
¢ Manauly [V AutoRun [3 =
Cancel | Help |

Figure 106 Compliance Tests Options Selection Dialog Box

Configuration Space Tests Check the device to be tested as Master, Target or both.

Master Protocol Tests

Target Protocol Tests

DEVSEL# Speed
Auto Run

Select protocol test options such as I/O, Memory. For Master test the user
is expected to interact and cause his master card to perform a series of
expected transactions. For the list of these transactions and the order they
appear refer to the “Compliance Test IUT User Guide.doc”.

Performs Target tests, in this mode the TA700/800 is a master and
requires little interaction from the user to perform target related tests on
UUT.

Select the target DEVSEL# decode speed.

In cases where you would like the test to be performed repetitively, check
the Auto Run box and set the number of times for the test to be repeated.
Click OK to complete setting the options.

Checklist Compatible with Select the PCI specification that you wish the test to follow, PCI 2.1 or

Save Configuration

Report Mode

PCI2.2.

You may save the test configuration for use later by clicking Saye. Assign
a test file name to the configuration and click Save.

When Overview is checked, only test results are displayed, however,
when Detail is checked all details are listed and explained.
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Running Compliance at an Offset

To run compliance at an offset you must specify the offset in the compliance.inf file
(in decimal) located in TA700_TAS800 directory. Keep in mind that the least 2
significant bits are masked. For more information refer to the compliance readme.txt
file in TA700 TA800\manual directory
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Executing a Saved Configuration

Run Previous Configuration To run a Compliance test with a previously saved configuration, click
Load and select a configuration file.

Specify the output file name where the test results are to be saved and click Start.

After clicking Start several messages may display, depending on the selected test, to
guide the user through the test.

Example Test

The following test (1.09) finds the addresses that are free for the TA700/800 as target.

Compliance Tests Configuration ' X|
i~ Device Selection
VendorID: |11F6 Device ID : [1401 Function NO : |FO
Found Devices : IVendor ID =11FE Device ID = 1401 Network controller _'J_l
r— Tests List
[=)- Component Pratocol checklist for a mas ;l 1.09
1.01
1.02 Add —
1.03
1.04
1.05 <--- Remove |
1.06
1.07 < Remove All
1.08
1.09
1.10 b
« | ;l"

Output File Name : ITEST.FITF

Start | Close | Load | Save | Help | thionsl

1.09 PCIBUS DATA PARITY ERROR SINGLE CYCLES

Figure 107 Compliance Test Setup
Choose test (1.09) and click Add -> and then Start.

After a short time the device found dialog as shown in Figure 108 will open,
requesting you to perform an action.
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001 Found the de: test will continue. B

>>
Compliance Test 1.09 (Medium Speed Memory Target) | ]

Please press OK and then program the IUT to perform the following transactions .

If you can not perform this press Cancel.
No. | Command Target Address DATA
1| Mem Read with CBE #=0000 010000000

Cancel | | abat |

Figure 108 Device Found Dialog

Perform the requested action and click OK.

Compliance Test 1.09 (Medium Speed Memory Target) | X|

Please press 0K and then program the IUT to perform the following transactions .
If you can not perform this transaction press Cancel.

No. |[Command | Target Address | DATA |

1| MemWiite | 010000000 | 00000000 |

Cancel | Abort |

Repeat Process for all displayed windows.

Compliance Test 1.09 (Medium Speed 1/0 Target) | X|

Please press 0K and then program the IUT to perform the following transactions .
If you can not perform this transaction press Cancel.

No. |[Command || Target Address | DATA |

1_|1/0 Read with CBE #=0000 | ox1oooo000 | |

Cancel | Abort |

Compliance Test 1.09 (Medium Speed 170 Target) | X|

Please press 0K and then program the IUT to perform the following transactions .

If you can not perform this transaction press Cancel.
No. |[Command | Target Address | DATA |
1 [170 Wite | 010000000 | 00000000 |

Cancel | Abort |

121



Catalyst Enterprises, Inc.

Compliance Device Test

ompliance Test

iguration Target)

If you can not perform this transaction press Cancel.

Please press 0K and then program the IUT to perform the following transactions .

No. |[Command || Target Address |

DATA

1_|Config Read with CBER=0000_|_(0x20000000_|

Cancel |

Abort |

ompliance Test

iguration Target)

If you can not perform this transaction press Cancel.

Please press 0K and then program the IUT to perform the following transactions .

No. |[Command | Target Address | DATA |
1_|[Config Wite | 20000000 | 00000000 |
Cancel | Abort |

After the final action is performed, a Compliance Result report is displayed.

Component Configuration Checklist
Test Description Result
co_o1 Does each PCl resource have a configuration space based on the 256 Yes « No N/A
byte template definedin section 6.1., with a predefined 64 byte header
and 3 192 byte device specific region?
co_oz Do all functions inthe device support the Viendor 10, Device D, Yes « No  N/A
Command, Status, Header Type and Class Code fields in the header? See
figure 6-1.
co_o3 Is the configuration space available for access at all times? Yes « No  N/A
CO_04 | Arewrites to resenved registers or read only bits completed normally and Yes « No N/A
the data discard?
CO_05 | Are reads to resenved or uni mplemented regsters, or bits, completed Yes « No  N/A
normally and a data value of 0 returned?
co_08 Is the Viendor 10 a number allocated by the PCI SIG? Yes « No  N/A
co_o07 Does the Header Type field hawve a valid encoding? Yes « No  N/A
co_os Do multi-byte transactions access the appropriate registers and are the Yes « No N/A
registers in "little endian" order?
CO_03 | Are all READ ONLY register vadueswithin legal rmnges? For example, the Yes « No N/A
interrupt pin register must only containvaues 0-4.
CO_03 | Vendor ID Implementation . 0K
co_03 Latency_Timer Implementation . 0K
co_03 Interupt_Line Implementation . 0K
CcO_10 Is the class code in compliance with the defirition in Appendix D? Yes « No  N/A
CcO_10 Base Classis : Display controller
Cco_10 SubBase Class is : WGA-compatible
controller. Memory
addresses 0AN000h
through OBFFFFh.
Y0 addresses 3B0h
to 3BBh and 3COh
to 30Fh and all
alizses of these
addresses.
co_1 Is the predefined header portion of configuration space accessible as Yes « No N/A
bytes, words, and dwords?
co_12 Is the device a multifunction device? Yes No « NiA
co_13 I the deviceis mutifunction, are corfiguration space accessesto Yes No N/A S
uni mplemented function ignored.

Figure 109 Compliance Result Report

This report may be printed for future reference.
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An additional report is generated on the display during this test. This report may be
used to access the details on the performed test for the data generated and captured on
the bus during the test. To access this data double click on the message line for the
desired test to open a display with the data, written and read, from the IUT board. For
NO responses the cursor is usually located at the non compliant event as shown in
Figure 110.

=== - T e TTRRN T TME T T T TS “\ Advanced Mode - Switchto Easy
[setupseieen ] Bocknaks | 4| X [»] + [wom0|em| e |« jm ﬁélﬁﬁ"‘”“’ |S' e |ulx i
Signal Name | Value (X) i 8 I—? I—S |5 i 4 |—3 I—Z IV‘ Iﬂ i 1 IZ |3 I‘ i 5
Time Gap Time Gap Time Gap i
Add[32] 10000000 10000004 10000008 10000000 i
Data[32] 11223344 A4BBCCOD mnm 11223344 i
CYCLE MEMBM | walT DATA WAIT DATA WAIT DATA IDLE MEMRM  WAIT WAIT WAIT DATA WAIT ]
FRAME# 0 R |
IRDY# 1
DEVSEL# |1
TRDY# 1
STOPE 1
Time_Rel 3853785 | mns 3 Wns s '
LAT_TGTI ——» |[1.08 _11] The IUT has not performed the requested write transaction | 60.ns |
LAT_Mstr B i
. L3, S e UL has nol petormed e equceied ead i aacton i
[1.08 _01] The IUT has not performed the requested read transaction ‘
== >>
[1.08 _11] The IUT has not performed the requested write transaction & |
K —— ¥ °
’ jE

Figure 110 Display With Non Compliant Trigger
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Compliance Device Test

E-Mail Device Compliance Results

Compliance [IEES
Start Test...
Test Options
View check list

Program Device

E-mail results to ...

When encountering difficulty with running a device compliance test, you may
perform the troublesome test and e-mail the result to Catalyst customer support.

Mz

Perform step 1 by clicking the Empty Folder button.

Archive & e-mail compliance test suite results to Catalyst

Step 1: Clear all sample files from compliance output folder.

Step 2 Chek UK tarur the Compliatice Tiest Suite

w

ster i Bill imthe Blanks o the checklst and close it

ap

tepd: Be sureithat the checklist s closed

Arehive

=
ol

ite & emallresultsito Catalpst

Lhp)

Click “E-mail results to . .” from the Compliance drop down list on the menu bar.

Then perform step 2 by clicking OK

Archive & e-mail compliance test suite results to Catalyst 2| x|

2

tepi s Elean &l sample fies fremeemplience eutputfalder

U

Step 2: Click OK to run the Compliance Test Suite

Step 2 Eilimthe Blanks orthie chiecklist and eleseit

0

tep 4o e sure thatithe checkiistis closed)

Step S Arehive b e-mal results e Eatalst

Ermpty Eolder |
0K I

[Ipern Chesklist

(I |

Archinve & E-mal

Close |

Set up a compliance test configuration in the Compliance Tests Configuration dialog

box as shown in Figure 111.
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Compliance Tests Configuration EHE I
— Device Selection
Vendor 1D - I Device D ; [1401 Function NO : |FO -
Vendor Name :
Found Devices : I‘u"endnr ID = 11FE Device ID = 1401 Network controller j _'
i~ Tests List
[=)- Component Configuration checklist Co_m
- C0 co_o2
oC Add > CO_03
=- DS
BA
o VG [hawe
[#- General Component Pratocol checklistimas
General Component Pratacol checklist(targ <-- Remove All |
[#- Component Protocal checklist for a master
Component Protocol checklist for a target ¢
4 | H

Output File Name : ITEST.FETF

Start | Close I Load I Save I Options

Component Configuration checklist

Figure 111 Compliance Tests Configuration Dialog Box

Click Start to start the test. After a brief period of time the test completes and displays
the PCI compliance checklist

ults to Catalyst HE Y

E Gl fder

Sten 1 Clea Advanced Mode Swilch to Essy

e fes from eomel
Step 2 Cick OK to run the Comphance Tes! Sute

S il e Bbris rithe checkls: Coispling 5 ==

Venda ID - [1176 Device D - [14 Function N0 - [F0 -
Vendos Narme :
* [Wendor ID = 1176 Device 1D = 1401

Close Compliance ;
Configuration Dialog

- Tests List

)6l Ede vew Inset Fomar Took Table window Help Acrcbt =18

T )
et DsaleRy rERd oo A HEEE S 6 1[0 ||
#3? Uﬂbaﬂngz | arid szsBrojlEsEsE|EEEEO-2-A
L C I I I KT ST T I e |

B VG
) Generel Compor | -
#) General Compor | ©
& Component Prol|
PCI resource hay | | # Component Prot| -

===3>YES B T
ions in the devic =~ |+
===3>YES Oukpud File Hame | | - Revision 2.1
Device is: Network controller (Ethernet controller)

Device Address: 0x80000000

‘Vendor ID: Dx11F6 Device 10: 0x1401

s vendor ID, de

Figure 112 PCI Compliance Checklist

Close the Compliance Configuration Dialog by clicking the Close button or the
Windows Close button to enable step 3.
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Archive & e-mail compliance test suite results to Catalyst [ 2| X] I

Step i: Clean all samplefiles from compliance cutput felder; Ermpty Folder I
Step 2 Click UK tarum the Compliance Tiest Suite

Step 3: Fill in the blanks on the checklist and close it Open Checklist I

Step 42 Be sure that the chiecklistis closed! 4 I

Click Open Checklist for step 3 to display the Checklist

W Microsoft Word - PCI_Compliance_Checklist-User_checklist.doc

“@ File Edit Yiew Insert Format Tools Table Window Help Acrobat =181 x|
D2 SRY tB@a<S oo =g ET@ ||
| it - Avial -w B 7= Si=EE Q-2 A

] R R R T K R SRR -

If you have a problem with compliance checklist function, please read the below documer
my question

1. Your DUT (device under test) 1z a multifunction device?
2. What 1z your DUT class code?

3. Do you have any implemented base address register on your DUT? J
3.1. If yes please fill the below table.
Base Addresses
Register N/A /0
Base Address 0

Base Address 1
Base Address 2

Base Address 3 =

Base Address 4 ;

Base Address 5

Funancinn BNM Aaca Addrocs =
E I EER | »

|Page 2 Sec 1 2z [at Ln Col =l i e Y

Fill in the required blanks on the checklist, close it and click OK for Step 3 to enable
step 4.
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Archive & e-mail compliance test suite results to Catalyst K B3 I

Step 1 Clean all sample files from complisnce autput felder, Ernpty Falder I
tep 2 (Elick WK ke i the Eompliance Hiest Suite MK |

step 2 Eillimthe blanks orithie checklistand close it e khe

o0

Step 4: Be sure that the checklist is closed.

tep & Archive & e-mal results toEatafyst

ap)

Click OK for step 4 to enable step 5.
Archive & e-mail compliance test suite results to Catalyst K E3 I

|
il Stepiis Cleanall samplefilesifram complisnce outputifelder Empty Folder I

StepZ: (Slick WK torum thelEampliance iest Suite |

i\ Stem 2 Fill i the Blanks o the checkiist and close it Open Checkiist

Step 4: Be sure that the checklistisiclosed )4

Step 5: Archive & e-mail results to Catalyst Archive & E-mail I
Close I

Click Archive & E-mail to open the E-mail client dialog.

[ Cotomer SwpportServioes M=
J File Edit View Inset Fomat Tools Message Help
E‘»‘ & @R o|la v 0 O =3B D

Send [t Copy Pastel  Undo Check Speling | Attach  Priority Sign  Enciypt  Dffine

To: |sugguﬂ@calalysl-ant,cnm
Ce |
Subject: |Eus|orner Support Services

Attach: |@ Compliance.zip (45.3 KE)

Times New Roman x| [12 VI Z|B 1 UA =iz

Description of problem |

]
/

Figure 113 E-mail Client Dialog Box

Default E-mail Client The E-mail dialog box reflects the default E-mail client installed on your
system.
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Default Recipient The default recipient of your E-mail is Catalyst Enterprises customer
support, but you may change that to any valid E-mail address
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Display Manipulation

Captured data may be displayed in either a waveform Figure 114, a list window as
shown in Figure 115 or both simultaneously as shown in Figure 116. To enhance
viewing the data you may add or delete signals for viewing, use cursors to measure
timing differences and zoom in and out around the X and Y cursors to analyze the
captured events.

Zoom IXT][XRef-Tig)  [Y-T)(YRef-Trig) ~ [X-Y] (XRef-YRef)
SelupScreen | Bookmaks | 4| X || & [woo|Em|Ea |« | | [T Biocks [0Clocks T Clocks
Signal Name | Value (<) | -4 3 2 A 1] 1 2 3 4 5 B 7 8 9
1 1 1 1 1 1 I 1 1 1 1 1 1 1 )
L] ] =
1
Clock |
1
Time Gap l
Add[32] 00000021
Data(32] 3
CYCLE WAIT IDLE VOWR [WAIT  [WAIT  wAIT  WAT  WAT  WAIT  DATA  IDLE
FRAME# 1
IRDY# 0 -
DEVSEL# 0
TRDY# 1
STOP# 1
Time_Rel 30.ns 30 30ns  3ms 30ns  [3ns [3es 30ns 3ns 3ns 30ns 30ns 3ns 30ns 30ns
LAT_TGT1 ¥ 150. ns
LAT _Mstr 00ns
LAT_ARB
Kl o

Figure 114 Waveform Data Display

You may rearrange the displayed signal order by selecting the signal name in the
display with the left mouse button and then dragging it to a new location.

Signal Level Display A convenient numeric signal level readout appears next to each signal
name. The level indicated is at the active cursor position. Clicking on the
cursor select button on the Data Display menu bar toggles the numeric
readout to match the cursor selected. Clicking the + button enables this
feature.

| Bookmark's | ﬂ X |)| : |IOI0|E CYCLE WAIT IDLE
FRAME# 1

Value (X) ’I-? I-S |-5 : ——————

| IRDY# 0

DEVSEL# 1
TRDY# 1
STOP# 1
Time_Rel 30.ns 1.0752 ms
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1010 To view the list file output display, click the List button.

SetupSoreen | Bookmaks | 4| X [»] # [in|Em | = jﬁ-g::f:f.w ﬁ;ﬂf{f il ﬁgﬂﬁﬁm"’"
SignalName | TimeGep  Add[32]  Deta[32] CYCLE  FRAME# IRDY# DEVSEL# TROY# STOP# Time_Rel LAT_TGT1 LAT Mstr LAT
Value (9 DLE 1 1 1 1 1 30.ns
7 Time Gap IDLE 1 1 1 1 1 1.0752 ms H
£ 1 1 1 1 1 30.ns !
5 1 1 1 1 1 30.ns i
-4 x| 1 1 1 1 1 0. n:
-3 1 1 1 1 1 30.ns
2 1 1 1 1 1 30.ns
1 00000021 1/0'WR 0 1 1 1 1 30.ns
0 <l WAIT 1 0 1 1 1 30.ns 0.0ns
1 WAIT 1 0 0 1 1 30.ns
2 WAIT 1 0 0 1 1 30.ns
3 WAIT 1 0 0 1 1 30.ns
4 WAIT 1 0 0 1 1 30.ns
5 WAIT 1 0 0 1 1 30.ns
6 98- DATA 1 0 0 0 1 30.ns 150. ns
7 IDLE 1 1 1 1 1 30.ns
8 1 1 1 1 1 30.ns
9 1 1 1 1 1 30.ns
10 1 1 1 1 1 30.ns
n 1 1 1 1 1 30.ns
12 1 1 1 1 1 30.ns
13 1 1 1 1 1 30.ns

Figure 115 List Data Display

To view the waveform and the list file outputs display simultaneously, click the
Q%l [ split screen button on either, an open waveform or list display.

& E_SpecAdd.smp W= K |[SE_SpecAdd. smp (o] x|
SetpSoieen | Bookmaks | 4| X [»| |+ |n|Em| ] o = || setpssieen | Bookmaks | 4| X [v] + [wo0|em[FH] < jm
Signal Name ‘ Time Gap Add[32] Data[32] CYCLE FRANK | Signal Name | Value (%) | -7 ES 5 -4 3
Value (%) [ WAT 1 ! ! ! ! ! =
s ! Time Gap Time Gap
5 1
. , Add[32)
5 ; Data[32]
2 1 CYCLE WAT | DE
-1 00000021 1/0WR 0 FRAME# i |
0 a WAIT 1 —
: Al ; IRDY# 0 |
2 WAl ; DEVSEL# 1 [
3 WAIT 1 TRDY# 1 [
4 WAIT 1 STOP# 1 |
5 WAIT 1 _
5 3. DATA 4 Time_Rel 30.ns 1.0752ms 30.ns 30.ns 30.ns 30.ns
7 IDLE 1 LAT_TGT1
8 1 LAT_Mstr 0.0ns
9 ! LAT_ARB
10 1
1 1 ' l
Figure 116 Simultaneous Waveform and List Display
Linked Cursors The cursors in the waveform and list windows are linked such that when

you reposition a cursor in one window, the corresponding cursor in the
other window moves to the same location.
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Multiple Results Windows

In cases where you would like to view several open windows simultaneously:

Click Configuration on the main menu bar.

Working Mode 4
Protocol Erors...

Mnemonics...

Extemnal Signal Names
Extemnal Trigger Settings...
Voltage Check...

Host Bus

Zoom Options 3
Color Settings...

Authorization
System Feature Status
Configuration Space Information

Choose Software Settings from the drop-down list to open the TA 700 Global
Settings Dialog box.

TA700_TA800 Global Settings ] 21|

User Directory : IE:\F‘roglam Filesh\Catalysth

= ::l Program Files Zl
{1 Adaptec [v sk for number of Inserts in Exerciser Program
&3 Adobe [V Close Previous Sample Window

i{_] Aladdin Systems

-] AvantGo Connect [V Use Default Options for Ultiities
1 Borland ;
_ g |: s, J [~ Ask for "Save changes" on exit
e Q BTAE [¥ Show Splash Screen at Startup
-] SBAE30
=1 TATO0_TAS00 [V View Sequencer in Text Mode
. [i lEII E{:Bu:':ne 4 [V Save Software Settings on Exit
-0 UserDir

Scan Config compatible with PCl Spec: 21+ 22 ‘

El {2 USE Driver Installatic

{1 Common Files =
< D | Ll—, ITI Cancel |

Figure 117 TA700/800 Global Settings Dialog
Uncheck the Close Previous Sample Window check box and click OK
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Adding and Removing Signals for Display

All PCI bus signals are always captured and stored on disc, but may not necessarily be
displayed as default unless selected. For a signal to be viewed you must make sure that
it is included for display. The capability to add or remove signals from the display

offers you the ability to make the display less cluttered by including only the signals
of current interest.

All signals stored Adding and removing signals is a display function only. All captured data
are saved in the output file on the hard disc and is available for display by
including the signal name on the setup screen.

To add a signal to an open display:

Click the Setup Screen button to open the Active Signals dialog box.

| Remaining Signals I Active Signals rr: g:"w g;:erences in E:'"ek [~ Show Grid Lines
« Show Differences in Clocl
2] : ' 1% Show Signal Values
I .I 1 - .
Group | PCI E“:CaIEE ] " Show Latency in Time [¥ Show Timegap
aoaa. . |FRAMER {+ Show Latency in Clock IV | Show Clock
C/BE[3-0] IRDYH
GNTH# DEVSEL# " List Show Mode Column Width :
IDSEL TRDvE {* Wave Show Mode
LOCK#H STOPH 60
Time_Rel P
E:Eu Lﬂejaeﬁ (% Move X Cursor fowhicichi;
REQ# LAT_Mst " Move Y Cursor 30
RSTH# LAT_ARE
Red (D ] |
Green [ 4 l ﬂ
Add > <-- Remove EBlue [255 ‘ »
_l Add All Groups ==>> J J_l
_pada-> | - Remave | |
o | Concel | SetColor | Defouk Color | Hep |

Figure 118 Active Signals Dialog Box

Find the signal to be added in the Remaining Signals area and click Add. To find
signals quicker the signals are grouped in several classifications. When you select a
group, all of the signals of that group display in the Remaining Signals window.
Conversely you may remove signals from the Active Signals window by highlighting
them and clicking Remove. When done click OK. The signals are always added to the

end of the display but they may be dragged by the mouse to the desired location in the
display for viewing.
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Termination Display

In addition to the software determined termination, displayed in the

sample viewer CYCLE column, you may add a column to display a
hardware determined termination.

Note:

This feature is not available for the expansion memory in the TA700.

To display the hardware determined termination: Click the Setup Screen button in an open sample
window to open the Active Signals dialog box.

2l
e — s " Show Differences in Time e
| Remaining Signals [ Active Signals I” Show Grid Lines
1+ Show Differences in Clock
pciz] ' I Show Signal Values
Group ITUDLS :1' D?‘lt:aIEE ! " Show Latency in Time: ¥ Show Timegap
i FRAME# (¥ Shaw Latency in Clock
IRDYH ¥ Show Clock
?EE&%L“ & List Show Mode Column Width :
STOPH " wave Show Mode |Eg
Time_Rel B
fme-ne " Move X Cursor R
& Move Y Cursor 30
Red IIJ 4 o
Green Ig 4 I I _;]
Add > I < Remove I Blue |255 q »
Add All Groups ==>> J -]—I
udd iy 4“' femove 1 |
K| Concel | SetColor | Defauit Color |

Figure 119 Active Signals Dialog Box

Click the down arrow next to the Group drop down list box, choose Tools, select
Termination, click Add-> and then OK to include it in the Active Signals list.

F Catalyst Enterprises, Inc. TA700_TAB800 Software - [termination example.smp]

5l File Edt View Configuration Tools Macro Window Help

|2 2 BS w s & & #&rcsee ey EELIIEN £
Easy Mode Switch to Advanced

Sample Type : PCI State Anal Only or State Analyzer and Exerciser 2007 KT KRef-Trg)  [V-TI1(YRef-Trg] [X-Y] <XRefYRef]

Selup Screen I Bookmark's ] qI ¥ ] pI + I1.r|.| m] fy I j —.“E Clocks [pTiacks [FTiocks

|Signal Nams Time Gap Add[32)  Data[32) CYCLE  Temminaion FRAME# IRDY# DEVSEL# TRDY# STOP#
[ivalue oy Time Gap 00000000 MEM W 0 1 1 1 1

a ] Time Gap 00000000 MEM WH 0 1 1 1 1

1 Hardware determined terminatiofl 1 0 1 1 1

2 WAaIT 1 0 1 1 1

3 . L. WAIT 1 0 1 1 1

h Software determined termination \ AT : . . . .

5 MaBORT 1 1] 1 1 1

3 <X IDLE MABORT 1 1 1 1 1

7 Time Gap 11111110 MEM WR 0 1 1 1 1

1 WAIT 1 0 1 1 1

9 WAIT 1 0 1 1 1

10 WAIT 1 0 1 1 1

11 WAIT 1 0 1 1 1

12 M&BORT 1 0 1 1 1

Figure 120 Hardware Determined Termination Included in Display

This feature is useful to display a hardware determined termination for cases where,
for some sequencer qualified captures, the software has insufficient data to decode a
termination.
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PCI-X Attribute Display To display PCI-X attributes you must include them in the Active Signals
list. Click the Setup Screen button in a PCI-X sample window to open the
Active Signals dialog box.

Femaining Signals | Active Signals ? g:"w gge'me‘ ® E:‘Ek I~ Show Grid Lines
———— | | & Show Differences in Cloc
Add[32) ¥ Show Signal Values
CIETRIATTRIBUTE :lv E\??E‘Ezl " Show Latency in Time ¥ Show Timegap
FRAME# % Show Latency in Clock
IRDYH ¥ Show Clock
DEVSEL#H " List Show Mode Colurnn Width :
TRDva ' \Wave Show Mode
STOPH# | 55
Time_Rel 1l T
Comp Bus No LAT_TGT1 " tove X Cursor Row Height :
Fieq Bus No LAT_Mst " Move Y Cursor 30
Comp Dev No LAT_ARE
ReqDev No
Comp Func No Red [0 Fl »
Req Func No LI —U J
oo Green [ ﬂ_l ﬂ
Add > | <-- Remave I Blue [755 ] v
Add All Groups ==>> J
T ]| O —

oK | Concel | SetColor | Defauit Coar | Hep |

Figure 121 Select PCI-X Attributes for Display

Click the down arrow in the Group drop down box and choose Attribute. Select
individual attributes and click the Add->> button or click the Add All->> button to
move the signals to the Active Signal list. Click OK when done.

P Catalyst Enterprises, Inc. TA700 Software - [Analyzer_x. smp]
) Fle Edt View Coniigwstion Tooks Macro Window Hep SETE

FECrEE Y e LA L

Advanced Mode Switch to Easy

Sample Type : PCI X State Analyzer Only o State Analyzer and Exerciser Zoom DCTIRXReiTial  [-T1(YRefTog) [XY]PFRefYRel]
setupscieen | Bosknaits | ¢ X |#| + [woo|EE| @] | ek (=3 [Friecks
.Signﬂ\ Name  |Value (<) IIfl I1 I2 IJ 14 l5 IE I? IB IS IIlfl I" II? I13 I1-|

i ® =
clck gipSplipipiplipinininSnSnnEnEnl

Time Gap
LAT_TGTI #2, Clocks
LAT_Mstr ¥ 3 Clocks

LAT_ARE
[BCM
ISCE

INS

ISCM

RO

TAG nz
(Comp Bus No
IReq Bus No 0
IComp Dev No
Req DevNo 0

(Comp FuncNo

Reg Func Na il

L] L] LILI

Unknonn 64 B equency = 33.33MHz & [ oM

Figure 122 PCI-X Attribute Display
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Attribute Abbreviations
BCM
SCE
NS
SCM
RO
Comp Bus No
Req Bus No
Comp Dev No
Comp Func No
Req Func No
Comp ID
Req ID
Seq ID
SEC Bus ID
Byte En [3-0]

Quick Signal Edit

in the signal name area.

Byte Count Modified
Split Completion Error
No Snoop (NS)

Split Completion Message
Relaxed Ordering (RO)
Completer Bus No.
Requester Bus No.
Completer Device No.
Completer Function No.
Requester Function No.
Completer ID
Requester ID

Sequence ID

Secondary Bus No

Byte Enable

To quickly add or remove signals from the display, right click the mouse

Insert Signal
Delete Signal

* Set New Bookmark

Define New Color of this Signal
Define New Backaround Color

DefineewEramework Calor

Figure 123 Quick Signal Edit List

Clicking Insert Signal will open the Insert Signal dialog shown in Figure 124.
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[Insert Signal |
Group [TRE RN ~ | ] |
ED[31-0]
C/BE[30] &l
PAR
SDONE
SBO#
REQH
GNT#
LOCK#
IDSEL
RSTH
PME #

Figure 124 Insert Signal Dialog
Choose the signal to be added and click OK.

Using a Bookmark Bookmarks are a convenient way to mark a point in the results display by

name such that you can rapidly return to that point by name. To create a
bookmark:

Right click the mouse in the signal display area where you wish to place a
bookmark to open the Quick Signal Edit list.

Insert Signal
Delete Signal

Set Mew Bookmark

Define Mew Color of this Signal
Define New Background Color

Defitie Hew Eramework Color

Choose Set New Bookmark to open the Bookmark dialog box shown in
Figure 125.

Bookmark E3

Name IBonkmark #2

Bookmark #1

Sample File : j\catalyst\Predefined\Simulation\E_S pecadd.smp
Sample No: 1

Figure 125 Bookmark Dialog
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Using a Bookmark

Remove Display Signal

Signal Trace Color

Background Color

Enter a name for the bookmark and click Add and then Close. For
additional bookmarks, search the display for another point of interest and
repeat the process.

You can jump X or Y cursors, to the bookmarked point from anywhere in
the display by clicking the Bookmark’s button on the Waveform or List
data display to open the Bookmark Search Dialog shown in Figure 126.

Name IBookmark #2 LI

Bookmark #1 Close
:Bookmark #2

Delete

Go to Bookmark

i

Help

[~ MoveX
[~ MoveY

Sample File : D:ATA-BE0\Data\Simulation\E_Specidd.smp
Sample No: 32

Figure 126 Bookmark Search Dialog

Select the bookmark location you desire and then Go to bookmark.

To remove a signal from display right click the mouse on the signal name
or on the signal line and choose Delete Signal in the Quick Signal Edit
List.

You may tag special signals of interest to be displayed in a different color
to differentiate them from the rest. To assign a color to a signal trace:

Right click the mouse under the signal which you wish to change the
color to open the Quick Signal Edit List and choose Define Signal Color
to open the Signal Color Selection Dialog box as shown in Figure 127,
select a color and click OK.

To choose a different background color, right click the mouse in the signal
display area to open the Quick Signal Edit List and choose Define
Background Color to open the Signal Color Selection Dialog box as
shown in Figure 127, select a color and click OK.
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Colot ‘ I!i
Basic colors:
T
i el |
[ il § el § |
HTEN NN NN
AN EEEEEN
EEEEE E
Custom colors:
N I I
N I Y I
Define Custom Colors >> |
OK I Cancel |

Figure 127 Signal Color Selection Dialog

Latency Report

To view Master/Target Latencies add the signals LAT XX to the display See Figure
118.

Latency Clock vs Time  You may display latencies in clock or time units by making the choice in
the Setup Screen as shown in Figure 118.

Using the Cursors

Each of the data displays incorporates three cursors that are labeled X, Y and T. All of
them are initially overlaid and positioned at location 0, which is the trigger position of
the display. The Trigger or T cursor is always locked at location 0 of the display. It
cannot be repositioned. and serves as the measurement reference.

Moving the X Cursor The X cursor may be dragged by selecting the left mouse button and
positioning the mouse cursor over the display cursors and then dragging
to the desired location or by clicking the left mouse button with the mouse
cursor positioned anywhere in the display. This will cause a display in the
[X-T](XRef-Trig) box to show the difference in clocks, or, if selected,
time, between the trigger and the X cursor.

Moving the Y Cursor Similarly the Y cursor may be dragged by positioning the mouse cursor
over the cursors with the right mouse button selected or by clicking the
right mouse button with the mouse cursor anywhere in the display. This
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will cause a display in the [Y-T](YRef-Trig) box to show the difference in
clocks, or if selected, time, between the trigger and the Y cursor. The
difference between the X cursor and the Y cursor is shown in the
[X-Y](XRef-YRef) box as well.

Time vs. Clocks Display  To display differences in clocks or time select Show Differences in Time

or Show Differences in Clock from the Active Signals Dialog box as
desired. See Figure 118.

Jump Within Data Display

You may quickly jump within a data display relative to the start position, trigger
position or cursor positions, using the Jump option.

Eind F3
Find Next kN
Find Previous Cl+L

Compare...
Capture Screen...

Murnber of Erors...
Filter Data...

System Memory Allocation

To jump within the display click Tools on the menu bar and then select Jump to
open the Jump Dialog box.

Zoom XTIKRefTrig)  [Y-TIVRefTrig)  [XY] XRefYRef]
SetupSoreen | Bookmaik's | 4| X [»] + [io0|Em a4 | | [#Thocks [0Ciocks 4 Clocks
Signal Name | Value (X) |-4 |-3 |-2 |-1 IU I1 IZ |3 Ia |5 IS I? IB |9
x [ =
Clock |
l}
Time Gap. !
Add[32] 00000021 I
Data[32] g 9. i
JumpTygpe——————————————
CYCLE WAIT IDLE 18| | & Rejative To Trigger Postion WAT WA DATA  IDLE
FRAMES 1 ]  Relative toX Posiion
€ Relative to Y Postion
IRDY# 0 ' From Staiting Position -
DEVSEL# 0 Jump Value : [4
TRDY# 1 0K | | Concel | Hep |
STOP# 1 I

Figure 128 Selecting a Jump Option

Select the desired jump option, enter the desired distance for the jump and click OK.

Using Zoom in the Wave Window

Zoom is available only in the wave window and permits you to scale the display by a
factor of 0.1 to 10. To zoom the display you may click on and drag the zoom slider to
a zoom position or simply click to the right of the slider button to zoom in and to the

left of the slider button to zoom out.
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Zoom Options

To zoom about the X, Y or between the X & Y cursors click Configuration on the
main menu bar and select the Zoom Options as shown in Figure 129.

Qunfiguraiiuﬁ‘ Tools Window Help

‘Working Mode Sl Analyzes = x
Protocol Erors...

Mnemonics... Zoom
Extemal Signal Names ...

Extemal Trigger Settings... 1010 | B | iy |j J

Voltage Check... 4 3 4
Host Bus... | 1 1
Zoom Options Zoom About X Cursor

Color Settings... Zoom About Y Cursor

Software Settings... Zoom Between X, Y Cursors
Authorization ® Zoom &round

System Feature Status
Configuration Space Information

Figure 129 Setting Zoom Options

Zoom Around Choosing this option zooms the current display window independently of
the cursors.

User Defined Display Configuration

Users may modify the display by adding, removing, and rearranging the position and
color of the signals as it fits best for their application. This format may be saved and
recalled for different data capture and trigger projects.

Display Configuration To save and recall this configuration file, simply make all the desired
changes to the display and do a “Save As”, select a file name with
extension.ddc (Data Display configuration).

To recall this configuration format click on “Data Display Configuration” Button on
the bottom of the project menu before executing the project, browse and select the file
name desired for this project and enable it in the drop down menu.

Note: Saving the Data display configuration does not work on the pre-captured data
provided with the software in the simulation mode, it has to be done on user
captured data.
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I} data_capture.cdp

Capture Data And Trigger I

Data Capture Selection

' Everything
" Specific Address(es)

Exclude
lrl_ Idles [T /&t IT | Fieties

i~ Trigger Point Selection

UFFETEN ¢ Address [\opaotdt! MNew...
'Eress ﬂ _| 7
Command : [0 _' Madii,.
HEemaye:
™ Manual Trigger il
Clear &ll
Display: ' Entire Memory (%" Partial Memory |1000 ﬂsan’ples ™ Auto Run |20 times
Pre-Trigger (50 % ): LI _E _.l Address/DataSize: % 32Bit " B4Bit

Bun | Cancel | Save | Load.. | ygjeieies |

Ic:\pruglam fileshcatalyst\taBB0_release_4\userdifstest.ddc ... |

ok | Cancel Hep |

Search

The search option permits you to examine any output file and to quickly locate PCI
bus data patterns including search patterns defined in Mnemonics.

The search option is enabled whenever an output file is displayed on the screen.

Whenever an output file is displayed the Menu Bar is expanded to include the
additional Find, Find Next and Find Previous icons.

= = =

N e =

fH Click the Search button to open the Search Pattern definition dialog box.
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1.

~ Seaich Ako

I Vitual Address Pattemn [[20000000 I~ Temination [Taicet Aete = Clear List
™ Protocol Erors Pattem OO _I E
Cancel
- Search From —SearchDirection——— - Vitual Address Pattem Typs—— =
%! Beginning of Fie & Foward  C Backwaid & @Bt € B4BQ .
€ Last Item Found
" Beginning of Screen
~
- : g: Search for pattern longer than |1 samples

Figure 130 Search Pattern Definition Dialog Box (D32 XFER)

Set the search parameters and address or parameter pattern that you wish to
locate and click OK.

Search Settings Retained The search settings for each search are retained for future use, unless

Search Also

cleared by clicking the Clear List button. To search with previously
defined settings, highlight the appropriate line and click OK.

~ Seaich Ako

I Vitual Address Pattemn [[20000000 I~ Temination [Taicet Aete = Clear List
™ Protocol Erors Pattem OO _I L
Cancel
- Search From —SearchDirection——— - Vitual Address Pattem Typs—— 5
%! Beginning of Fie © Backward & @Bk B4BL S
€ Last Item Found
" Beginning of Screen
~
- : g: Search for pattern longer than |1 samples

Figure 131 Search Settings Retained

Each time you initiate a new search, an unconfigured search line is added
to the list. You may use it to set up new search parameters or use one of
the previously defined ones.

You may expand your search to include Virtual Address Pattern, Protocol
Errors Pattern and/or External Signals Pattern or termination type by
checking the appropriate check box in the Search Also area.
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Search may also be made for names. These names are defined and
assigned to patterns in the mnemonics menu.

External Signals Pattern To search external signals, double click in the Extern Signal field and
select the external signal pattern required in the data entry dialog.

Search Pattern e x|

g| Mame |XFER AD[] P | CBE[] |[I|F|I|D|T|S[L|R/G [INTX|E R
E A DIR(R(E|R|T|O 5
= S|A(D|VID|O|C T
R E(M[Y|S|Y|P|K #
c L{E[#|E]|# # %
#| |L
H
#
X XX
0

~Search Also
I Vitual Address Pat O Binay I SetRange [
™ Protocol Errars Patl ;W J
~SearchFiom
& Beginning of Fil

€ Last ltem Found 16 Bits maximum.

" Beginning of Scre oK I Cancel | Clear | Help I
X Cursor
Y Cursor

‘ ‘ Search for pattern longer than [T samples |

Figure 132 Defining External Signals Patterns

Protocol Errors Pattern  To search with protocol error patterns, click the ellipses button next to the
Protocol Errors Patterns edit box and define the Protocol error pattern by
clicking the don’t care X repeatedly to setitto a 1 or 0 as desired.

Search Pattein

D32
i~ Search | [X | ERRO - FRAMER must be de-asserted as soon as IRDY#H can be asserted from the time STOPH was asserted PCI Rev &
I i | || ERR1 - Back-to-Back timing was used in a transaction in which was not proceeded by a wite transaction form the same
% |ERR2 - FRAMEH is not asserted within 18 clacks from the time GNTH was asserted. PCI Rev 22-3.4.1
¥ Pral % |ERR3 - FRAMER was asserted before the bus was granted(before GNTH was asserted) PCl Rev 21341
% |ERR4 - IRDY# was not asserted a cycle immediately after FRAME # was deasserted. PCI Rev 2.1-3.3.1
Bl | N E RS - Improper temmination Either IRDY#, TRDY#, o1 STOPH v
@+ Be| | X | ERRAG - IRDY# was asserted on the same clock edge that FRAME# was asselted 3.3.1.Read Transaction
s (% |ERR7 - IRDY# was asserted when FRAMEH was high.Appnedix CRule 7.
i ERRS - After IRDY'H was asserted, IRDYH or FRAMEH were changed before the curent data phase was completed or
" Be (% |ERRY - IRDYH was asserted duung the second ad:!less phase of a DuaIAddress Cyele. 3.10.1 B4-bit Addressing
(9 J] NN EFR10 - FERR# was as 3
v i ERR11 - PERR# was assaned dumg address [:ycle FE! Hev 21.- 2 2 5
% |ERR12 - PAR does not match paiity across AD[31:0] and CBE[3:0]
% |ERR13 - PARG4 does not match parity across AD[B3:32] and CBE[7:4) ]
% | ERR14 - Data parity enor was detected on A0[31..0], but PERR# was not asserted. Appendix C. Rule 37 b
% |ERR15 - Data parity enor was detected on AD[63..32], but PERR# was not asserted. Appendix C, Rule 37 ¢
K AFRRIF - NFYSFI # was remived while ansaction was nat eomnleted uet PRI Rey 2133 ﬂ
Selaltol’ | Setalto' | Dont Care il 0Kk || Concel || Hep |

Figure 133 Search Also Protocol Errors
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Search Using Mnemonic To search for a match pattern defined as a Mnemonic click in the Name
Field of the search pattern dialog and choose the mnemonic name that you
wish to use in the search.

Select Mnemonic

YOUR NM
NAME?2
NAME3
NAME 4
NAMES
NAMEG
NAME7
NAMES

NAMES
NAME10 i

Cancel I

Figure 134 Choosing a Mnemonic

Defining Mnemonics For instructions on how to define Mnemonics see “Mnemonics” on
page 164.

Virtual Address Pattern To search for a Virtual Address pattern, click the Virtual Address check
box in the Search Also area and enter the address relative to the start
address of a Burst or DMA transfer (Which is transferred on the bus) to
locate the corresponding data point. Virtual addresses are displayed in
black in the results display.

Termination To search for a termination, click the down arrow next to the Termination
drop-down list box and choose the desired termination type to search for.

Search Palten

Seaich Ako

IV Vitual Address Paiten IV Termination |Target Fietry =] ClearList_ |
" Piotocol Erors Pattem _I : : E
Target Disconnect With Data Cancel
i~ Search Fram -~ Search Direction Target Disconnect Without Data
& Beginning of File Master Abort Help
egnning of Fi & Foward O Backwaid ‘ FT32BKE B4 BT
€ Last Item Found
" Beginning of Screen
¥ Cursor
Search for pattern longer than |1 samples
€ ¥ Cursor LRI

Figure 135 Search for Virtual Address and Termination Selection

After the initial search, you may perform forward or backward searches for the
ﬁ .;a same item by clicking on the Find Next or Find Previous buttons on the menu
bar.

Required Data The search forward or search backward functions require collected data in
the selected search direction in order to operate. A search is performed in
relation to the X cursor. When a match is found a new Search S cursor
appears at that location.
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Converting Captured Data

The captured data may be converted to several standard formats such as text, Excel
and PCX graphics.

Convert To Text

You may convert an output (*.smp) file to ASCII text for later use in off-line data
analysis programs. A text file may be created from the currently displayed (*.smp) file
immediately after data capture or from a previously saved output file.

New >

Open... Ctrl+0

Close

Save.. Eubs To create a text file from a displayed data file. Click File on the menu bar and

then select Save As

Printer Setup...
Print... Ctrl+P
Print Preyiew

Exit

Select a folder where you wish to save the text file, enter a File Name and choose Save
as type Text Files (*.txt) and click Save.

Save in: lﬁ Compliance j @, gl

File name:  [transactior| Save I

Save astype: [Text Files [*tx) | Cancel |/
Z

After a short time the Text File created window will open, displaying the name and the
path to the converted text file.

TAZ700

Text file of d:Acatalpsthuserdiritext_example.tat created.

Make a note of the path to the file and click OK to close the window.
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To view the newly created text file click File on the menu bar and then select Open.

Look in: l’ﬂ Compliance | @J EI‘J

File name:  [transaction.tst Open I
Files of type: |TexlFiIes (=) | Cancel |

Z

Select the file and click Open to view the text file as shown in Figure 136.

& transaction.txt - Notepad _ (o] x|
File Edt Seach Help

I &
Sample# Rdd[32] Data[32] CYCLE FRAME# IRDY# DEUSEL# TRDY# STOP# Time_Rel LAT_TGT1 |
] IDLE 1 1 1 1 1 8. ns

1 IDLE 1 1 1 1 1 30. ns

2 8000603C CFG RD ] 1 1 1 1 396. ns

3 WRIT 1 ] 1 1 1 30. ns

4 WRIT 1 ] ] 1 1 36. ns

5 FFO101RF DARTA 1 [} L} (] 1 30. ns 30. ns

6 IDLE 1 1 1 1 1 30. ns

7 IDLE 1 1 1 1 1 30. ns

8 IDLE 1 1 1 1 1 30. ns

9 IDLE 1 1 1 1 1 36. ns

10 IDLE 1 1 1 1 1 30. ns

11 IDLE 1 1 1 1 1 36. ns

12 00000000 INTACK (] 1 1 1 1 30. ns

13 WRIT 1 L] 1 1 1 30. ns

14 WRIT 1 [} 1 1 1 30. ns

15 WRIT 1 0 1 1 1 30. ns

16 HMABORT 1 ] 1 1 1 36. ns

17 IDLE 1 1 1 1 1 30. ns

18 IDLE 1 1 1 1 1 36. ns

19 IDLE 1 1 1 1 1 30. ns

20 IDLE 1 1 1 1 1 30. ns

21 IDLE 1 1 1 1 1 30. ns

22 IDLE 1 1 1 1 1 30. ns

< | A

Figure 136 Text File Display
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Convert to Excel™

New

Open... Ctrl+0
Close

Save... Ctil+S
Printer Setup...

Print... Ctrl+P
Print Preyiew

Exit

You may convert an output (*.smp) file to an Excel (*.xls) spreadsheet for later

off-line analysis.

»

then select Save As.

Select Sample File 2| x|

To create an Excel™ for a displayed data file. Click File on the menu bar and

Save in: l 23 Compliance

R N=IN6] Nad ) =l

File name: |transactinn

Save I

Save as type: [worksheet Files [*.xls) | Cancel |

Z

Select a folder where you wish to save the Excel™ file, enter a File Name and choose
Save as type Worksheet Files (*.xls) and click Save which will begin the conversion

process.

Extract Signal values...

After a short time the Conversion Completed Successfully message will display.

TAG60

Pe
(\l‘) Conversion completed successfully.
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You may now open the file using Excel™ as shown in Figure 137 and perform any
required data manipulations.

w o =

A B c 1] E F H [ J K L M N o [J Q =l
I_‘r'd]d[i?] Data[32] CYCLE FRAME# IRDY# DEVSEL# TROY# STOP# Time_Rel LAT_TGT!LAT Mstr LAT_ARB b=
2 LE 1 1 1 1 10.ns
3 IDLE 1 1 { 1 130.ns
4 |8000003C CFG RD 0 1 1 1 139. ns
5 WAIT 1 0 1 1 130 ns 00ns
6 WAIT 1 0 0 1 130.ns
77 FFO101AF DATA 1 0 0 0 130.ns 30.ns
8 IDLE 1 1 1 1 130.ns
9 IDLE 1 1 1 1 130.ns
10 IDLE 1 1 1 1 130.ns
n IDLE 3 1 1 1 130.ns
12 IDLE 1 1 1 1 130.ns 80. ns
13 IDLE 1 1 1 1 130.ns
14 0 INTACK 0 1 1 1 130.ns
15 WAIT 1 0 1 1 130.ns 00ns
16 WAIT 1 0 1 1 130.ns
17 WAIT 1 0 1 1 130.ns
18 MABORT 1 0 1 1 130.ns
19 IDLE 1 1 1 1 130.ns
20 IDLE 1 1 1 1 130.ns
21 IDLE 1 1 1 1 1.30. n:
2 IDLE 1 1 1 1 130.ns
3 IDLE 1 1 1 1 130.ns
24 IDLE 1 1 1 1 130.ns
3
2%
27
28
)
2
3
2
33
3
»
36
Erd
38
£
0 o
4/ 41p bi\sheets / 14l -]

Figure 137 Excel™ File Display

Capture a Screen

You may perform a screen capture at any time and save it as a *.pcx graphics file for
later review or inclusion in a report.

Eird... F3
Find Newt Cul:N
Find Previous Chilel
Jump...

To perform a screen capture click Tools on the menu bar and choose Capture
Screen . . .

Muriber of Ertars.
Filter Data...

System Memory Allocation
Changs Sample Diata

Position the cursor where you would like to capture the screen and with the left mouse
button depressed drag the cursor to define the screen capture area. Release the mouse
button to open the Save As dialog.
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Assign a file name to the screen capture to be saved and click OK.

Save As H
Save jn: I 4 UserDir j QI
AnalyzerExerciser
Compliance
Ltility

E] wave_display-01.pcx

File hame: |wave_display-021 Save I
Save as type: IEapture Screen to PCX file[*. pox) L‘ Cancel

The capture progress bar will display, and when complete, you may open the *.pcx file
for viewing using a graphics program or import it in a word processing program such
as Word™ as an illustration.

Make PCX File...
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Tools to Analyze Captured Data

Compare

Compare permits you to perform a comparison of two output files to generate a screen
display of the differences found. This feature may be particularly useful to compare an
output file of a known working product to that of a malfunctioning product.

Find... F3
Find Nexst kN
Find Previous Cul+l

dump...

To compare two files select Compare from the Tools menu to open the compare
o output files dialog box shown in Figure 138.

Number of Enors.
Filer Data..

System Memory Alacation
Changs Sample Data

Compare files

[~ Selected File:
First File

SGEEIE  Browse... From |”
Bowss. |

Second File |c:‘program files\catalyst\tabB0_release_4\dat  Browse... From |0
~CompareSize Output File
I~ Save result into the file Load Result
& Entire File goc hesu
" Partial File GutputFile |empiptictn
No. of samples lu—

0K I Cancel | Help |

Figure 138 Compare Output Files Dialog Box
1. Select the comparison files by browsing the first and second file list boxes.

2. Choose the sample at which you would like the comparison to start by entering
the start sample number in the From edit box, (the default value is 1).

3. Click either, the Entire File or Partial File radio buttons to select the entire file
or a partial file to be compared. Checking Partial File requires you to specify
the number of samples to be compared.

4. Click OK.

Compare Equal If the contents of the two files match the Two files are equal dialog box
will display
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TA700

(,.-"’"! 5 Two files are equal.

Compare Different If the two files are not identical then the Compare Results window as
shown in Figure 139 will open displaying the differences between the two
files.

cmprpt.crp \ !EE I
Sampleft Differences
B: AD, C/BE, FRAMEH, ﬂ
%3 AD, C/BE, IRDY#H,
8: AD, C/BE, PAR, IRDY#, DEVSEL#,
53 AD, C/BE, PAR, IRDY#, DEVSELH,
10: AD, C/BE, PAR, IRDY#, DEVSEL#,
ik AD, C/BE, PAR, IRDY#, DEVSELH,
12: AD, C/BE, PAR, IRDY#, DEVSELH,
il AD, C/BE, PAR, IRDY#, TRDY, DEVSEL#H,
14: AD, C/BE, PAR,
15: AD, C/BE, PAR,
il AD, C/BE, FRAME#,
22 AD, C/BE, PAR, IRDY#, IDSEL,
33 AD, C/BE, PAR, IRDY#, DEVSEL#H, IDSEL,
34: AD, C/BE, PAR, IRDY#, DEVSEL#, IDSEL,
853 AD, C/BE, PAR, IRDY#, DEVSEL#, IDSEL,
36: AD, C/BE, PAR, IRDY#, DEVSEL#, IDSEL, j

Figure 139 Compare Differences Display

Different File Sizes If you are comparing two files with the Entire File option checked and
the two files are of unequal length, you will get the following warning.

TA700

Number of samples in the two files are not equal.
‘You can not use entire files option.

Click OK and repeat the action with the Partial File option checked.
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Filtering Captured Data

Filtering feature permits you to modify an existing *.smp data files to include or
exclude a set of user defined patterns. This modification is saved into a new file.

To perform filtering you must first define the patterns that you wish to use for
filtering. The patterns are defined as mnemonics.

For a complete discussion of other applications of Mnemonics, see “Mnemonics” on
page 164.

To define a mnemonic for filtering, click on the Mnemonics icon on the menu
bar or select Mnemonics from the Configuration dropdown list on the menu
bar.

To define a mnemonic for filtering, double click a NAME# to open an Event name
dialog box. Select and enter a unique name (e.g. YOUR_NAME) for the search
pattern that you wish to define. Complete the filter parameter definition by clicking on
the appropriate parameters for that name to open the corresponding dialog box and
entering the desired settings.

User Defined Mnemonics

Name |XFER AD[]

P| CBE[] |I|F(I(D|T|S|L|R/G [INTX|E [R|3. EKTiI
A D|IR(R|E|R(T|O R |S| 3 | EBRN
R S(AD|V|D(O(C R|T|V
E|M(Y|S|Y(P|K # a | SIG
L|E(#E|#|# # u | NAL
# L %
#
YOUR_NM: A32 KOO X KK KF XXX XK R XK KX X X XK
NAME?2 e ROOOOOOOOOOCOONK XX | XOOOOOE K X X (K X X X XK 0K XX X X 00K
NAME3 KK ROOOOOK K XXX XXX KKK KKK KK KK KKK
NAME 4 XX HOOOOOOK K X XK K X X KK OO XX X X 0K
NAMES KK ROOOOOK K XXX XXX XK XK KK XK KKK
NAMEG XK IOOOOOOK K X XK X X X 0K 3O XX X X 0K
NAME?Z KK ROOOOOK X XXX XXX KKK XK K X K KKK
NAMES XX IOOOOOOK K X XK X X X XOOK 3O XX X X 300K
NAMES — KR OOOCOOR KKK KK KK KK KA KKK DK
NAME1D - 3COOOOOOOOOOO0OM, XK XOOOOOK X X X (X X X X 300K XOK KX X ¥ XK
NAME11 i s et A i a4
KIS ;I_I

oK | Cancel | save | Load | Hep |

Figure 140 Mnemonics Setup for Filtering
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Eind...

Find Next
Find Pravious
Jump. .

Compare...
Caplure Scieen...

Humbe of Errois..

Ctrlshl
Cirsl.

To filter a previously sampled data file click Tools on the menu bar and then
select Filter Data . . . to open the Filter Data dialog box as shown in Figure 141.

System Memory Allacation
Change Sample Data

Filter Data [x]

Source File : li:\calalyst\pledalinad\simulatiun\analyzm_x smp Browse...

Output File : I\:'\calalyst\pledelinEd\simulat\on\namtE.smp Browse...
r— Filter Signals
Patterns Selected Patterns
NAMES
Add >
Bemave
Filter Type
( & Include Signals " Exclude Signals

0K I Cancel | Help | Goto Mnemonics |

Figure 141 Filter Data Dialog Box
To configure the filter:
1. Select the Source file to be filtered and an Output File which is the destination
file for the filtered results.

2. Select the desired Filter signal mnemonics one at a time from the Patterns list
and click Add-> to include them in the Selected Patterns List.

3. Determine the filter type by checking the Include or Exclude Signals button to
define if the patterns are to be included or excluded from filtering.

4. Click Ok
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After a short time the Filter Data complete dialog box opens.

Filter Data
i The file c:\program files' lyst\taBB0_release_4'\data\si :_specaddOut.smp was created.
‘Would you like to view it now?
No

Figure 142 Filter Data Complete Dialog Box

Click Yes to view the filtered file or No to view it later. You may view and search the
filtered file as any other data file.

Filtering Example Figure 143 shows an example of results of filtering with a Mnemonic.
The active window in the display shows filter results where only memory
transactions were selected for inclusion.

2 =101

copsem | ] o o B | |l ] e G

Add[32] Data[32] CYCLE FRAME# IRDYv# DI Add[32] Data[32] CYCLE FRAME# IRDY# DI |

4 IDLE 1 1 1 J o &L AL i} 1 1 4
3 1 1 1 =I5 00000021 140w a 1 1
2 1 1 1 2 Qoo00o20 1/0'WR o 1 1
1 00000000 INTACK o 1 1 3 00000021 140w o 1 1
0 e 50 DAL, 1 0 il 4 00000043 1/0WR 0 1 1
1 IDLE 1 1 1 ) 00000040 170 RD o 1 1
2 00000021 140 WR o 1 1 B 00000040 I¥0RD a 1 1
3 B DATA 1 o a 7 00000043 1/0'WR o 1 1
4 IDLE 1 1 1 8 00000040 140 RD 0 1 1
5 00000020 140 Wh a 1 1 El 00000040 I¥0RD a 1 1
3 =60 DATA 1 n 1] 10 00000043 140 WR o 1 1
7 IDLE 1 1 1 " 00000040 I¥0RD a 1 1
8 00000021 1/0'Wh a 1 1 12 00000040 1¥0RD o 1 1
9 RS- DATA 1 o o 13 00000043 140w a 1 1
10 IDLE 1 1 1 14 00000040 I¥0RD a 1 1
1 00000043 1/0WhR o 1 1 s 00000040 170 RD o 1 1
12 LI DATA 1 o o 16 00000043 1/0'WR a 1 1
13 IDLE 1 1 1 17 00000040 170 RD o 1 1
14 00000040 /0 RD o 1 1 18 00000040 I¥0RD a 1 1
15 e DATA 1 o a 19 00000043 1/0'WR o 1 1
16 IDLE 1 1 1 0 00000040 170 RD o 1 1

17 | 00000040 140 RD a 1 1=]2 00000040 10 RD a 1 1=

Figure 143 Filter Results Display
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Special Setups

Protocol Errors

Protocol Error

The TA700/800 monitors over 50 different protocol errors and detects all of them
automatically every time a data capture is made. The detected errors are displayed in
red on the output display provided, that the ERROR signal has been selected for
display using the Active Signals dialog box. To include the protocol errors on the
display click the Setup Screen button and then make sure that ERROR has been
included in the Active Signal list.

A predefined trigger selection for Protocol Error is included as one of the
trigger choices in the Data Capture & Trigger On menu in the Easy
Mode. For Advanced mode the Protocol Error is also listed as an input of
each sequencer state to cause the conditional jump or triggering selection
as well. You may use the Protocol Error selection in the easy mode to
trigger on protocol errors without any special setup required.

To limit the number of errors that can cause a trigger you may mask out the unwanted
protocol errors.

To mask undesired protocol errors click the Protocol Errors icon on the menu
bar to open the Set Protocol Errors dialog box.

Protocol Errors Mask EHE

W ERRD - FRAME # must be de-asseited as soon as IRDY#H can be asserted from the time STOPH was asserted. PCl Rev &
WIERR1 - Back-to-Back timing was used in a transaction in which was not proceeded by a wirte transaction form the same

v ERR2 - FRAMEH is not asserted within 16 clocks from the time GNT# was asserted. PCl Rev 2.2-3.4.1.

(W ERR3 - FRAME # was asserted before the bus was granted(before GNTH was asserted).PCI Rev 2.2 -3.4.1.

(VIERR4 - IRDYH was not asserted a cycle immediately after FRAME # was deasserted, PCI Rev 2.2 - 3.3.1.

VIERRS - Improper teimination .Either IRDYH, TRDYH, or STOPH# were not deasserted after FRAME# was deassented PC
(VIERRE - IRDYH was asseited on the same clock edge that FRAME# was asserted .PCl Rev 2.2-3.3.1.

VIERRY - IRDY#H was asserted when FRAME# was high.PCl Rev 2.2 - Appnedix C,Rule 7.

W ERRS - After IRDYH was asserted, IRDY# or FRAME# were changed before the cunent data phase was completed or F

[ 1ERRY - IRDY# was asserted during the second addiess phase of a Dual Address Cycle. PCI Rev 2.2- 39
vIERR10 - PERRE was asserted during special cycle. PCl Rev 2.2 -3.7.4.1.

VIERR11 - PERR# was asserted duing address cycle. PCl Rev 2.2, - 3.7.4.2.

[JERR12 - PAR does not mat rity 2 D[31:0] and CBE[3:0]

o

‘l_. 3

Mote : Error is masked as a trigger when unchecked.
MaskALL | UnmaskALL | Mask 64 BitSig. |

ok | Cancel |

Figure 144 Protocol Errors Mask Enable

Uncheck the protocol Errors that you wish to exclude from causing a trigger and click
OK. See Table 3. for a description of protocol errors.
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Table 3. PCI Protocol Errors (0-51)

Err#

Description

ERRO

FRAME# must be de-asserted as soon as IRDY# can be asserted from the time STOP# was asserted PCI Rev 2.2-
3.3.3.2.1.Rule 5

ERR1

Back-to-Back timing was used in a transaction in which was not proceeded by a write transaction form the same master.
PCIRev2.2-342

ERR2

FRAME# is not asserted within 16 clocks from the time GNT# was asserted. PCI Rev 2.2 - 3.4.1

ERR3

FRAMEH# was asserted before the bus was granted(before GNT# was asserted).PCI Rev 2.2 -3.4.1

ERR4

IRDY# was not asserted a cycle immediately after FRAME# was deasserted. PCI Rev 2.2 - 3.3.1

ERRS

Improper termination .Either IRDY#, TRDY#, or STOP# were not deasserted after FRAME# was deasserted.PCI Rev
22-33.1

ERR6

IRDY# was asserted on the same clock edge that FRAME# was asserted .PCI Rev 2.2 - 3.3.1

ERR?7

IRDY# was asserted when FRAME# was high.PCI Rev 2.2 - Appendix C,Rule 7

ERRS

After IRDY# was asserted, IRDY# or FRAME# were changed before the current data phase was completed or
FRAMEH# reasserted during the same transaction. PCI Rev 2.2 - Appendix C, Rules 8 b and 8 d

ERR9

(*Not implemented*)"IRDY# was asserted during the second address phase of a Dual Address Cycle. PCI Rev 2.2 -
3.9"

ERR10

PERR# was asserted during special cycle. PCI Rev 2.2. - 3.7.4.1

ERR11

PERR# was asserted during address cycle. PCI Rev 2.2. - 3.7.4.2

ERR12

(*Not implemented*) PAR does not match parity across AD[31:0] and CBE[3:0] PCI Rev 2.2 - 3.7.1

ERR13

(*Not implemented*) PAR64 does not match parity across AD[63:32] and CBE[7:4] Rev 2.2 - 3.8

ERR14

(*Not implemented*) Data parity error was detected on AD[31..0], but PERR# was not asserted. PCI Rev 2.2 -
Appendix C. Rule 32.b

ERR15

(*Not implemented*) Data parity error was detected on AD[63..32], but PERR# was not asserted. PCI Rev 2.2 -
Appendix C, Rule 37 ¢

ERRI16

"DEVSEL# was removed while transaction was not completed yet. PCI Rev 2.2 - 3.3

ERR17

Target has responded to a reserved command by asserting DEVSEL#. PCI Rev 2.2 - 3.1.1

ERR18

DEVSEL# was asserted during special cycle. PCI Rev 2.2. - 3.6.2

ERR19

DEVSEL# was asserted before FRAME# was asserted. PCI Rev 2.2. -3.3.1 and 3.3.2

ERR20

Target does not allow for turnaround time. TRDY# must not go low at the first clock after assertion of FRAME# in a
read transaction. PCI Rev 2.2 - 3.3.1. & 3.3.2.

ERR21

TRDY# was asserted before DEVSEL# was asserted. PCI Rev 2.2 - Appendix C, Rule 14

ERR22

DEVSEL#, TRDY# or STOP# were changed before the current data phase was completed, after TRDY# was asserted.
PCIRev 2.2 - Appendix C, Rule 12 d

ERR23

TRDY# asserted while target is requesting abort. PCI Rev 2.1. - 3.3.3.2.1.
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Table 3. PCI Protocol Errors (0-51)

Err#

Description

ERR24

Improper termination by Target. STOP# was asserted and de-asserted while FRAME# was still asserted. PCI Rev 2.2. -
3.3.2.1.Rule 4

ERR25

STOP# was asserted before DEVSEL# was asserted. Appendix C, Rule 14

ERR26

DEVSEL#, TRDY# or STOP# were changed before the current data phase was completed, after STOP# was asserted.
PCIRev 2.2 - Appendix C, Rule 12 d

ERR27

Improper Back-to-Back transaction. Either DEVSEL#, TRDY#, or STOP# were not delayed and were asserted on the
first cycle of the Back-to-Back transaction. PCI Rev 2.2. - 3.4.2.

ERR28

The first transaction on the LOCK# was not a read transaction. PCI Rev 2.2. - Appendix F, F.1, Rule 2

ERR29

LOCK# was not released when Retry was requested by the Target. PCI Rev 2.2. - Appendix F, F.1, Rule 4

ERR30

LOCKH# was not released after target abort. PCI Rev 2.2 - Appendix F, F.1, Rule 5

ERR31

LOCKH# was not asserted the clock following the address phase or was not kept asserted throughout the transaction. PCI
Rev 2.2 - Appendix F, F.1, Rule 3

ERR32

REQO64+# was not asserted during the same time as FRAME#. PCI Rev 2.2 - 3.8

ERR33

ACKO64# was not asserted during the same time as DEVSEL#. PCI Rev 2.2 - 3.8

ERR34

REQO64# was asserted during a non-memory transaction. PCI Rev 2.2 - 3.8

ERR35

ACKO64+# was asserted before REQ64# was asserted. PCI Rev 2.2 - 3.8

ERR36

TRDY# is not asserted within 8 clocks on the data phase of the burst transfer. ERR36 applies only to second or
subsequent transfers, first transfer which is 16 clocks is covered by ERR37. PCI Rev 2.2 - 3.5.4.1

ERR37

TRDY# or STOP# not asserted within 16 clocks on the first data phase of the burst transfer. PCI Rev 2.2 - 3.5.4.1

ERR38

IRDY# was not asserted within 8 clocks from the time FRAME# was asserted. PCI Rev 2.2 - 3.5.4.1

ERR39

Master did not abort within 6 clocks from the time FRAME# was asserted while DEVSEL# was never asserted. PCI
Rev22-354.1

ERR40

DEVSEL# asserted after 5 clocks from the time FRAME# was asserted. PCI Rev 2.2 - 3.5.4.1

ERR41

REQ# was not deasserted for a minimum of 2 clocks after a Retry and or a Disconnect by the Target. PCI Rev 2.2 -
Appendix C, Rule 10

ERR42

Target has not recognized configuration cycle type 00 or 01 and has asserted DEVSEL#. PCI Rev 2.2 -3.2.2.3

ERR43

The 10 byte address (ADO, AD1) given at the start of cycle does not match the CBE, byte enable. PCI Rev 2.2. - 3.2.2.1

ERR44

Memory Write and Invalidate Command were not implemented in Linear Incrementing Burst Mode. PCI Rev 2.2. -
3222

ERR45

Target did not disconnect after the first phase of Reserved Burst Ordering in memory commands. PCI Rev 2.2 - 3.2.2.2

ERR46

Master abort was done prior to 4 clocks from the address phase. PCI Rev 2.2 - 3.3.3.1 and 3.9

ERR47

Reserved command was performed. PCI Rev 2.2 - 3.1.1

ERR48

A second DAC was performed immediately following a DAC. PCI Rev 2.2 - 3.9
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Table 3. PCI Protocol Errors (0-51)

Err# Description

ERR49 |Byte enables were changed before the data phase was completed, A master must keep the byte enables stable during the
complete data phase. PCI Rev 2.2 - Appendix C, Rule 3b

ERR50 |An INTx signal has been asserted and then deasserted before an Interrupt Acknowledge. PCI Rev 2.2 - 3.6.4

ERRS51 |Bus Command was not reflected on C/BE[7..4] during DAC transaction. PCI Rev 2.2 - 3.9
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PCI-X Protocol Errors

Table 4. PCI-X Protocol Errors (0-58)

Err. # Description

ERRO |Burst transactions are only allowed for memory transactions or Split Completion. PCI-X Rev 1.0 -1.5

ERR1 |The starting address of Configuration Read and Configuration Write transactions must be aligned to a DWORD
boundary. PCI-X Rev 1.0 -1.10.1

ERR2 |[The C/BE bus is reserved and must be driven high the clock after the attribute phase. PCI-X Rev 1.0 -1.10.1

ERR3 |The initiator must assert FRAME six clocks after GNT is asserted and the bus is idle on a configuration
transaction. PCI-X Rev 1.0 -1.10.2

ERR4 |[IRDY must be asserted two clocks after attribute phase. PCI-X Rev 1.0 -1.10.2

ERR5 |(*Not implemented*) For write and split completion initiator must toggle between first and last data in starting
wait states

ERRG6 |Fast back-to-back transactions are not permitted. PCI-X Rev 1.0 -1.10.4

ERR7 |(*Not implemented*) Initiator should driver address four clock before asserting frame in configuration
transactions

ERRS8 |PERR can not be asserted during attribute phase. PCI-X Rev 1.0 -1.10.6

ERR9 |For I/O and memory DWORD transactions, ADO and AD1 must match the byte enable. PCI-X Rev 1.0 -2.3

ERRI10 |In attribute phase reserved bits must be zero. PCI-X Rev 1.0 -2.5

ERRI11 |Initiators must not generate reserved commands. PCI-X Rev 1.0 -2.6

ERRI12 |After the attribute phase and during the data phase(s) of a transaction, the C/BE bus is reserved and must be driven
high by the initiator for all transactions except Memory Write. PCI-X Rev 1.0 -2.6

ERRI13 |[DEVSEL can not be asserted 1, 5 or more than 6 clocks after address phase. PCI-X Rev 1.0 -2.8

ERR14 |If the completer sets the Split Completion Error (SCE) bit in attribute phase, it must set also the Split Completion
Message (SCM) bit to indicate the Split Completion has message. PCI-X Rev 1.0 -2.10.4

ERRI15 |(*Not implemented*) If the transaction is a Split Completion Messages, the Lower Address field in the Split
Completion address must be set to zero, and the Byte Count field in the Completer Attributes must be set to four.
PCI-X Rev 1.0 -2.10.6

ERR16 |(*Not implemented*) Delayed transactions not allowed.

ERR17 |Memory write and Split Completion can not be completed as Split Transaction. PCI-X Rev 1.0 -1.7

ERR18 |Initiator can not signal Master Abort before § clocks after assertion of FRAME. PCI-X Rev 1.0 -1.10.2

ERR19 |The initiator must terminate the transaction when the byte count is satisfied. PCI-X Rev 1.0 -1.10.2,

ERR20 |The initiator is permitted to disconnect a burst transaction (before the byte count is satisfied) only on an ADB.
PCI-X Rev 1.0-1.10.2
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Table 4. PCI-X Protocol Errors (0-58)

Err. #

Description

ERR21

The target must deasserts TRDY, STOP and DEVSEL on the first clock after the last data phase. PCI-X Rev 1.0 -
1.10.3

ERR22

If the target signals Split Response, Target-Abort, or Retry, the target must do so within 8 clocks of the assertion of
FRAME. PCI-X Rev 1.0 -1.10.3

ERR23

If the target signals Single Data Phase Disconnect, Data Transfer, or Disconnect at Next ADB, the target must do
so within 16 clocks of the assertion of FRAME. PCI-X Rev 1.0 -1.10.3

ERR24

Once the target has signaled Disconnect at Next ADB, it must continue to do so until the end of the transaction or
must signal Target Abort. PCI-X Rev 1.0 -1.10.3

ERR25

The requester must terminate a Split Completion with Data Transfer or Target-Abort (except PCI-X bridge that is
forwarding a Split Completion from one PCI bus to another). PCI-X Rev 1.0 -1.10.8

ERR26

TRDY must be asserted more than one clock after the attribute phase. PCI-X Rev 1.0 -2.8

ERR27

If a transaction has four or more data phases, the initiator signals the end of the transaction by deasserting FRAME
one clock before the last data phase. PCI-X Rev 1.0 -2.11.1.1

ERR28

The initiator must deassert FRAME at least two clocks after the target asserts TRDY. PCI-X Rev 1.0 -2.11.1.1

ERR29

The initiator must deassert IRDY one clock after the last data phase but never less than two clocks after the first
data phase. PCI-X Rev 1.0 -2.11.1.1

ERR30

Not a valid termination with respect to IRDY, FRAME. PCI-X Rev 1.0 -2.11.1.1

ERR31

(*Not implemented*) If the target signals Disconnect at Next ADB less than four data phases from an ADB the
transaction must cross that ADB and disconnects on the next one. PCI-X Rev 1.0 -2.11.2.2

ERR32

Single Data Phase Disconnect, Retry or Split Response must be signaled in the first data phase. PCI-X Rev 1.0 -
2.11.2

ERR33

Master can not insert wait states. PCI-X Rev 1.0 -1.6

ERR34

Target can not insert wait states after first data phase. PCI-X Rev 1.0 -1.6

ERR35

Target initial wait states for memory write and Split Completion transactions must come in pairs. PCI-X Rev 1.0 -
1.6

ERR36

REQ64 can be asserted only for memory transactions (except Memory Read DWORD) or Split Completion. PCI-
X Rev 1.0-1.10.1

ERR37

(*Not implemented*) Dual transactions should not be used for addresses less that 4GB

ERR38

(*Not implemented *) Dual address & split

ERR39

The first transaction on the LOCK# was not a read transaction. PCI-X Rev 1.0 - 8.5.1

ERR40

LOCK# was not released when Retry was requested by the Target. PCI-X Rev 1.0 - 8.5.1

ERR41

LOCKH# was not released after target abort. PCI-X Rev 1.0 - 8.5.1

ERR42

LOCK# was not asserted the clock following the address phase or was not kept asserted throughout the
transaction. PCI-X Rev 1.0 - 8.5.1

ERR43

Target has not recognized configuration cycle type 00 or 01 and has asserted DEVSEL#. PCI-X Rev 1.0 - 1.10.5
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Table 4. PCI-X Protocol Errors (0-58)

Err. # Description

ERR44 | Target has responded to a reserved command by asserting DEVSEL#. PCI-X Rev 1.0 - 2.4

ERR45 |DEVSEL# was asserted during special cycle. PCI-X Rev 1.0 - 2.7.3

ERR46 |FRAME# was asserted before the bus was granted (before GNT# was asserted). PCI-X Rev 1.0 - 1.10.2

ERR47 |(*Overlapped Error*) IRDY# was asserted during the second address phase of a Dual Address Cycle. PCI-X Rev
1.0-2.12.1

ERR48 |Reserved command was performed. PCI-X Rev 1.0 - 2.4

ERR49 |PERR# was asserted during special cycle. PCI-X Rev 1.0 - 1.10.6

ERR50 |[PERR# was asserted during address cycle. PCI-X Rev 1.0 - 5

ERRS51 [PAR does not match parity across AD[31:0] and CBE[3:0] PCI-X Rev 1.0 - 5.3

ERRS52 [PAR64 does not match parity across AD[63:32] and CBE[7:4] PCI-X Rev 1.0 - 5.3

ERR53 | Data parity error was detected on AD[31..0], but PERR# was not asserted. PCI-X Rev 1.0 - 1.10.6

ERRS54 |Data parity error was detected on AD[63..32], but PERR# was not asserted. PCI-X Rev 1.0 - 1.10.6

ERRS5 |REQ64# was not asserted during the same time as FRAME#. PCI-X Rev 1.0 - 2.12.3

ERR56 |ACKG64# was not asserted during the same time as DEVSEL#. PCI-X Rev 1.0 1.12.3

ERR57 |ACK64# was asserted before REQ64# was asserted. PCI-X Rev 1.0 - 2.12.3

ERRS58 |Bus Command was not reflected on C/BE[7..4] during DAC transaction. PCI-X Rev 1.0 - 2.12.1
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Number of Errors

Eind..
Find Next
Find Previous

Jump...

Compare...

Convert to Text...
ConverttoXLS...
Capture Sereen...

F3
Ctrl+N
CtilsL

Cikn)

Ctil+F5.
ClieFE.
Cul+F7
Cl+F8.

Detected errors are displayed as an ERROR signal name in red in the display window
if the signal ERROR has been selected for display on the screen.

System Memory Allocation

(

To determine the total number of errors encountered in the entire captured data
file click Tools on the analyzer menu bar and then select Number of Errors to
open the number of errors display box as shown in Figure 145.
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Figure 145 Number of Errors Display
Protocol Error Type

To view the type of the detected protocol error in either a list or wave display you
must make sure that the ERROR signal has been added to the display. Figure 146
illustrates a typical protocol error wave display with the ERROR signal added. The
error appears as a red number on the error signal line where it occurred in synch with
the rest of the PCI bus signals. To determine the protocol error type triggered on,
double click on the red NUMBER to open the detected protocol error message shown
in Figure 147.
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The check mark(s) next to the error(s) indicate(s) the type of the error(s) and
description of the error according to PCI specifications.
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Figure 146 Protocol Error Wave Display
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Figure 147 Detected Protocol Error Message
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Mnemonics

Mnemonics is a convenient debugging tool that assigns pre-defined names to
matching patterns. The Pre-defined names may be:

1.

Included in the captured data display screen next to the matching patterns for

quick identification.

Used in the search menu to specify and find a desired pattern.

Used in Filter Data menu to include or exclude data from a previously generated

data file.

Defined for complex patterns such as data that occurs only after a specific

address.

You may define up to 100 individual patterns to use in the data output display, search
menu and Filter Data menu.

You may create several files each intended for a specific application.

M H

To define mnemonics, click on the Mnemonics icon on the menu bar.

NAME3
NAME4
NAMES

KIS

Name |XFER AD[] P| CBE[] |1|F[1[D[T[S[L[RZG [INTX[E [R EXT [«
A D(R|R|E(R|T|O S ERN
R s|Alp|v|p|o|c R|T
E|M[Y|S|¥|P|K # SIG
L|E|#|E|#|#|# NAL
# L
YOUR_NM_A32 WO KX X X 200K
NAME2 | - WO XK K| X 300K

NAMES 000K KX X X 3000¢
NAME7 ok | Camcel | KRR KK K| R XK
NAMES | - 000K KX X X 3000¢
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HUAKXXUXXAXXX| xcocw

Cancel | Save I Load | Help

Figure 148 Mnemonics Definition Dialog Box

To define a mnemonic, double click a NAME# to open an Event name dialog box
select and enter a unique name for the pattern. To define a complex address/data
pattern click on the XFER field and select the MX32 or MX64 mode.

Not a Measurement

While similar in appearance and action to the Event file, the mnemonics
definition is only an assignment of names to matching patterns used to
search and highlight an already collected data and is not used to perform

any measurements.
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Displaying Patterns Matching Mnemonics

Figure 148 illustrates a simple mnemonic file named YOUR NM that is to be used to
highlight a matching pattern in collected data.

To view a pattern with this mnemonic you must add it to the displayed signals list. To
add the mnemonic:

Click the Setup Screen on either the wave or list data display to open the Active
Signals Dialog Box.

Active Signals
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Remaining Signals Active Signal I Shol
et — & Show Differences in Clock Stoa i Lnes

¥ Shaw Sianal Values
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Red [0 il »

|
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ok | Carcel | SetColr | Dicfaul Color e |

Figure 149 Add Mnemonic to Display

Select MNEMONICS from the Group drop down list, select the mnemonic to be
added and click Add-> and then OK to complete the operation.

Figure 150 illustrates the search result with a mnemonic.

Zoom BRI Vel POl
SetupScieen | Booknaiks | 4| X [v] + [wn|Em oy |« | »RE oG [Z6

Signal Name | Value (09 | 5 2 3 2 /! 0 A 2

Clock i i R‘i ? m

Time Gap |

Add[32] 00000021
Data[32]
CYCLE IDLE IDLE 170 WR [WAIT WAIT WAIT I
FRAME#
IRDY#

1
1
DEVSEL# 1
1
1

TRDY#

STOP#
Time_Rel 30.ns 30.ns 30.ns 30.ns 30.ns 30.ns 30.ns 30.ns 30.ns
LAT_TGT1 —_—
LAT_Mstr 0.0ns

LAT_ARB

IMnemonics YOUR_NM

Figure 150 Searching a Display With a Mnemonic
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External Signals

External Input Signals

Your analyzer accepts 16 external signals that may be used in performing Performance
analysis and event recognition. These signals are accessed via an External cable,
provided with the analyzer and they are captured to memory in synch with PCI
signals.The signals are named XX00 to XX15 by default. They may be renamed in the
External Signals Dialog Box by the user.

Warning: External signal inputs level is 5V compliant, exceeding this level may damage the
board. Additionally the signals must be valid for at least 2 clock cycles.

Fully enabled on TA700 and TA800A, only signal XX00 is enabled on TA800 Rev.

Vokoge Chrck. Choose External Signal Names from the Configuration list on the main analyzer
Host Bus. . .
" semtwes | menu bar to open the External Signal Names dialog.
Color Settings...
Software Setfings...
Authorization

System Feature Status
Configuration Space Infarmation

00 [Tl %08 [<<08
3201 ; %09 [<X09
w02 [HX02 $x<10; <10
3103 [<H03 $X11: 1
K04 <404 35612 [X12
K05 [<X05 ®X13: PX13
XX06: |08 Wxi4: 14
w07 [xo7 %415 x5
oK | Cancel | Hep |

The wires in the cable carrying these signals follow the resistor color code convention
as defined in the following tables.
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Table 5. External Signal Color Code Assignment TA700 (PCI, PCI-X, PDC*)

Signal Name Color

1 XX00 Brown
2 XXO01 Red

3 XX02 Orange
4 XX03 Yellow
5 XX04 Green
6 XX05 Blue

7 XX06 Violet
8 XX07 Gray

9 XX08 White
10 XX09 Black
11 XX10 Brown
12 XX11 Red

13 XX12 Orange
14 XX13 Yellow
15 XX14 Green
16 XX15 Blue

17 * GND Violet
18 * GND Gray
19 * GND White
20 * Key Black
21 * Ext OO0 Brown
22 % Ext O1 Red

23 * Ext 02 Orange
24 * Ext O3 Yellow

* For PDC pin assignments see “External Signals” on page 241.
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Table 6. External Signal Color Code Assignment TA800 (PCI, PCI-X)

Signal Name Color

1 XX00 Brown
2 GND Red

3 - Orange
4 - Yellow
5 GND Green
6 - Blue

7 - Magenta
8 GND Gray

9 - White
10 - Black
11 GND Brown
12 - Red

13 - Orange
14 GND Yellow
15 - Green
16 - Blue

17 GND Magenta
18 - Gray
19 - White
20 GND Black
21 - Brown
22 - Red

23 KEY Orange
24 - Yellow
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Table 7. External Signal Color Code Assignment TA850 (PCI, PCI-X)

Signal Name Color

1 XX00 Brown
2 GND Red

3 XXO01 Orange
4 XX02 Yellow
5 GND Green
6 XX05 Blue

7 XX07 Magenta
8 GND Gray

9 XX05 White
10 XX06 Black
11 GND Brown
12 XX07 Red

13 XXO08 Orange
14 GND Yellow
15 XX09 Green
16 XX10 Blue

17 GND Magenta
18 XX11 Gray
19 XX12 White
20 GND Black
21 XX13 Brown
22 XX14 Red

23 KEY Orange
24 XX15 Yellow
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Table 8. External Signal Color Code Assignment (TA700 CPCI)

Signal Name Color
1 XX00 Brown
2 XXO01 Red

3 XX02 Orange
4 XX03 Yellow
5 XX04 Green
6 XX05 Blue

7 XX06 Violet
8 XX07 Gray

9 XX08 White
10 XX09 Black
11 XX10 Brown
12 XX11 Red
13 XX12 Orange
14 XX13 Yellow
15 XX14 Green
16 XX15 Blue
17 GND Violet
18 GND Gray
19 GND White
20 GND Black

External Output Trigger

The external output trigger is a TTL level output with a duration of 1/2 system clock
cycle. This signal is delayed by 17 clock periods from the actual trigger point. The
trigger polarity is set from the Configuration menu selectable on the main menu bar.
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Macros

TA700/800 software allows users to define a series of routines, that open files and
execute programs, as macros and assign them to a Function key.

To define a macro:

1. Click “Macro” on the main menu bar

2. Select Macro Editor to open the define new macro dialog box shown in Figure
152.

atalyst Enterprises. Inc.

Zl File Edit View Run Configuration Egxerciser Compliance Tools Window Help

52 QS| % R & D [P0 AndprerErers; Defelindeine Key. b -
Macro Editor... e
Sample Type : PCI State Analyzer Only or State Analyzer and Exer L35t DataFile F2  Ref-Tiiq)
Run Last Project F5
Setup Screen I Bookmark's | 4| X |}| + ||[||ﬂ| 22 | Bz ‘

Figure 151 Defining a Macro

Define New Macro Dialog E

" Macra Description [ will used in Menu Up to 40 ch

IMux_Test

Enter Macro Commands below Available Commands

Open
Run

_«AD0 |
Argurent

Save I Savegs..] Load | Cancel | Help

Figure 152 Defining the Macro
3. Enter a Macro description e.g. Mux_Test in the Macro Description text box.

4. Select the type of function to be performed, i.e. OPEN from the available
commands and click ADD.

5. Click in the newly added command line to highlight it and then click Argument
to locate an appropriate function *.udp file.
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Look in: l_\JAnaIyzexE:-:elclser ;I g’
] all_events.udp |#] eve_seq_x.udp

@ data_exer_adv.udp . MUX udp

@ data_exer_adv_x.udp Q timing_adv.udp
@ delay_cntr.udp

@ eve_seq.udp

@ eve_seq asych.udp

File name:  [MUX.udp Open I
Files of tupe: IUserDefined Project Files (*.udp) ﬂ Cancel |

In this example the function is to OPEN a frequently tested file called MUX.udp.
Several functions such as OPEN and RUN may be intermixed and selected in a macro
function.

6. Highlight the desired file and click Open to display the completed Macro
definition.

Define New Macro Dialog E2

Macro Description [ will used in Menu Up to 40 characters)
IMux_Test
Enter Macro Commands below Available Commands
Function | Argument |
Open | \catalysthuserdi\analyzerexercise... Run
<-ADD
Argument
Remove
Remaove All
Save | Load | Cancel | Help |

Figure 153 Completed Macro Definition

7. To save the newly created Macro click Save As to open the Save As dialog.
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Savens T g
Save in: IJAnalyzerExercisel LI gl

File name:  [Musx_tes] Save I
Save as lype: IMac«o Files [*MAC) L‘ Cancel |

8. Assign a File name and click Save.

Assigning a Macro to a Function Key:
1. Click “Macro” on the main menu bar and choose the Define/Undefine Key to
open the Macro Assign Key dialog.

Macro Assign/Unasign Key [ x]
Function Keys  |F4 'l Macro File Name | _I

No Macro Assigned to this key

Agsign

Figure 154 Macro Assign Key Dialog

2. Click the ellipses next to the Macro File Name edit box to display defined
macros.

= & s [=E

File name: IMu:-:_lestMAE Open I
Files of type:  [Macio Files [ MAC) = | Cancel |

Figure 155 Defined Macros
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3. Choose the macro for assignment to the function key and click Open.

Macro Assign/Unasign Key | %]

Function Keys [F4 *| Macro File Name |!Analyzel£ werciser\Mus_test MAC _I

No Macro Assigned to this key

Assign | Wrassiar | MacmEdilm,,,l Close | Help |

Figure 156 Assigning a Macro to a Function Key
4. Choose a function key from the Function Keys dropdown list and click Assign.
The assigned function key is now available to open the mux mode.udp project.
NOTE: Please note that before a macro is assigned to a project, the project must be defined

and saved. All project types including Performance Analysis, Statistical, Timing, etc
may be defined as part of a macro utility.
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System Administration

Multiple Users

Your system software comes with a pre-defined folder (directory) structure for storing
input and output files. All pre-defined Easy Mode input files are stored in the Data
folder.

=l ) ta700_4x
+ | ) PreDefined
=l I UserDir
() AnalyzerExerciser
) Compliance
) TempProjects
) Utility

Figure 157 TA700/800 Directory Structure

You may configure your system using the Windows File Manager or Explorer for
multiple users by creating a different User Directory (Folder) for each user to separate
user specific projects.
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Troubleshooting

Hardware Not Found

When launching your TA700/800 Analyzer, a Hardware Not Found may be
indicative of a problem with your parallel or USB port. Make sure to check your LPT
Port settings as described in “LPT Port Setting” on page 15 or, if using USB, make
sure that the USB cable is securely installed and that the USB driver has been installed
as described in “Manual USB Driver Installation” on page 6

Device Not Found

When performing a configuration registers scan some devices on the bus are not
found. Verify that the TA700/800 is not in downstream from a bridge. See page 56 for
a description of scan direction limitations.

No LEDs Lit on Powerup

If no LEDs are lit on TA700 on powerup set +3.3V Power source jumper for on board
regulator operation. See “Jumper Configuration” on page 226.

PCI-X 100 MHz Inoperative

Verify that there is no DUT in TA700 test connector. The TA700 will not operate at
100 MHz with a device in the test connector. See “Optional Auxiliary PCI connector”
on page 2 Make sure that the extender switch is OFF.

No Trigger

If after clicking Run the analyzer does not trigger for a long time.

|

Waiting for data...

Analyzer state:  Running...

Analyzer (&
stop | Abort | Trigger &

Click the Stop button in the “Waiting for data. . . ““ screen to open the data capture
display window.
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Z [X-T] (<Ref-T
«\) SelupScteenI Bookmark's |ﬂ X |}| + |00 | B Bglﬂ jom ductockse

Signal Name | Value (X) ]-1 IO

Time Gap Time Gap | Time Gap Time Gap

Add[32]

REQ# 1 |

Datal32]

A display with only two captured locations may be indicative of a BIOS that views
your card as transparent to the slot used and shuts off the clock to that slot.

To correct this condition go to your CMOS setup and check the options for “PCI clock
Enable/Disable” and disable the option.

Top Connector Live Power Rails

In cases where an external power supply is used for the TA700/800, but the power
supply is off, the host bus +12V and -12V rails on the top connector will be live. This
is a condition that happens for TA700 PCI Boards Revision C and above.

Recommendations:

1. Apply the external power prior to powering up the host bus.

2. Insert or remove your DUT from the top connector with no power applied to the
bus.
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Active Session Conflict

Two active software sessions when attached to the same parallel port will cause the
TA700/800 to operate improperly.

Recommendations:

1. Make sure that there is only one active session.

2. For applications that require two TA700/800 analyzers and two software
sessions running in the same system, you may implement that by using two
parallel ports with each session connected to its own port.

To implement this:

1. Run the first session with only one TA700/800 connected to a parallel port.
2. Disconnect the TA700/800 from the parallel port.

3. Connect the second TA700/800 to the second parallel port and start another
software session.

4. Reconnect the first TA700/800.

System Clock Shutdown

Some host systems may shut down the system clock to the TA700/800 slot if the
TA700/800 is set to be transparent to the BIOS.

Known Issues

For the most current known issues and problem resolutions visit

http://www.getcatalyst.com
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TA700/800 SPECIFICATIONS
ANALYZER

Bus Type
TA700/800 PCI/PCI-X
TA700C CPCI
TA700PDC PMC
Bus width 32 or 64 bit wide
Maximum Clock Rate Up to 100 MHz (Up to 66.66 MHz for PMC, up to 133.33 MHz for
TA800) analyzer
Up to 66.66 MHz (Up to 133.33 MHz for TA800) exerciser
Min 25 MHz (PCI, PCI-X, CPCI)

100 kHz (PMC, TA800)
External Signals

16 Input Channels Sampled in memory, may be used as trigger
inputs or as input to performance analysis. (Not
supported by TA800)

1 External Trigger Out Positive or negative TTL Level synchronized to
the sequencer first time trigger.

Memory Depth per Channel
Trace, 95 PCl signals 128K

Trace, optional 4 Meg (Not supported for TA700PDC or TA800)
External Signals 16 x 128K
Exerciser, 95 signals 128K
Protocol Errors 128K
Timing Errors 128K
Time Tag 128K

Word Recognizers 8 Event patterns.

Triggering Events Any of the 8 events, Boolean equation of the events, or trigger on timing
or protocol errors.

30 - 20 bit Counters Used as 30 event or delay counters at each state. (14 - 20 bit counters in
TAS800 used as 14 event or delay counters at each state)

32 Level Sequencer Supported at each level by Store, Set Trigger, Set Tag, Discard, If, Else If,
GoTo, Delay Time, Delay Count and Start Exerciser statements.(16 level
sequencer for TA800)
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Counter Use Count Accumulative count & reset as High Pass filter for triggering on
system crashes. Count & reset as Low Pass filter.

TIMING MEASUREMENT

Synchronous
Not Supported by PMC and TA800

Strobe Window strobe (2 edges)
Width 94 (64 bit PCI + control signals).
Resolution 100 Ps/edge
Operating Frequency 25 MHz to 67MHz
Spread 2-12 ns 33 MHz mode
2-5 ns 66 MHz mode
Glitch Detection 1.5ns
Signals Any or all PCI bus signals may be included or masked individually.
Display Red flag on the data display for each PCI signal, identified by the PCI

signal name.

Asynchronous
Not Supported by PMC and TA800

Clock 664 MHz

Width 64 bit (selectable PCI control signals + addresses for AD [0 .. 31] or
ADJ[32 .. 63])

Resolution 1.5 ns

Memory Depth 512K

TIME TAG

Counter 40 bits
Resolution TA700 10 ns to 40 ns
TA700PDC 15 ns to 1.0 ms
TA800 7.5 ns to 1.0 ms
Recording Duration Up to 5 Hours at 15 ns, up to 10 Hours at 30 ns.

Reported display Absolute time from the start, Relative to trigger point, relative to each
data sample, Latencies for Target and Master.
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PERFORMANCE ANALYSIS

Real-time, Continuous

Event Counters 8 counters, each 32 bit.

Count qualifier Every bus cycle, User defined address space or Sequencer (Based on user
defined sequence of events)

Count Modes Reset or Accumulative

Count Interval 500 us to 10 minutes

Output Results Reports

Pre-defined Bus utilization, Efficiencies, Throughput,
Latencies, DMA transfers, Idle time; I/O vs.
Memory utilization.

Custom Per user defined equations.
Measurement Reports Normalized to largest per interval or Absolute measurement.
Output Display (Real Time) Text Report, Bar Graph, Pie Chart and histogram.
Display Modes Color; 2D or 3D
Host CPU interface Real-time FIFOs

Statistical (Memory Capture)

Capture Depth User defined up to 128 K

Capture Qualifier User defined sequence of events.

Measurement types Min, Max or Average. Number of occurrences. Percentage of
occurrences.

Measurement Qualifiers User-defined address, address range or cycle type.
Report Types Graphical and Text
Measured Parameters Latency Target

Latency Master

Latency Arbiter

Efficiency

Target Efficiency

Master Efficiency

Throughput Mb/Sec

Bus Utilization

IDLE

No of Data Transfer/Address

Wait
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Int Ack

/0

I/ORD

/O WR
Memory
Mem RD
Mem WR
Configuration
CFGRD
CFG WR
MEM RM
Dual ADD
MEM RL
MEM W&l
Total No Of Data
RETRY
TABORT
DIS+DATA
DIS-DATA
MABORT
Latency, REQ# to Data
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UTILITIES

Search
Post-capture filter

Convert Captured Data

Compare Captured Data
Jump

Capture Screen

Zoom

MNEMONICS

By name, forward, backward and for consecutively re-occurring patterns.
Include or exclude use-defined patterns.

ASCII

EXCEL

PCX

User defined start and end from each file

Jump in results display relative to X and Y trigger positions from starting
position.

Capture a mouse cursor selectable screen area for saving as a *.pcx file.

Zoom display around X and Y cursors, between X and Y cursors or Zoom
around independently of cursors.

100 User Defined per file

PCI Bus

EXERCISER

May be saved for recall in a different application. Unlimited files may be
generated and saved.

Inverse decode of all PCI initiator and target termination.

Bus Width
Bus Speed

Output Voltage Swing
Link

Up to 64 Bit

25 to 66.6 MHz

1 KHz to 133.33 MHz PCI-X for TA800

1 KHz to 66.6 MHz for TA700PDC

33V

To the Analyzer, Start after defined events, Start after external trigger

Data Block generation

Data block generation of W1, WO or user patterns

8, 16, 32 or 64 bit wide

Up to 128K deep

Multiple blocks of data in to a single file

May be generated in the GUI and saved as ASCII format

May be generated in a text editor and imported to the exerciser program
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Master Mode

Read/Write to /0, MEM or configuration registers.
DMA transfers of up to 128K, real-time.

Single execution, loop up to 65535 or indefinite.

Insert user defined Wait states, unlimited, any location.
Force Interrupts, Errors, Parity Errors.

Perform special bus cycles.

Test memory blocks.

Read Modify Write memory.

Execute programs with or without GNT# from arbiter.
Several programs may be cascaded for on-the-fly execution.
Respond to Retry, Abort and Disconnect.

Perform Dual address cycle programs.

Split completion for PCI-X exerciser.

Target Mode

Termination Type Transfer data, Retry, Disconnect with or without data, Abort with or
without data.

Decode Address User defined I/O, Memory Read, Write single address or range, special
cycle etc.

DEVSEL Speed Fast (Not available in current version), Medium, Slow, Subtractive or

Below Subtractive.

Split response for PCI-X exerciser.

Local Memory

Read/Write memory 1 Meg Byte memory on board for random access read/write operation
Memory Depth IMB organized as 8 x 128 Kbyte locations.
Transactions 32/64 bit

DEVSEL Speed Assertion Slow
Initial Latency 7 wait states.

Not available for PCI-X and TA800, in current version of software.
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Voltage Check

N/A for TA700PDC
Voltages Monitored

Drop Measured

Indicator

+5V, +3.3V, +12V, +3.3Vux

+5V, +3.3V for the DUT (Not available for CPCI)

(+5V, +3.3V, +12V, +3.3V, yx, +3.3V|q for TA800)
-5%

Red/Green LED (D8, D9 for TA700, D2, D3 for TA800)

Voltage Requirement

TA700

TA700PDC
TA700C
TA800/TA850

+5V @ 10 mA for Rev. C

+3.3V @ 3 Amps and +/-12V @ 50 mA for Rev. B and earlier for
extender operation.

+3.3V @ 3 Amps and +5V @ 10 mA.
+5V @ 10 mA +3.3V @ 3 Amps
+3.3V @ 1.79 Amps for typical 133.33 MHz Analyzer operation.
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Appendix A

TA700 COMAPI Library

The TA700EngineAPI is a COM Object library that enables programmers to use most of the TA700 software
functionality in their programs. This library covers all the hardware functionality. The software has been developed for
use with applications developed under COM Supported Platforms such as Microsoft Visual C++, Borland Delphi, and
Microsoft Visual Basic. The library includes internal interfaces to detect, set device options and program TA700
hardware to execute a specified project with the desired event, sequence and program selections.

A sample file that demonstrates the use of several of the TA700 COM API features is included with this package.

Note: To use this library first you must register the following DLLs:
TA700EngineAPI.dll

Make sure to copy the most recent *.BIN files in to the working directory.

The easiest way to register these DLLs is to use the "Regsvr32.exe" program located in the Windows/System directory
Regsvr32 “<path>\TA700EngineAPIL.dII”

Where <path> is the location of the TA700API DLL

Please note the following items before using the TA700 COM API Package:

*  All samples are implemented at Microsoft Visual C++ 6.0

+  TA700 COM API Package requires the file TA700EngineAPI i.c.This file declares the
GUID’s for all Interfaces, COM Class... in the C style.

* The TA700 COM API Package requires the file TA700APIcons.h.This file declares
some of the useful constants for developing with TA700 COM API. This feature is only
enabled on C based platforms such at Visual C++.

Examples using each function are provided in the sample section on

Limitations: At this time the Com API does not support Performance Analysis and Trace Statistics.

This release support TA850 boards in addition to TA700 and TA800 boards. In addition to EPP & USB ports Ethernet
Interface has been added to the interfaces supporting by COM API with TA850 boards. For this purpose some settings
files have been added to the API Suite in the “.\System\Configuration\” folder, so it is necessary to have this folder in
parent folder of “Ta700EngineApi.dll”. Some interfaces have changed as follows:

187



Catalyst Enterprises Inc. Appendix A

New Methods

IRunProjectServer Interface
SetDevicelD()
FormatResultMessage()
SaveAsText()
DumpLocalMemory()

IChangeProjectServer Interface
GetTimingMasks()
GetTimingMasksAddress()
GetTimingMasksControl()
SetSampleNo()

GetSampleNo()
SetWorkingMode()
GetWorkingMode()
SetOutputFileName()
GetOutputFileName()
GetMasterAbortOption()
GetAssertFrameOption()
GetCompleteTransactionOption()
GetTargetDisconnectOption()

IRunProjectServer Interface
SetinterfaceMode()
SetPortNumber()

IUtilityserver Interface
SetFpgaFilesPath()
SetInterfaceMode()
SetPortNumber()
AutoDetectSystemFrequency()
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Removed/Moved Methods

IUtilityserver Interface
GetPortNumber()
ShowFeaturesStatus()
SetAuthorizationCode()

IRunProjectServer Interface

SetSampleNo() : Moved to IChangeProjectServer Interface

SetWorkingMode() : Moved to IChangeProjectServer Interface

SetProjectName() : Merged with RunTa700Project() method

SetOutputFileName() : Moved to IChangeProjectServer Interface

AutoDetectSystemFrequency(): Moved to [UtilityServer Interface

SetMasterAbortOption(): Moved to IChangeProjectServer Interface

SetAssertFrameOption(): Moved to IChangeProjectServer Interface

SetCompleteTransactionOption(): Moved to IChangeProjectServer Interface

SetTargetDisconnectOption(): Moved to IChangeProjectServer Interface

Note: Make sure to create the interfaces only by Pure COM instantiation method or Smart Pointer

method since some method IDs have changed. Automation Instantiation method is not
supported.

TA-700 Modes Supported

* PCI Analyzer only Mode

* PCI Analyzer/Exerciser Mode

* PCI Timing Mode (100psec)

*  PCI Asynchronous Timing Mode
*  PCI-X Analyzer only Mode

*  PCI-X Analyzer/Exerciser Mode

This release supports all PCI, CPCI, PMC, and PMC-DC protocols. In the EPP mode we support only the speed up mode.
It means that at this release all programming & Capturing data is speed up. Also it must be mentioned that this release has
some changes from last release 1.0, it is so important for all developers, please read below before using this release.

Support of Multithreading

The TA700 Engine API has been changed to be used as a multi threading mechanism while maintaining the supported
API functions the same as they were before. TA700 API permits developers to use it at desired multi threading
applications, meaning that the TA700 API Engine can be used to attach to multi boards, and run multi projects in the
body of several threading processes simultaneously. See the following example that is used at UserApp application:

189



Catalyst Enterprises Inc. Appendix A

Assume that it is desired to run a master exerciser program on one TA700 board, and one Target Exerciser program on
another TA700 board. These programs are named master.mtm and target.mtm. The following sequence illustrates this
process:

Two instantiated objects are created by the IRunProjectServer Interface, first TempRun, and then TempRun2

if (! SUCCEEDED (CoCreateInstance (CLSID_RunProjectServer, NULL, CLSCTX ALL,
IID IDispatch, (void**)&pDispatch)))

Return;

if (! SUCCEEDED (pDispatch-
>QueryInterface (IID IRunProjectServer, (void**) &TempRun)))

return ;
pDispatch->Release () ;

if (! SUCCEEDED (CoCreatelInstance (CLSID RunProjectServer, NULL, CLSCTX ALL,
IID IDispatch, (void**)g&pDispatch2)))

return;

if (! SUCCEEDED (pDispatch2-
>QueryInterface (IID IRunProjectServer, (void**) &TempRun2

return;
pDispatch2->Release () ;

Set all needed data for each. For example the interface type (EPP or USB), port No, FPGA path, project name
(Master.mtm related project for one of them and Target.mtm related project for another)

TempRun->SetInterfaceMode (m nProjectlPortType);
TempRun->SetPortNumber (m nProjectlPortNo) ;
TempRun->SetFpgaFilesPath (strFPGAFolderPath) ;

Call the runTA700Project method of TempRun while the new thread is started which uses the TempRun2 as the
connecting interface to RUNProjectServer COM server.

AfxBeginThread (ProgramControlThread, &pData, 0, THREAD PRIORITY NORMAL) ;
TempRun->RunTA700Project (strProjectName)

Note: “ProgramControlThread” is the function pointer for a similar process for embedded thread
function.
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Library Exported Interfaces

IRunProjectServer

This interface allows the developer to run a predefined TA700 project. The developer must define the following data
fields:

e Path of FPGA Files,

*  Voltage Mask

»  Trigger Option polarity

Methods to set the required data Fields are included. The following are methods available for this interface:

*  SetTriggerOption() *  EnableCompilerOfExerciser()
*  RunTA700Project() *  SetForceStopTimerValue()

*  SetFpgaFilesPath() +  GetTerminationType()

*  SetProtocolErrorMasks() «  SetDevicelD()
SetVoltageMasks() +  FormatResultMessage()

» SetInterfaceMode() e SaveAsText()

*  SetPortNumber() +  DumpLocalMemory()

SetTriggerOption (nOutTrigPolarity)

Parameters

NOutTrigPolarity Specifies the new Polarity of External Signal Trigger. It can take 0-1
values no more.

1: Triggers on positive polarity

0: Triggers om negative polarity

RunTA700Project (BSTR ProjectName)

Parameters
BSTR Projectname. The RunTA700Project method runs TA700 board with specified data
and saves the result with a specified output file name.

SetFPGAFilesPath (bstrOutputFileName)

Parameters

bstrOutputFileName Specifies the new path of the FPGA file that is needed for TA700 Run
Engine.
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SetProtocolErrorMask (nProtocolErrorMask)

Parameters
nProtocolErrorMask Specifies the new Protocol Error mask.

For example if you want to unmask Protocol error No 11, you must
set the 11™ bit to 1 before passing the nProtocolErrorMask to this
method:

Mask = (_ int64)1 <<10;

If (Unmask)

nProtocolErrorMask |= mask;

else

nProtocolErrorMask &= ~ mask;

SetVoltageMasks (nVoltageMasks)

Parameters

nVoltageMask Specifies Voltage Mask. The TA700 monitors the critical voltages on
the PCI bus. A 5% drop in voltage for selected voltages and turns the
SYS status LED from green to red. If the bit set for a voltage in the
Voltage Mask this capability will be disabled for that voltage

bit 0: Board +5 Volt

bit 1: Bus +5 Volt

bit 2: Bus +3.3 Volt

bit 3: Bus +12 Volt

bit 4: Bus +12 vaux Volt}

bit 5: Top Connector +5 Volti
bit 6: Top Connector +5 Volti

SetinterfaceMode (ninterfaceMode)

Parameters

ninterfaceMode Specifies the new Interface Mode for Next run.
Pass 0 for EPP Port.
Pass > 1 for USB Port

SetPortNumber (nPortNumber)

Parameters

nPortNumber Sets the new Iport Number for the Next run. For example, you can
have more than one EPP or USB port, so nPortNumber specifies the
number of each port, this number is one base.
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EnableCompilerOfExerciser (bEnabledCompiler)

Parameters
bEnabledCompiler Enables or disables Compiler of Exerciser for next run.
Parameter value =TRUE the TA700 API will compile the .prg file and
use it.

Parameter value =FALSE the TA700 APIwill use precompiled
exerciser file that is archived as. MTM.

SetForceStopTimerValue (nTimerValue)

Parameters

nTimerValue Sets the value for timer which TA700 Analyzer / Exerciser which
when expired will cause a stop.

GetTerminationType (nTerminationType)

Parameters
nTerminationType The Termination type of the last run will be saved at this parameter.
Remarks The GetTerminationType method returns the last termination
type of Analyzer / Exerciser of the TA700. The type of this
parameter is a predefined enumeration type at CAPI dll. The
following is a declaration that can be used in your software:
enum {

eSuccessTermination, // If Analyzer / Exerciser has finished
normally

eUserStopTermination, // If User has stopped the Analyzer/
Exerciser at GUI

eCancelRetrievingDataTermination, // If User has stopped the
retrieving data at GUI

eCancelProgrammingTermination, // If user has stopped the Hardware
while it is configuring by software

eErrorTermination,// If software has any problem by Hardware

eForcedStopTermination // If analyzer/Exerciser was stopped
manually by Software by the internal
force stop timer

193



Catalyst Enterprises Inc. Library Exported Interfaces

SetDevicelD(nDeviceType,IBoardSerialld)

Parameters
nDeviceType Type of board interface connection, 0 for TA700,TA800 and 1 for
TAS850
1BoardSerialld The board serial id specified by Catalyst

FormatResultMessage(nMessagelD, pbstrMessage)

Parameters
nMessagelD The returned error code
pbstrMessage The message depends on message id, this parameter is by reference

return value

SaveAsText(bstrSampleFileName)

Parameters
bstrSampleFileName Name of sample file (User does not have to include the txt extension)
Remarks The SaveAsText method saves the specified sample file in text format
with same name as the sample file with a .txt extension added
automatically.

DumpLocalMemory(bstrProjectName)

Parameters
bstrProjectName Name of project file
Remarks The DumpLocalMemory reads the local memory defined in project

file and saves it as a .Imf file specified in project.
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IChangeProjectServer

This interface allows the developer to change a predefined TA700 project.By this interface developers can do any
modifications on Event,Sequencer, But not Exerciser of the specified project.All methods which are available at this

Interface are below :

SetEventField()
GetEventField()
SetPreTrigger()
GetPreTrigger()
SetSeqFieldInt()
GetSeqFieldInt()
SetSeqFieldStr()
GetSeqFieldStr()
SetElseStatementInt()
GetElseStatementInt()
SetElseStatementStr()
GetElseStatementStr()
SetTimingEnableValue()
SetTimingTClock Value()
GetTimingEnableValue()
GetTimingTClockValue()
SetTimingMasks()
SetTimingMaskALll()
SetTimingMasksAddress()
SetTimingMasksControl()

Open (IpszProjectName)

Parameters

lpszProjectName

Close ()

Parameters
None.

Remarks

GetTimingMasks()
GetTimingMasksAddress()
GetTimingMasksControl()
SetSampleNo()

GetSampleNo()
SetWorkingMode()
GetWorkingMode()
SetOutputFileName()
GetOutputFileName()
SetMasterAbortOption()

Open()

Close()

SetAssertFrameOption()
SetCompleteTransactionOption()
SetTargetDisconnectOption()
GetMasterAbortOption()
GetAssertFrameOption()
GetCompleteTransactionOption()
GetTargetDisconnectOption()

Sets new Project Name

The Close method closes the last opened project.
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SetSampleNo (nhSampleNo)

Parameters

nSampleNo Sets the number of samples to be taken.

GetSampleNo (pnSampleNo)

PCIXAsyncTimingAnalyzer

Parameters
pnSampleNo Number of samples taken.
Remarks The GetSampleNo method returns the Number of samples that have
been saved.
SetWorkingMode (nWorkingMode)
Parameters
nWorkingMode Specifies TA Working Mode. The following values define the
working mode:
PCIBusAnalyzer 0
PCITimingAnalyzer 1
PCIBusExerciser 2
PCIAsyncTimingAnalyzer 3
PCIXBusAnalyzer 4
PCIXTimingAnalyzer 5
PCIXBusExerciser 6
7
8

None
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GetWorkingMode (pnWorkingMode)

Parameters
pnWorkingMode Value of saved project working mode.
PCIBusAnalyzer 0
PCITimingAnalyzer 1
PCIBusExerciser 2
PCIAsyncTimingAnalyzer 3
PCIXBusAnalyzer 4
PCIXTimingAnalyzer 5
PCIXBusExerciser 6
PCIXAsyncTimingAnalyzer 7
None 8
Remarks The GetWorkingMode method returns the working mode value of
saved project.
SetOutputFileName (bstrOutputFileName)
Parameters
bstrOutputFileName Output File Name such as FileName.Smp
Remarks The SetOutputFileName method Sets output file name.
GetOutputFileName (pbstrOutputFileName)
Parameters
pbstrOutputFileName Returned File Name such as MyFile.Smp
Remarks The GetOutputFileName method returns the last output file name.

SetTargetDisconnectOption (bTargetDisconnect)

Parameters
bTargetDisconnect Sets the Target Disconnect status for next run of TA Board.

If set TRUE: The TA will bypass all of the transactions in the current
command and will jump to the transaction for the next
command

Remarks The SetTargetDisconnectOption method the Target Disconnect status

for next running for TA700 Board.

If it is set to true then otherwise Completes from that point on, regardless of the number of times the target
issues a disconnect. The TA700 will take it from where the target
disconnect was issued and try to complete the transaction from that
point on.

Use Next Transaction.
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GetTargetDisconnectOption (pbTargetDisconnect)

Parameters
pbTargetDisconnect Returns last set Target Disconnect status.
Remarks The GetTargetDisconnectOption method returns the last set Target

Disconnect status.

SetCompleteTransactionOption (bCompleteTransaction )

Parameters
bCompleteTransaction Specifies the Master completion status on time out at next Run.

TRUE: The TA completes the current transaction as
soon as possible after GNT# is deasserted.

FALSE: The TA continues to complete the transaction
for however many clocks it takes regardless of GNT#
being deasserted.

GetCompleteTransactionOption (pbCompleteTransaction )
Parameters

pbCompleteTransaction Returns the last set Master completion status.

SetAssertFrameOption(pbAssertFrame)
Parameters
bAssertFrame Specifies Assertion Status of Frame Signal for TA board for next Run.

FALSE: Asserts the frame and starts the transaction
regardless of the status of the GNT#.

TRUE: Requests the bus and starts the transaction only
after the GNT# is asserted.

GetAssertFrameOption(pbAssertFrame)

Parameters
pbAssertFrame Returned Assertion Status of last set Frame Signal.
Remarks
SetMasterAbortOption (bMasterAbort)
Parameters
bMasterAbort Specifies the duty cycle of TA Board on Master Abort.

TRUE: The TA will issue a Master ABORT on the 5th
clock if no DEVSEL# is asserted.

FALSE: The FRAME# will stay asserted indefinitely
and the TA will not issue a Master ABORT.
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GetMasterAbortOption (pbMasterAbort)

Parameters
pbMasterAbort Returned duty cycle of TA Board on Master Abort.

SetEventField(nEventNo, nFieldIndex, IpszNewValue)

Parameters
nEventNo Specifies the Event No that must be modified with IpszNew Value.
nFieldIndex Specifies the Index of the Event that must be modified with
IpszNewValue.
IpszNewValue Specifies the new Event value that must be set for an Event.
Remarks The SetEventField method sets the new value lpszNewValue at the

specified part of event specified by nFieldIndex.

GetEventField (nEventNo, nFieldlndex, strValue)

Parameters
nEventNo Specifies the Event No for which Event value will be returned.
NFieldIndex Specifies the Index of the Event for which Event value will be
returned.
strValue The Event value returned for Event specified by nEventNo &
nFieldIndex.
SetPreTrigger (npreTrigger)
Parameters
npreTrigger Specifies Trigger Point to be set.
GetPreTrigger (npreTrigger)
Parameters
npreTrigger Returned Trigger Point.

SetSeqFiledint (nStateNo, nFieldindex, nNewValue)

Parameters
nStateNo Specifies the state No that must be updated.
nFieldIndex Specifies the index of state Part that must be updated.
nNewValue Specifies the new value of specified part of sequencer state.
Remarks The SetSeqFieldInt method updates the sequencer state with

nNew Value.
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GetSeqFiledint(nStateNo, nFieldindex, nValue)

Parameters
nStateNo Specifies the state No whose data is to be returned. Value between 0-
31.
nFieldIndex Specifies the index of state Part that whose data is to be returned.
nValue Returned value of specified part of sequencer state.

SetSeqgFiledStr (nStateNo, nFieldIndex, strExpression)

Parameters
nStateNo Specifies the state No whose data is to be retrieved. Range between 0-
31.
nFieldIndex Specifies the index of state Part whose data is to be retrieved.
strExpression Specifies the value for specified part of sequencer state.

GetSeqgFiledStr (nStateNo, nFieldIndex, strExpression)

Parameters
nStateNo Specifies the state No whose data is to be retrieved. Range between 0-
31.
nFieldIndex Specifies the index of state Part whose data is to be retrieved.
strExpression Returned value of specified part of sequencer state.

SetElseStatementint (nStateNo, nElseNo, nFieldiIndex, nNewValue)

Parameters
nStateNo Specifies the state No whose data is to be updated. Range between 0-
31.
nElseNo Specifies the Else No whose data is to be updated. Range between 0-
10.
nFieldIndex Specifies the index of state Part that whose data is to be updated.
nNew Value Specifies the new value for specified part of sequencer state.

GetElseStatementint (nStateNo, nElseNo, nFieldIndex, nValue)

Parameters
nStateNo Specifies the state No whose data is to be retrieved.Range between 0-
31.
nElseNo Specifies the Else No whose data is to be updated.Range between 0-
10.
nFieldIndex Specifies the index of state Part whose data is to be retrieved.
nValue Returned value of specified part of sequencer state.
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SetElseStatementStr(nStateNo,nElseNo,nFieldindex,strExpression)

Parameters
nStateNo Specifies the state No whose data is to be retrieved. Range between 0-
31.
nElseNo Specifies the Else No whose data is to be updated. Ranged between 0-
10.
nFieldIndex Specifies the index of state Part that whose data is to be retrieved.
strExpression Specifies the value of specified part of sequencer state.

GetElseStatementStr(nStateNo, nElseNo, nFieldIndex, strExpression)

Parameters
nStateNo Specifies the state No whose data is to be returned. Ranged between
0-31.
nElseNo Specifies the Else No whose data is to be updated.Ranged between 0-
10.
nFieldIndex Specifies the index of state Part that whose data is to be returned.
strExpression Specifies the current value of specified part of sequencer state.
Remarks The GetElseStatementStr method gets specified part of sequencer

belonging to strExpression parameter.

SetTimingEnableValue(nTimingEnableValue)

Parameters

nTimingEnableValue Specifies the Value of Enable parameter for next run. The scale of
This parameter is nanosecond, and with .1 nanosecond tolerance.

GetTimingEnableValue(pnTimingEnableValue)

Parameters
pnTimingEnableValue The Value of Enable parameter returned.
SetTimingTClockValue(nTimingTClkValue)
Parameters
nTimingTClkValue Specifies the Value of T-Clk parameter for next run. The scale of This

parameter is nanosecond, and with .1 nanosecond tolerance.

GetTimingTClockValue(pnTimingTClkValue)

Parameters

pnTimingTClk Value Value of T-Clk parameter returned.
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SetTimingMasks(ptrTimingMasks)
Parameters
ptrTimingMasks Specifies the Value of the Signal Masks parameter for next run.
The order of the Timing mask is shown below:
“AD[64], CBE[8], PAR, PAR64, PERR, SERR, REQ, GNT,

REQ64, ACK64, STOP, LOCK, RST, INTA, INTB, INTC, INTD,
FRAME,TRDY, IRDY, DEVSEL, IDSEL, PME”

For example:
AD[0]->ptrTimingMasks[0]
ADJ[1]->ptrTimingMasks|[ 1]

GetTimingMasks(ptrTimingMasks)

Parameters
ptrTimingMasks The Value of Signal Masks parameter returned.
The order of the Timing mask is shown below:
“AD[64], CBE[8], PAR, PAR64, PERR, SERR, REQ, GNT,

REQ64, ACK64, STOP, LOCK, RST, INTA, INTB, INTC, INTD,
FRAME, TRDY, IRDY, DEVSEL, IDSEL, PME”

For example:
ptrTimingMasks[0] -> ADI[0]
ptrTimingMasks[1] ->AD[1]

SetTimingMaskAll(bMaskValue)

Parameters
bMaskValue Specifies the Value of all Signal Masks parameters for next run.
Remarks SetTimingMaskAll method sets the Value of Timing Masks parameter

for next run by bMaskValue.
SetTimingMasksAddress(bAdd32, bMaskValue)

Parameters
bAdd32 Specifies the mode of Masking for address signals. If it will be true
the masking is on the Address 32bits els on all address signals.
TRUE: Masking is on 32 bits of address
FALSE: Masking is on all address signals
bMaskValue Specifies the value of Masking for address signals.
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GetTimingMasksAddress(ptrAddressMask)

Parameters
ptrAddressMask Returned value of Masking for address signals.
SetTimingMasksControl(bMaskValue)
Parameters
bMaskValue Specifies the Value of control Signal Masks parameter for next run.
Remarks The SetTimingMasksControll method sets the Value of Control

Timing Masks parameter for next run by bMaskValue.

GetTimingMasksControl(ptrControlMask)

Parameters
ptrControlMask Returned value of control Signal Masks parameter.
Remarks The GetTimingMasksControll method returns the Value of Control

Timing Masks parameter.

IUtilityServer

This interface allows the developer to get some TA board information such as attached LPT no or Bus Frequency which
is connected to TABoard. The methods which are available at this Interface are:

SetFpgaFilesPath()

SetInterfaceMode()

SetPortNumber()

AutoDetectSystemFrequency/()

AutoDetectSystemFrequency (nSystemFrequency)

Parameters
nSystemFrequency Specifies the Bus Frequency of TA board connected.
Remarks The AutoDetectSystemFrequency method gets the Bus Frequency of
TA board is connected to the bus
Notice: To detect the System frequency, TA boards must be programmed by calling SetFPGAFilsePath

method first. Otherwise the TA may be not be found by the specified FPGA Path.
SetinterfaceMode (ninterfaceMode)

Parameters
ninterfaceMode Specifies the new Interface Mode for Next run.
Pass 0 for EPP Port.
Pass > 1 for USB Port
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SetPortNumber (nPortNumber)

Parameters
nPortNumber Specifies port Number for Next run. So software will attach to this
port Number, for example you can have more than one EPP or USB
port, so it specifies the number of each port, this number is one base.
Remarks The SetPortNumber method sets the Port number for the next run.
SetFPGAFilesPath (bstrOutputFileName)
Parameters
bstrOutputFileName Specifies the path of FPGA file that is needed for the TA Run Engine.
Remarks The SetFpgaFilesPath method Sets the path to FPGA files.
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Examples

The following are some examples of working with TA700 Com API, illustrating the use of all of the methods supported
by our library:

IRunProjectServers Interface Examples

LPDISPATCH pDispatch = NULL;
IRunProjectServer* Run = NULL;
VERIFY (SUCCEEDED (CoInitialize (NULL)));
VERIFY (SUCCEEDED (CoCreateInstance (
CLSID RunProjectServer,
NULL,
CLSCTX ALL,
IID IDispatch, (void**)&pDispatch)
))
VERIFY (SUCCEEDED (pDispatch->QueryInterface (
IID IRunProjectServer,
(void**) &Run) )
) 7
//Set the device specifics for TA850 with 0x123 serial id
Run->SetDeviceID(0 , 0x123);

//-- Set port number to 1, so it means that you want to attach to first USB
port

Run->SetPortNumber (1) ;

//Set the Interface to Hardware to USB Port
Run->SetInterfaceMode (1) ;

//-- Set the Trigger to trigger on a positive level
Run->SetTriggerOption (1) ;

//—— By default the TA700 detects and monitors the critical voltages on the
PCI bus but with

//-— this setting the Bus 3.3 Volt will be masked
Run->SetVoltageMasks (2) ;

//-- By default the TA700 detects all protocol errors specified for PCI, PCI-
X bus but ,with
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//-- below mask we want that TA700 unmask the 3,6,7th protocol errors
//-— 100 = 4+32+64

long nProtocolErrorMask = 0;

nProtocolErrorMask |= (_ int64)1 <<2;
nProtocolErrorMask |= (_ int64)1 <<5;
nProtocolErrorMask |= (_ int64)1 <<6;

//-— nProtocolErrorMask is equal 100
Run->SetProtocolErrorMask (nProtocolErrorMask) ;
Run->SetFpgaFilesPath ((LPCTSTR)m strFPGAPath);

//—-— SW uses the last compiled exerciser file or MTM file, so there is nor
Compilation

//—-— Phase at next run
Run-> EnableCompilerOfExerciser (FALSE);
Run->RunTA700Project ( (LPCTSTR)m strProjectName) ;

CoUninitialize();

IChangeProjectServer Interface Examples

IChangeProjectServer* Project = NULL;
VERIFY (SUCCEEDED (CoInitialize (NULL))) ;
VERIFY (SUCCEEDED (CoCreateInstance (

CLSID ChangeProjectServer,

NULL,

CLSCTX_ALL,

IID IDispatch,

(void**) &pDispatch))

) 7
VERIFY (SUCCEEDED (pDispatch->QueryInterface (

IID IChangeProjectServer,

(void**) &Project))

)
Project->Open ( (LPCSTR)m strProjectName) ;
//-— Upadting EVENT Fields of Project --//
long nEventNo;

long nFieldIndex;
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//-— Set same setting for all 8 Events

//-- IMPORTANT NOTICE

//-— At TA700ComApi pack, there is the file “TA700ApiCons.h”.

//-= With this file we declare some common values such as: EVN NAME,
//-- EVN XFER .., you can add this file to your VC++ project, or you
//-- Declare same values for other projects

//-- If you use this header file the tables below describe the values used.

Event Field

XFER type gfr%l;ivzval“e
A32 XFER A32
D32 (Data XFERs only IRDY = 0, TRDY=0, DEVSEL=0) XFER D32
D32 (Data XFERs including Wait Cycles, DEVSEL=0) XFER D32S
MX32 (DE_Multiplex) XFER MX32
Ao64 XFER _A64
D64 (Data XFERs only IRDY = 0, TRDY=0, DEVSEL=0) XFER D64
D64 (Data XFERs including Wait Cycles, DEVSEL=0) XFER D64S
MX64 (DE_Multiplex) XFER_MX64
IDLE XFER IDLE
Per User Defined XFER_USER

“nEventNo” is used to select which event to modify. See the table below for the valid parameters:

EVENT NAME nEventNo
EV1 EVN EV1
EV2 EVN _EV2
EV3 EVN _EV3
EV4 EVN EV4
EVs EVN_EVS5
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valid parameters:

EVENT NAME nEventNo
EV6 EVN EV6
EV7 EVN EV7
EV8 EVN _EV8
“nFieldIndex” is used to select which field to modify. See the following table for the
FIELD NAME nFieldIndex
Name EVN NAME
XFER EVN_XFER
ADJ[] EVN_ADD
PAR EVN PAR
CBE[] EVN CBE
IDSEL EVN IDSEL
FRAME# EVN FRAME
IRDY# EVN _IRDY
DEVSEL# EVN DEVSEL
TRDY# EVN TRDY
STOP# EVN_STOP
LOCK# EVN_LOCK
R/G EVN R/G
INTX EVN_INTX
ERR EVN_ERR
RST# EVN RST
PME# EVN PME
for (int nCount = 0;nCount < 8;nCount++)

{

Project->SetEventField (nCount, EVN NAME

Project->SetEventField (nCount, EVN XFER

Project->SetEventField (nCount, EVN_ ADD

Project->SetEventField (nCount,
Project->SetEventField (nCount,

Project->SetEventField (nCount, EVN IDSEL

,_T("Add32"));
, XFER_A32) ;

, _T("00001™));
EVN_PAR, T("1"));
EVN_CBE,_T("0001"));

P _T(M1IM))
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Project->SetEventField(nCount, EVN FRAME , T("1"));
Project->SetEventField (nCount, EVN IRDY , _T("1M))
Project->SetEventField (nCount, EVN DEVSEL, T("1"));
Project->SetEventField (nCount, EVN TRDY , T("LM))
Project->SetEventField (nCount, EVN STOP , T("LM))
Project->SetEventField (nCount, EVN LOCK , T("1IM))
Project->SetEventField(nCount, EVN RG, T("10"));
Project->SetEventField (nCount, EVN INTX , _T("1000™));
Project->SetEventField(nCount, EVN ERR, T("1"));
Project->SetEventField (nCount, EVN RST , T("1"));
Project->SetEventField (nCount, EVN CACHE , _T("1M))
Project->SetEventField (nCount, EVN PME , T("1"));

(

Project->SetEventField(nCount, EVN USER , _T("1M))

BSTR strValue = NULL;
Project->GetEventField (nEventNo, nFieldIndex, &strValue);

//-- Upadting SEQUENCER Fields of Project --//
//-- Set same setting for all 32 states --//
//-- IMPORTANT NOTICE
//-- At TA700ComApi pack, there is the file “TA700ApiCons.h”.
//-- At this file we declare some common values such as:
//--SEQ_ TRIGGER,
//-- SEQ EXERCISER .., you can add this file to your VC++ project,
//-=-You must declare same values for other projects

//-- If you will use this header file below is some description about its
values:
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Sequencer Fields

Field Name nFieldIndex nNewValue options
Set Trigger SEQ TRIGGER TRUE::FALSE
Start Exerciser SEQ_EXERCISER TRUE::FALSE

If(-- Time) SEQ_IF TIME TRUE::FALSE

If Counter SEQ IF COUNT Count/Time

SEQ_NANO_SECOND
Time Unit SEQ TIME UNIT SEQ MICRO SECOND
SEQ MILLI SECOND

Tag Event SEQ_IF_TAG TRUE::FALSE

If Then Goto SEQ _IF THEN Define the State to goto (SEQ_S1 ~ SEQ_S31)

Number of ELSE IF statements SEQ ELSE NO(<20) Number of else statements

Valid values for strExpression and return values for strValue:

SEQ ALL
SEQ_ANY (Not used in SEQ_STORE)
SEQ NONE

SEQ EVI

SEQ EV2

SEQ EV3

SEQ EV4

SEQ EV5

SEQ EV6

SEQ EV7

SEQ EV8

SEQ NOTEVI
SEQ NOTEV2
SEQ NOTEV3
SEQ NOTEV4
SEQ NOTEV5
SEQ NOTEV6
SEQ NOTEV7
SEQ NOTEVS
SEQ_EXPRESSION
SEQ PEROTOCOL
SEQ TIMING

SEQ EXTERNAL
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ELSE Fields

Field Name nFieldIndex nNewValue/nValue
ELSE IF condition SEQ ELSE CONDITION |See above

Discard SEQ ELSE DISCARD TRUE::FALSE
Then Goto SEQ_ELSE THEN SEQ_S0to SEQ S31

for (int nCount = 0; nCount < 32 ;nCount ++)
{
Project->SetSeqgFieldInt (nCount, SEQ TRIGGER,1);
Project->SetSegFieldInt (nCount, SEQ EXERCISER,1);
Project->SetSegFieldInt (nCount, SEQ STORE,SEQ EV5);
Project->SetSeqgFieldInt (nCount,SEQ IF TIME,1);
Project->SetSegFieldInt (nCount, SEQ IF COUNT, 10);
Project->SetSegFieldInt (nCount, SEQ TIME UNIT,SEQ MILLI SECOND);
Project->SetSegFieldInt (nCount, SEQ IF CONDITION, SEQ EV5);
Project->SetSegFieldInt (nCount, SEQ IF TAG,1);
Project->SetSeqgFieldInt (nCount, SEQ IF THEN,SEQ EV5);
Project->SetSeqgFieldInt (nCount, SEQ ELSE NO,10);

Project->SetElseStatementInt (nCount, 0, SEQ ELSE CONDITION, SEQ EV5) ;
Project->SetElseStatementInt (nCount, 0, SEQ ELSE DISCARD,1);
Project->SetElseStatementInt (nCount, 0, SEQ ELSE THEN, SEQ EV5) ;

Project->SetSeqgFieldStr (nCount,SEQ STORE, T ("EV1+EV2"));
Project—>SetSequeldStr(nCount,SEQ_IF_CONDITION,_T("EV2+EV3"));

Project->SetElseStatementStr (nCount, 0, SEQ ELSE CONDITION
, T("EV3+EV4"));

}

Project->GetSegFieldInt (nStateNo,nFieldIndex, &nValue) ;
Project->GetSegFieldStr (nStateNo,nFieldIndex, &ébtrExpression) ;
Project-GetElseStatementStr (nStateNo,nElseNo,nFieldIndex,

&btrExpression) ;
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Project->GetElseStatementInt (nStateNo,nElseNo,nFieldIndex, &nValue) ;
Project ->SetTimingEnableValue (150);

Project ->SetTimingMasks (TimingMask) ;

Project ->SetTimingTClockValue (30);

Project ->SetTimingMaskAll (TRUE) ;

Project ->SetTimingMasksAddress (TRUE, FALSE) ;

Project ->SetTimingMasksControl (FALSE) ;

Project->Close();

CoUninitialize();

IUtilityServer Interface Examples

UtilityServer* Utility = NULL;
VERIFY (SUCCEEDED (CoInitialize (NULL))) ;
VERIFY (SUCCEEDED (CoCreateInstance (
CLSID UtilityServer,
NULL,
CLSCTX ALL,
IID IDispatch,
(void**) &pDispatch))
) ;
VERIFY (SUCCEEDED (pDispatch->QueryInterface (
IID IUtilityServer,
(void**) &Utility))
) ;
long nPortNo = 0;
//Set the device specifics for a TA700 or TA800
TempUtility->SetDeviceID(1,0);

//Set the port Number to 1, so it means that you want to attach to first USB
port

TempUtility->SetPortNumber (1) ;
//Set the Interface to Hardware to USB Port
TempUtility->SetInterfaceMode (2) ;

CoUninitialize();
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Data File Structure

The format for the SMP consists of 3 parts:

Header 32 Bytes

Data (Sample size *number of sample size) bytes

Display Information Not used by TA700ComAPI, for screen display of GUI only.
HEADER GROUP NAME BYTES USED
SAMPLE SIGNATURE! 1-16
NUMBER OF SAMPLES IN FILE (in Hex; LSB -> MSB) 17-20

TRIGGER POSITION (in Hex; LSB-> MSB relative to start of file 21-24

SIZE OF EACH SAMPLE (in Hex; LSB, MSB) 25-26
CLOCK TIME (ns)9in Hex; LSB, MSB) 27-28
SETUP TIME (For Timing Modes, otherwise is RESERVED) 29-30
HOLD TIME (For Timing Modes, otherwise is RESERVED) 31-32

1. This field can be any one of the following values:
“SampleOptionANE”: PCI Analyzer/Exerciser Mode data file
“SampleOptionTIE”: PCI Synchronous Timing Analyzer Mode data file
“SampleOptionOAE”: PCI Asynchronous Timing Analyzer Option A Mode data file
“SampleOptionOBE”: PCI Asynchronous Timing Analyzer Option B Mode data file
“SampleXptionANE”: PCI-X Analyzer/Exerciser Mode data file
“SampleXptionTIE”: PCI-X Synchronous Timing Mode data file
“SampleXptionOAE”: PCI Asynchronous Timing analyzer Option A Mode data file
“SampleXptionOBE”: PCI Asynchronous Timing analyzer Option B Mode data file
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DATA MAPPING

BIT USED
GROUPING |GROUPING |GROUPING| SIGNAL BYTE
NAME 7165432110

AD[63..00] AD[39] X

ADD[64] AD[38] X
DATA[64] AD[37] X

AD[36] X
AD[39..34] 36
AD[35] X

AD[34] X

AD[33] X

AD[32] X

AD[31] X

AD[30] X

ADI[29] X

AD[28] X
AD[31..24] 37
AD[31..00] AD[27] X

ADDI[32] ADI[26] X

DATA[32] AD[25] X

AD[24] X

AD[23] X

AD[22] X

AD[21] X

AD[20] X
AD[23..16] 38
AD[19] X

AD[18] X

ADI[17] X

AD[16] X
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DATA MAPPING

SIGNAL BIT USED

GROUPING | GROUPING | GROUPING ME BYTE
NA 716|543 |2]1]0

AD[15] X

AD[14 X

AD[13] X

AD[12] X
ADI[15..8] 39
AD[11] X

ADI[10] X

AD[9] X

AD[31..00]
ADD[32]
DATA[32]

ADIS8] X

AD[7] X

AD[6] X

ADI5] X

AD[4] X
ADI[7..0] T 40 "

AD[2] X

AD[1] X

AD[0] X

CBEJ[7..0] CBE[7.4] | CBE[7] X

CBE[6] X

CBE[5] X

CBE[4] X
41
CBE[3] X

CBE[2] X
CBE[3..0]

CBE[1] X

CBE[0] X
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DATA MAPPING

BIT USED
GROUPING |GROUPING |GROUPING| SIGNAL BYTE
NAME 7165432110

PAR X

PAR64 X

SDONE X

SBO# X
42

SERR#

PERR#

REQ#

GNT#

REQ64# X

ACKO64# X

LOCK# X

CONTROL STOP# X

43

IRDY#

TRDY#

DEVSEL#

IDSEL# X

RST# X

INTA# X

INTB# X

44
INTC# X

INTD#

PME#

USER#
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DATA MAPPING

GROUPING

GROUPING

GROUPING

SIGNAL
NAME

BYTE

BIT USED

4

31211160

ERROR

23..16

TIME TAG

TIME TAG
MSB

45

X

XX [X]|X

TIME TAG

46

TIME TAG

47

TIME TAG

48

TIME TAG
LSB

49

ERROR
56..63

ERROR 63

ERROR 62

ERROR 61

ERROR 60

ERROR 59

ERROR 58

ERROR 57

ERROR 56

50

ERROR
48..55

ERROR 55

ERROR 54

ERROR 53

ERROR 52

ERROR 51

ERROR 50

ERROR 49

ERROR 48

51

ERROR
40..47

ERROR 47

ERROR 46

ERROR 45

52
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DATA MAPPING

BIT USED
GROUPING |GROUPING |GROUPING| SIGNAL BYTE
NAME 7165432110

ERROR 43 X

ERROR | ERROR 42 X
10,4 52
0..47 ERROR 41 X

ERROR 40 X

ERROR 39 X

ERROR 38 X

ERROR 37 X

ERROR ERROR 36 X
32..39 >3
- ERROR 35 X

ERROR 34 X

ERROR 33 X

ERROR 32 X

ERROR 31 X

ERROR 30 X

ERROR 29 X

ERROR ERROR 28 X
24.31 >4
" ERROR 27 X

ERROR 26 X

ERROR 25 X

ERROR 24 X

ERROR 23 X

ERROR | ERROR 22 X
55
23..16 RRROR 21 X

ERROR 20 X
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DATA MAPPING

GROUPING

GROUPING

GROUPING

SIGNAL
NAME

BYTE

BIT USED

41312

ERROR
23..16

ERROR 19

ERROR 18

ERROR 17

ERROR 16

55

X

ERROR
15..8

ERROR 15

ERROR 14

ERROR 13

ERROR 12

ERROR 11

ERROR 10

ERROR 9

ERROR 8

56

ERROR
7.0

ERROR 7

ERROR 6

ERROR 5

ERROR 4

ERROR 3

ERROR 2

ERROR 1

ERROR 0

57

ExSignal

XGRP3

XXI15

XX14

XXI13

XX12

58
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DATA MAPPING

BIT USED
GROUPING | GROUPING | GROUPING | SIGNAL BYTE
NAME 716|543 |2]1]0

XXI11 X

XX10 X
XGRP2 58
XX09 X

XX08 X

XX07 X

XX06 X

ExSignal XGRPI
XX05 X

XX04 X
59
XX03 X

XX02 X

XGRPO
XX01 X

XX00 X

TE_ADI[63..0] |TE_AD[63..32] TE_AD[63] X

TE_AD[62] X

TE_AD[61] X

TE_AD[60] X
TE_AD[63..56] 60
TE_AD[59] X

TE_AD[58] X

TE_AD[57] X

TE_AD[56] X

TE_AD[55] X

TE_ADJ[55..48]| TE_AD[54] 6l X
TE_AD[53] X

TE_AD[52] X
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DATA MAPPING

BIT USED
GROUPING | GROUPING | GROUPING | SIGNAL BYTE
NAME 716|543 |2]1]0

TE_ADI[51] X

TE_ADI[55..48]| TE_AD[50] ol X
TE_AD[49] X

TE_ADI[48] X

TE_AD[47] X

TE_AD[46] X

TE_ADI[45] X

TE_AD[44] X
TE_AD[47..40] 62
TE_AD[43] X

TE_ADI[42] X

TE_AD[41] X

TE_AD[40] X

TE_ADI[39] X

TE_AD[38] X

TE_AD[37] X

TE_AD[36] X
TE AD[39..32] 63
TE_AD[35] X

TE_AD[34] X

TE_AD[33] X

TE_AD[32] X

TE AD[31..0] TE AD[31] X

TE_AD[31..24]| TE_AD[30] ” X
TE_AD[29] X

TE_AD[28] X
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DATA MAPPING

BIT USED
GROUPING | GROUPING | GROUPING | SIGNAL BYTE
NAME 716|543 |2]1]0

TE_AD[27] X

TE_AD[26] X
TE AD[31..24] 64
TE_AD[25] X

TE_AD[24] X

TE_AD[23] X

TE_AD[22] X

TE_AD[21] X

TE_AD[20] X
TE_AD[23..16] 65
TE_AD[19] X

TE_AD[18] X

TE_AD[17] X

TE_AD[16] X

TE_AD[15] X

TE_AD[14] X

TE_AD[13] X

TE_AD[12] X
TE_ADJ[15..8] 66
TE_AD[11] X

TE_AD[10] X

TE_AD[9] X

TE_ADI[8] X

TE_AD[7] X

TE_AD[7..0] | TE_AD[6] . X
TE_ADI[5] X

TE AD[4] X
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DATA MAPPING

GROUPING

GROUPING

GROUPING

SIGNAL
NAME

BYTE

BIT USED

4132

TE_AD[7..0]

TE AD[3]

TE_AD[2]

TE AD[1]

TE_AD[0]

67

X

TE_C/BE[7..0]

TE_C/BE[7..4]

TE_C/BE[7]

TE_C/BE[6]

TE_C/BE[5]

TE_C/BE[4]

TE_C/BE[3..0]

TE_C/BE[3]

TE C/BE[2]

TE_C/BE[1]

TE_C/BE[0]

68

TIMING
ERRPOR
CONTROL
SIGNALS

TE_PAR

TE_PAR64

TE_SDONE

TE_SBO#

TE_SERR#

TE_PERR#

TE_REQ#

TE_GNT#

69

TE REQ64+#

TE ACK64+#

TE_LOCK#

TE_STOP#

70
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DATA MAPPING

SIGNAL BIT USED

GROUPING | GROUPING | GROUPING AME BYTE
N 716|543 2]1]0

TE FRAME# X

TE IRDY# X
70
TE TRDT# X

TE DEVSEL# X

TE IDSEL X

TE_RST# X

TE INTA# X

TE_INTB# X
71
TE_INTC# X

TE INTD# X

TE_PME# X

TE_USER# X

NOT USED X

TEQ_PAR X

TEQ_IDSEL X
72
TEQ PERR# X

TEQ AD X

TEQ CBE X
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APPENDIX B

TA700 PCI Card

Memory Expansion

J7,J4 JP15 LED’s
o CEE2X92SM- V35Z14W

BURNDY
COMPUTERBUS SD0025

R D)

”
m
=3
o=
a o
W m
<~
o ©
@ m
@D -
(L
o

XCVE00™
PHILIPPINES

P2

JP16 JP10

Figure 158 TA700 PCI Analyzer Card

TA700 PCI Analyzer card supports all available features. The features are enabled
with the access code as described in “Authorization” on page 22.

Status LED Function Description

SYS When green it indicates that the system and DUT voltages are within 5% of their nominal
values. If any of +5V, 3.3V, +12V drop by more than 5%, the SYS LED turns red. Upon
power on it comes up red during a power self test and turns green when the software
executes.
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DUT

TRIG

Indicates that voltage to the DUT is on. In this case the user may not remove or insert any
card in the top connector of the TA700.

Indicates that the analyzer has met the trigger condition and is awaiting for the post-trigger
data to be captured.

D3, D11 When illuminated, the TA700 has been configured.

Jumper Configuration

Note:

If your board does not have JP16 then use alternate jumper configuration as provided on page 229.

TA700 +3.3V Power Source selection

JP2

Shunt 1-2  center to left +3.3V from on board 5V regulator

Shunt 2-3  center to right +3.3V Bus Power (Default)

TA700 +5V Power Source Selection

JP16

Shunt 1-2  center to bottom | +5V from external supply

Shunt 2-3  top to center +5V Bus Power (Default)

Connecting an External Power Supply

Install Shunt 1-2 center to left on JP2 (3.3V)
Install Shunt 1-2 center to bottom on JP16 (+5V)

Connect the external power supply to JP1 as follows:

JP1

JP1.1  Top pin +5VEX
JP1.2  Center pin +5VEX
JP1.3 Bottom GND

This configuration applies +5V power to the TA700 from the external power supply
and redirects the 3.3V power from the on board regulator.
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Bus Protocol & Speed Sensing

Note:

Caution

JP10

Shunt 1-2 Top two PCI-X 133MHz
Shunt 3-4 Below top DUT capabilities
Shunt 5-6 Next to bottom PCI-X 66MHz
Shunt 7-8 Bottom two PCI (Default)

The JP10 jumper settings tell the central system arbiter what the capability of the
board. The PCI and PCI-X bus speed and type is determined by the system BIOS at
powerup. During the time that RST# is asserted, the system reads the signals on B49
(M66EN) and B38 (PCIXCAP) from all of the boards asserted on the bus. At the
rising edge of RST# a message defining the bus protocol and operating speed that
satisfies the lowest performance on the bus is sent to all of the cards on the bus. This
message is sent by the following five control signals: FRAME, IRDY#, TRDY#,
DEVSEL# and STOP#.

For example, if PCIX CAP is set to 0, the DUT is only PCI protocol capable and if
M66EN is 0, then the bus speed is PCI 33MHz and for M66EN = 1 the DUT is PCI
66MHz capable. For non zero values of PCIX CAP the bus speed is dependant on
the voltage level and can be either, PCIX 66MHz or PCIX 133 MHz.

Additionally the JP10 jumper setting allows the same bus information to be acquired
from the DUT during RST# or allow setting a predefined protocol and bus speed
regardless of the DUT capability

The bus information returned at the rising edge of RST# that must be decoded by
the DUT for proper information is also decoded by the TA700 and is displayed on
the bottom of the screen.

The JP10 setting information and the bus data returned at the rising edge of RST#
do not have to match if there is more than one agent on the bus.
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TA700 Power Up configuration

S2 Jumper Bottom two
Open (Note 1.) TA700 Declared as PCI agent (Default)
Installed (Note 2) TA700 Transparent to the System BIOS

Note 1: The TA700 operating as a PCI agent requires 256 1/O space and 1 Meg of memory
from the host system.

Note2: The TA700 will not respond to any transactions including configuration.

S2 Jumper (Factory Use Only) Top two

Open X
Installed A
J7 Trigger Out
J4 GND
External Signals
JP15 Pin Pin
Ext_In0 1 2 Ext Inl
Ext In2 3 4 Ext In3
Ext In4 5 6 Ext In5
Ext_In6 7 8 Ext In7
Ext In8 9 10 Ext In9
Ext In10 11 12 Ext Inll
Ext In12 13 14 Ext Inl3
Ext Inl4 15 16 Ext Inl5
GND 17 18 GND
GND 19 20 Key
Ext O0 * 21 22 Ext O1 *
Ext 02 * 23 24 Ext O3 *

* Not Implemented
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Alternate Jumper Configuration

Use this if your board does not have JP16.
TA700 +3.3V Power Source selection

JP2

Shunt 1-2  center to left +3.3V from external power

supply.

Shunt 2-3  center to right +3.3V Bus Power (Default)
Bus Protocol & Speed Sensing

JP10

Shunt 1-2 Top two PCI-X 133MHz

Shunt 3-3 Below top DUT capabilities

Shunt 5-6 Next to bottom PCI-X 66MHz

Shunt 7-8 Bottom two PCI (Default)
External Power Selection

JP1

1 +3.3VEX

2 +5VEX

3 GND
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TA700 Power Draw

Board Model

TA700 RevF

Conditions for the measurements:

Measurements.

1.

Current measured with PCIX6432, Fluke 75 Multimeter, HP1631D Storage
scope.

No Extended Memory (M700) installed.
Bus traffic generated from TST660 board.
TA700’s 3.3V generated internally.

Scenario 1. Board powered ON and idle. Interface cable not connected.

Current Draw Power Consumed
Bus Speed (MHz) Power Rail
(Amps) (Watts)
100 5V 2.21 11.05
66 5V 1.78 8.90
33 5V 1.19 5.95

Scenario 2. Board configured and idle, SW session opened.

) Current Draw | Power Consumed
Bus Speed (MHz) Power Rail
(Amps) (Watts)
100 5V 1.45 7.25
66 5V 1.42 7.10
33 5V 1.40 7.00

Scenario 3. Board running Analyzer test.

) Current Draw | Power Consumed
Bus Speed (MHz) Power Rail
(Amps) (Watts)
100 5V 2.95 14.75
66 5V 2.16 10.80
33 5V 1.38 6.90
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Scenario 4. Board running Asynchronous Timing test.

Not Applicable since running this configuration mode is not recommended when

internal 3.3V is set to internally generated.

Scenario 5. Frequency Measurement by TA700 SW

Current Draw Power Consumed
Bus Speed (MHz) Power Rail
(Amps) (Watts)
100 5V 4.09 20.45
66 5V 3.81 19.05
33 5V 343 17.15

Note:  Frequency measurement is done every 4 seconds and extra current draw lasts

100 ms.
Scenario 6. FPGA Configuration Time.

Current Draw Power Consumed
Power Rail
(Amps) (Watts)
5V 4.09 20.45
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TA700 Extended Memory Card

The 4 Mega sample extended memory card plugs into the 4 Memory Expansion
connectors on the TA700 PCI Analyzer card. See Figure 158.

@)

1002'0002

Figure 159 TA700 Extended Memory Card

Specifications:
Maximum operating speed 100 MHz
Sampling 4 Mega samples of all PCI signals + time tag.

Note 1: There must be a stable clock on the bus prior to capturing data to the extended
memory.

Note 2: Extended Memory does not capture External Signals and Protocol Errors.
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APPENDIX C

TA700C CompactPCI Card

Figure 160 shows a TA700C CompactPCI Analyzer card identifying status LED
locations, external signal, external trigger input and output connections and external
power jumper location.

S2 Jumper

DA

Memory Expansion

/

Memory Expansion

[ JP10

Figure 160 TA700C CompactPCI Analyzer Card
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Status LED Function Description

SYS (Red/Green LED)  When green it indicates that the system voltages are within 5% of their
nominal values. If any of +5V, 3.3V, +12V drop by more than 5%, the
SYS LED turns red. Upon power on it comes up red during a power self
test and turns green when the software executes.

D3, D11 When illuminated, the TA700C has been configured.

TRIG Indicates that the analyzer has met the trigger condition and is awaiting
for the post-trigger data to be captured.

Jumper Configuration

TA700C +3.3V Power Source selection

JP2

Shunt 1-2  top to center +3.3V from on board 5V regulator

Shunt 2-3  bottom to center | +3.3V Bus Power (Default)

TA700C +5V Power Source Selection

JP16
Shunt 1-2 top to center +5V from external supply
Shunt 2-3 bottom to center +5V Bus Power (Default)

Connecting an External Power Supply
Install Shunt 1-2 top to center on JP2 (3.3V)
Install Shunt 1-2 top to center on JP16 (+5V)

Connect the external power supply to JP1 as follows:

JP1

JP1.1 Bottom pin +5VEX
JP1.2 Center pin +5VEX
JP1.3 Top Pin GND

This configuration applies +5V power to the TA700C from the external power supply
and redirects the 3.3V power from the on board regulator.
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Bus Protocol & Speed Sensing

JP10

Shunt 1-2 Top two PCI-X 133MHz
Shunt 3-4 Next to top N/A

Shunt 5-6 Next to bottom PCI-X 66MHz
Shunt 7-8 Bottom two PCI (Default)

Note: The JP10 jumper settings tell the central system arbiter the capability of the board.
The PCI and PCI-X bus speed and type is determined by the system BIOS at
powerup. During the time that RST# is asserted, the system reads the signals on D21
(M66EN) and B16 (PCIX CAP) from all of the boards asserted on the bus. At the
rising edge of RST# a message defining the bus protocol and operating speed that
satisfies the lowest performance on the bus is sent to all of the cards on the bus. This
message is sent by the following five control signals: FRAME, IRDY#, TRDY#,
DEVSEL# and STOP#.

Caution The JP10 setting information and the bus data returned at the rising edge of RST#
do not have to match if there is more than one agent on the bus.

4 Ny
| |

PCI-X 133 MHz

PCI PCI-X 66 MHz
JP 10 Fd.

"~ CPCISLOT

|
B16
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TA700C Power Up configuration

S2 Jumper Bottom two
Open TA700C Declared as PCI agent (Default)
Installed TA700C Transparent to the System BIOS

Note: The TA700C operating as a PCI agent requires 256 I/O space and 4 Meg of memory
from the host system.

S2 Jumper (Factory Use Only) | Top two

Open X
Installed A
J7 Trigger Out

J4 GND

External Signals

JP15 Pin Pin

Ext In0 1 2 Ext Inl
Ext In2 3 4 Ext In3
Ext In4 5 6 Ext_In5
Ext In6 7 8 Ext In7
Ext In8 9 10 Ext_In9
Ext Inl0 11 12 Ext Inll
Ext Inl12 13 14 Ext Inl3
Ext Inl4 15 16 Ext Inl5
GND 17 18 GND
GND 19 20 GND
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TA700C Extended Memory

The 4 MS extended memory card plugs into the 4 Memory Expansion connectors on
the TA700C CompactPCI Analyzer card. See Figure 160

il iliiililtilﬂlii!miil B HTHTHTTH T

UL L L
== cs

384-0073-001 (©2001

DRAMC REV A

Cataly
EnterpriseS,
San Jose, CA

(408)365-3846

Inc.

r‘ i

Figure 161 TA700C Extended Memory Card

Specifications:
Maximum operating speed 100 MHz
Sampling 4 Mega samples of all PCI signals + time tag.

Note:  There must be a stable clock on the bus prior to capturing data to the extended mem-
ory.
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APPENDIX D

TA700PDC PMC Module Analyzer Exerciser

Figure 162 shows a TA700PDC PMC Module Analyzer identifying status LED loca-
tions, external signal, external trigger input and output connections and external
power jumper location.

J7

JP15
Pin 1

—__ JP2&JP3

On Back

Figure 162 TA700PDC PMC Module Analyzer Exerciser

239



Catalyst Enterprises Inc.

APPENDIX D

Status LED Function Description

D3, D11 When illuminated, the TA700PDC has been configured.

Jumper Configuration

TA700P +3.3V Power Source selection

JP2

Shunt 1-2  center to right

+3.3V External Power

Shunt 2-3  center to left

+3.3V Bus Power (Default)

TA700P +5V Power Source Selection

JP3

Shunt 1-2 center to right

+5V External Power

Connecting an External Power Supply

Shunt 2-3 center to left +5V Bus Power (Default)
JP1
JP1.1 Left pin +3.3VEX
JP1.2 Center pin +5VEX
JP1.3 Right pin GND

TA700 Power Up configuration

JP17
Open TA700P Declared as PCI agent (Default)
Closed TA700P Transparent to the System BIOS

Note: The TA700P operating as a PCI agent requires 256 1/O space and 4 Meg of memory

from the host system.

J7 Trigger Out
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External Signals

JP15 Pin Pin

Ext In0 1 2 Ext Inl
Ext In2 3 4 Ext In3
Ext In4 5 6 Ext In5
Ext In6 7 8 Ext In7
Ext In8 9 10 Ext In9
Ext Inl0 11 12 Ext Inll
Ext Inl2 13 14 Ext Inl3
Ext Inl4 15 16 Ext Inl5
Ext O0 * 17 18 Ext O1 *
Ext 02 * 19 20 Ext O3 *
GND 21 22 GND
GND 23 24 Key

Pin 1 is square pad.

JP16 is for factory use only.

* Not Implemented
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APPENDIX E

TA800 PCI Card

Figure 163 shows a TA800 PCI Analyzer card identifying status LED locations,

external signal, external trigger input and output connections and external power

jumper location.

. LEDs
JP6 Pin 1 J7 Trigger Out

JP10
Catalyst 35

Enterprises, Inc. |o
(408)365-3846 O ¢
TAB02 h
. 384-0082-001 REV A
©z2002

B R

s1 JP2 JP1 accessible on the back of the board.

Figure 163 TA800 PCI Analyzer Card

Status LED Function Description

SYS (Red/Green LED) When green it indicates that the system voltages are within 5% of their
nominal values. If any of +5V, +3.3V +3.3V,,., +3.3V,, or +12V drop by
more than 5%, the SYS LED turns red. "!pon power on it comes up red
during a power self test and turns green when the software executes.

TRIG Indicates that the analyzer has met the trigger condition and is awaiting
for the post-trigger data to be captured.
D1, D2 When both are illuminated, the TA800 FPGAs are properly configured.
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Jumper Configuration

TAS800 +3.3V Power Source selection

JP7

Shunt 1-2  top to center +3.3V from on board 5V regulator

Shunt 2-3  bottom to center | +3.3V Bus Power (Default)

External Power External +5V connects to JP6 Pins 1 & 2 Gnd is pin 3. JP6 is keyed to
mate with the Catalyst power supply.
Trigger Out J7 Pin 1, gnd J7 pin 2 see Figure 163.
External Outputs:
JP1
1 thru 4 External Outputs [0:3]
5 thru 8 GND

Bus Protocol & Speed Sensing

JP2

Shunt 1-2 Top two PCI-X 133MHz (Default)
Shunt 3-4 Next to top PCI-X 66MHz

Shunt 5-6 Next to bottom PCI
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TA800 Power Up configuration

S1 Jumper Bottom two
Open TA800 Declared as a PCI agent (Default)
Installed (See note 1.) TABO00 is transparent to the System BIOS

Note 1. Jumper is used on TA800 Rev. A boards only. Rev. B boards perform this function
with switch S1.1.

Switch S1.1
OFF TAB800 Declared as a PCI agent (Default)
ON TAS8O0O is transparent to the System BIOS

Note 2. Switch S1.2 on Rev, B boards is for internal use only.

Note 3. The TA800 operating as a PCI agent requires 256 1/O space and 4 Meg of memory
from the host system.

External Inputs JP10 (Supported on TAS00 Rev. B only)

Color Signal Pin Pin Signal Color
Brown Ext In0 1 2 GND Red
Orange - 3 4 - Yellow
Green GND 5 6 - Blue
Magenta - 7 8 GND Gray
White - 9 10 - Black
Brown GND 11 12 - Red
Orange - 13 14 GND Yellow
Green - 15 16 - Blue
Magenta GND 17 18 - Gray
White - 19 20 GND Black
Brown - 21 22 - Red
Orange KEY 23 24 - Yellow
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APPENDIX F

TA850 PCI Card

Figure 164 shows a TA850 PCI Analyzer card identifying status LED locations,
external signal, external trigger input and output connections and external power
jumper location.

Status LEDs

USB JR2
D6 —plF
Ethernet LED JP10
Ethernet J2 S 'r_'; . Catalyst v -
o e T — 17 GND
JX1 W S i 5 384-0082-002 REVE
f (©)2004 =Y
i | 'y wiw:getcatalyst.coms &8
J7 Trigger Out
/ S1 is accessible on the back of the board
JP2

Figure 164 TA850 PCI Analyzer Card

Status LED Function Description

SYS (Red/Green LED) When green it indicates that the system voltages are within 5% of their
nominal values. If any of +5V, +3.3V +3.3V,,., +3.3V,, or +12V drop by
more than 5%, the SYS LED turns red. "!pon power on it comes up red
during a power self test and turns green when the software executes

TRIG Indicates that the analyzer has met the trigger condition and is awaiting
for the post-trigger data to be captured.
D1, D2 When both are illuminated, the TA850 FPGAs are properly configured.
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Jumper Configuration

JX1 Center +3.3V, Outer GND. JP6 must be set IAW Note 3, otherwise
a power supply contention may occur.

External Power

Trigger Out J7 Pin 1, gnd J7 pin 2 see Figure 164.
External Outputs:
JP1
1 thru 4 External Outputs [0:3]
5 thru 8 GND

Bus Protocol & Speed Sensing

JP2

Shunt 1-2 Top two

PCI-X 133MHz (Default)

Shunt 3-4 Next to top PCI-X 66MHz
Shunt 5-6 Next to bottom PCI
Switch S1.1
OFF TA850 Declared as a PCI agent (Default)
ON TA850 is transparent to the System BIOS
Note 1. Switch S1.2 is for internal use only.

Note 2. The TA850 operating as a PCI agent requires 256 1/O space and 4 Meg of memory

from the host system.

Note 3. With JP6 installed, power is supplied from the bus. To use external power input,

remove JP6.
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External Inputs JP10
Color Signal Pin Pin Signal Color
Brown Ext_In0 1 2 GND Red
Orange Ext Inl 3 4 Ext In2 Yellow
Green GND 5 6 Ext In3 Blue
Magenta Ext In4 7 8 GND Gray
White Ext In5 9 10 Ext In6 Black
Brown GND 11 12 Ext _In7 Red
Orange Ext In8 13 14 GND Yellow
Green Ext In9 15 16 Ext Inl0 Blue
Magenta GND 17 18 Ext Inll Gray
White Ext Inl2 19 20 GND Black
Brown Ext Inl13 21 22 Ext In14 Red
Orange GND 23 24 Ext Inl5 Yellow
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Easy Mode Access
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easy mode 92
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number detected 162
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Examples
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Easy Mode 40
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programming
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F
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example 154
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Forcing Errors 88
G
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H
Hardware Installation 5
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I
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J
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K
Keyboard Edit 68
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L
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